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or me OS X Yosemite really has been the 
most exciting Mac experience. Of course, the 
latest Macs make the most of it, but it’s an OS 

that I’ve found works very well on the minimum 
requirements. The system improvements from Apple 
are welcome, but now we’ve been using the OS (since 
beta) for nearly a year, we’ve seen plenty of useful 
third-party tools that can help give OS X 10.10 an 

extra boost. We’ve spent months looking at the best 
of them so that this month we can bring you our 

complete guide to powering up Yosemite.
It’s also Apple Watch time (finally), and the 

team has been hands-on with Sport and 
Watch varieties. Read our thoughts on this 
brave new world for Apple on page 10. And 
remember, we’d love to hear your thoughts 
on Apple Watch too. Next month we’ll bring 
you our full tips guide, on sale 11 June. 

Also in this issue, we revisit the world 
of website building. Many people still 
struggle to get into making a website for 
the first time, so we’ve looked at six of 
the latest Mac tools that will get your 
personal blog or small company website 
off the ground. There’s also a complete 
guide to the new Photos app for OS X, 
Apple’s replacement for iPhoto.
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It’s a perfect example  
of how any platform 

comprises innovation 
across each component to 

deliver more than the 
sum of its parts

A

The big  
sToryFuture 

Macs 
will be 
as quick 
as a flash
Apple is investing in new technologies that 
promise significant performance gains for SSD 
devices – for present and future generation Macs

pple isn’t just the iPhone company.  
It continues to invest lots of energy  
into its Mac platform, as seen in the 

innovative new battery packs for its all-new 
MacBook range and new Final Cut Pro X.

The new MacBook is remarkable in several 
ways, not least for the decision to adopt a single 
USB-C port on the device, but hidden inside the 
computer is evidence that Apple has a hand in 
the design of the SSD controller used in the Mac. 

Apple purchased flash memory-controller 
developer Anobit for $390 million in 2011, but 

little evidence of components created using that 
company’s technology have been seen, until the 
MacBook. iFixit reports the flash controllers used 
in previous SSD Macs (including but not only the 
MacBook Pro and Mac Pro) have used controllers 
designed by third-party firms, yet the latest 
MacBook uses a controller designed and built by 
Samsung. This controller delivers outstanding 
storage performance – AnandTech claims the 
MacBook delivered better storage performance 
than the mid-2013 MacBook Air, although it did 
fall behind in the 4KB random write test. These 
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Apple boss rejects Indiana’s prejudiced 
‘anti-gays’ law 

Steve Wozniak
www.woz.org

“I’m gonna try out  
the [Apple] Watch and 

see if it changes  
my life.”

Apple co-founder Woz  
admits he’s not sure if he needs  

a new timepiece

Romasha Roy 
Choudhury

www.cynapse.com

“We believe software  
is going to be more 

about intelligence than 
interfaces.”

The numerics developer on the 
connected potential of Apple Watch,  

iOS and everything 

John Thurso
www.parliament.uk

“The Apple iPad –  
and its supporting 

software – was the most 
suitable tablet device 

available.”
All 650 UK MPs will be given iPads – 

presumably so they can play Angry Birds 
when PM’s Question Time gets too dull
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Why you’ve gotta have faith 
in Apple upgrades   p18

Wheels of change
Is an e-car Apple’s secret 
next big project?   p20

Think different 
Exploring the tech that sits 
outside the box   p16
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Apple Watch:  
a hands on
Our first impressions   p10

test results in combination with the 
Samsung brand led AnandTech’s Ryan 

Smith to suggest, “Apple had some 
kind of hand in developing  

the SSD controller”. He 
believes Samsung is simply 
acting as a foundry for  

the product.
However, in order to fully 

realise the advantages of any 
improvements to SSD, Apple 

must embrace the challenge of 
improving the surrounding 

platform infrastructure to keep 
pace. Apple’s response is visible 

in the decision to implement 
support for the NVM Express 

(NVMe) SSD Interface within OS X 
10.10.3. Developed cooperatively by 

over 80 companies (including Intel 
and Microsoft) and introduced in 

March 2011 by the NVM Express Work 
Group, NVMe is designed to support 

improvements in SSD technology 
across the next 10 years. Among other 

improvements, the NVMe Work Group 
says it “efficiently supports multi-core 

architectures, ensuring thread(s) may run 
on each core with their own SSD queue 

and interrupt without any locks required”. In brief 
this means you can expect much better SSD 
performance than you’ll get using current 
generation AHCI (Advanced Host Controller 
Interface) technology.

Since they began shipping in 2014 NVMe 
products have “demonstrated up to six times 

greater 4KB Random and Sequential Read/Write 
performance and lower latency than SATA solid 
state drives”, says the NVMe standards group. 

Given that NVMe products have demonstrated 
such improvements in 4KB random-read tests, it’s 
a no-brainer for Apple to introduce support for 
the tech inside its OS – its possibly self-
developed SSD controller could use assistance.

It’s a perfect example of how any platform 
comprises innovation across each component to 
deliver more than the sum of its parts. “The goal 
of NVMe is to unlock the potential of PCIe SSDs 
now and in the future, and standardise the PCIe 
SSD interface”, the standards body behind the 
standard states (nvmexpress.org). 

NVMe is already used in data centres and 
products implementing the standard are 
scheduled to hit consumer markets this year.   
For Mac users, of course, the promise is further 
performance gains – even when using the most 
demanding applications – ahead. And these 
evolutions will impact Apple’s Mac, iPad, iPhone 
and Watch platforms in the years to come.

Macs of the future can expect much better SSD performance  
than we currently get with current-generation AHCI.

http://www.apple.com
http://www.woz.org
http://www.cynapse.com
http://www.parliament.uk
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Apple insider

WWDC set for June Apple’s 
Worldwide Developers Conference (WWDC) 
starts on 8 June. Tickets are available on  
a lottery basis, though the company intends 
streaming more sessions from the show 
than before. Marketing VP Phil Schiller 
promised, “Incredible new technologies  
for iOS and OS X to share with developers  
at WWDC and around the world”. Such  
new technologies will include new 
evolutions of the operating systems along 
with app development tracks for Apple 
Watch and – as MacFormat goes to  
press – increasing weight of speculation 
claiming Apple will reveal more on its plans 
for TV at the show. 

Apple and ibM in health data 
push Apple has teamed up with IBM  
in a deal that means HealthKit data may 
transform health research, thanks to big 
data analysis and IBM’s AI solution, Watson. 
“With Apple’s groundbreaking ResearchKit, 
researchers can easily create apps that  
take advantage of the power of mobile 
devices to give them rich data from a 
diverse global population”, said Jeff Williams, 
Apple’s Operations VP. “Now IBM’s secure 
cloud and analytics capabilities provide 
additional tools to help accelerate 
discoveries across a wide variety of health 
issues”. The notion is that sensors in your 
Apple device will gather useful data Watson 

will analyse to identify key health-related 
insights to inform better research.

earth Apple “We don’t want to debate 
climate change. We want to stop it”, says 
Apple at the start of its 2015 Environmental 
Responsibility Report, published for Earth 
Day 2015. The publication followed a series 
of green-friendly revelations, including huge 
new solar farms in China and another in 
California. Apple is also working with the 
Conservation Fund to acquire 36,000 acres 
of managed forest that will be sustained 
and harvested for Apple product packaging. 
Apple is trying to get 100% of its packaging 
from renewable sources. The report states 
the company has launched a Green 
Chemistry Advisory Board to stay in the 
forefront of help identify and reject toxins 
from its supply chain.

It’s a sign of getting old 
when numbers start 

seeming too large to be 
sensible. As a child, newspaper 
headlines had numbers in the 
hundreds of thousands. Then  
it took millions to make it as 
headline news. Then billions 
were the order of significant 
significance. Finally the dial 
has turned towards trillions.

Many expect Apple to be  
the first US trillion dollar 
enterprise. Apple only needs to 
rise another third for its market 
capitalisation to hit the 12 zero 
scale – up to $165-175 a share 
from its current $125.

The trouble is, that’s about 
half the price of the Apple 
Watch for every man, woman 
and child on Earth. So Apple 

really does have an 
astronomical valuation – to 
compare it you have to be 
thinking on a planetary level.

The Watch has just burst 
onto the market, but whether 
this will be the catalyst to get 
Apple to the trillion is another 
matter. However, it has the 
belief of Planet Earth’s leading 
stock market behind it…

Our industry expert rounds-up 
the biggest Apple corporate  

stories circulating this month

Clem Chambers, CEO 
of ADVFN, the leading 
stocks & shares website

Tickets for Apple’s WWDC in June are available via a lottery.

stock 
watch

June Apple  
TV  update  
says WsJ  
Apple plans to offer a 
slimmed-down bundle 
of TV networks starting 
from later this year.

iPhone gets 
quality Apple’s $20 
million acquisition of 
LinX should mean future 
iPhones will deliver SLR 
quality pictures even in 
low light conditions.

Apple Pay 
delayed in UK 
Reports claim banks  
are delaying the launch  
of Apple Pay in the  
UK as they fail to agree 
terms with Apple.

Apple dumps 
samsung… 
again At least 30% of 
next-generation iPhone 
chips are to be made 
by TSMC instead of 
Samsung, reports claim.

Force Touch 
comes to iPhone 
Apple will put Force 
Touch inside future 
iPhones, which may  
be made using Apple 
Watch alloys.

0
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The top 5 Apple stories 

Rumour  
ROUNDUP

The top 5 Apple stories 
we’re talking about



MacFormat.com  |  June 2015  |  9 

AppleWORLDAppleWORLD

 G
ol

dg
en

ie
 G

lo
ba

l, 
 w

w
w

.g
ol

dg
en

ie
.c

om

Apple in 
PIcTURES

The hottest pictures  
from the world of Apple

Some scoff at the price 
of the Apple Watch 
Edition, but at a cool 

£110,000, the custom Apple 
Watch Diamond Ecstasy from 
Apple luxury partner 
Goldgenie, is on another level 
entirely. Of course, it’s the 
kind of bling only super-
superstars can afford, but we 
can all gawp at its excess. It’s 
18k solid gold, encrusted with 
hundreds of diamonds and a 
1k gem in the Digital Crown.

http://www.goldgenie.com
http://www.goldgenie.com
http://www.goldgenie.com


10  |  MacFormat.com  |  June 2015

Finally, the Apple Watch is 
here and it’s instantly 
become one of the most 
drooled over products at 
MacFormat Towers

hands-on

T
he Watch is in our hands, or rather, 
on our wrists having placed our 
orders just a few minutes past 
8am on 10 April. MacFormat’s full 
review follows next month when 

we’ve had time to test out every single aspect, 
but the MacFormat team had a few days with 
Watches and we all found plenty of things to 
like, and dislike, about Apple’s brave new 
product launch.

If you were lucky enough to pre-order and 
get an early model, or you’re still deciding 
whether or not to order online, we would love 
to hear your thoughts on Apple’s wearable. As 
usual, email us: letters@macformat.com.

NEXT  
MONTH

Full review & 
 tips guide!

WATCH

mailto:letters@macformat.com
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My only real gripe 
was that it was not 

always clear what each 
input method 
would actually do

Christian, Editor Alex, Commissioning Editor

I’ve always worn a watch, so when 
Apple announced what is really 
the first proper smartwatch the 

world will pay attention to, I was hoping 
the release would be soon. Ironically for 
a timepiece, it turned out to be quite a 
wait. That might have dampened my 
expectations, but now it’s here I’m 

actually taken aback by its quality. When Apple said 
Watch is the ‘most personal device we’ve ever made’, 
it wasn’t wrong. I can get the crucial notifications I 
need but already feel free from the shackles of mobile 
devices. That’s slightly odd because you need an 
iPhone (5 or newer) for it, but I’m no longer conscious 
of having to pocket my iPhone 6 for everywhere I go, 
even when I’m around the house and urgently 
checking those Saturday football scores!

For me, the 38mm Apple Watch Sport is the right 
version. Yes, it’s the cheapest, yet I don’t feel that it’s in 
a different class to the higher end models at all. That 
said, I covet the Stainless Steel Case with Link Bracelet. 
Partly because I’ve worn watches with links for years 
and to me this one seems like a ‘real’ watch, more than 
just brilliant wearable tech. It’s quality jewellery.

The killer feature for me, so far, has to be 
the Digital Crown. Yes, it’s just a control 
mechanism but the responsiveness 
is where it wins. It feels fast and 
harmonises the mechanical 
feeling and digital UI 
perfectly. I love the way 
you can zoom into 
your apps with it, 
and it scrolls 
better than 
both touch and 
most mice I’ve 
used over 
the years!

As someone who hasn’t worn a 
timepiece for over a decade, I 
wasn’t falling over myself to pre-

order an Apple Watch. But in the spirit of 
open-mindedness, I popped down to my 
local Apple Store to try one on anyway – 
and I really was pleasantly 
surprised by it.

The fluoroelastomer strap was 
far more comfortable than I was 
expecting, soft to the touch and 
barely noticeable when worn. 
I was also taken with the Milanese 
Loop, which is extremely easy to 
fit and adjust to any tightness.

As for the Watch itself, the 
Taptic Engine is very subtle, 
exerting enough force to attract 
my attention without becoming 
irritating. The real star for me, 
though, is the Digital Crown, 
which is sensitive yet still precise, 
and a great way to get around 
the myriad functions of the 
Apple Watch.

My only real gripe is that it 
isn’t always clear what each input 
method – turning or pushing the Digital Crown, 

tapping the screen or using Force Touch – will 
actually do, so it occasionally took me several 

attempts to get the Watch to do what I 
really wanted it to do.

Still, this is the kind of thing that 
becomes natural with use. I’m still 
holding out for now, but I’ve got 
plenty to mull over.

The MacFormat team’s first impressions

Seth, Digital Art Editor

I was decidedly underwhelmed at first. I had 
difficulty selecting operations, kept trying to 
pinch to zoom and was confused by Force 

Touch. I know that using Watch would eventually 
become habit and the majority of these problems 
would go away in time. I did particularly like the 
Maps app, though. It jumped out as a genuinely 
useful feature. I asked it for directions and its 

operation was smooth and precise. I can see many of the 
standard apps coming into their own. As for a 
model, it would be the 42mm Sport for me.

Christian’s
choice

Alex’s
choice

Seth’s
choice

AppleWORLD
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Alan, Production Editor

The iPod is dead, long live the 
Watch! I listen to music while 
walking yet I was surprised that 

using Apple Watch as a remote control 
for an iPhone stands out so much. I’m 
curious to find out how the Watch’s 
battery holds up when paired directly 
with Bluetooth headphones.

What concerns me, though it isn’t a deal-breaker 
for my fingers, is the size of app 
icons and some other on-screen 
controls, which I fear fat-
fingered folk will have 
difficulty tapping with 
confidence even on 42mm 
models. Another niggling 
issue is how slowly the 
Digital Crown moves 
around the circle of 
favourite contacts.

Strap-wise, there’s 
only one that 
surpasses the 
surprising elegance 
of the Link Bracelet, 
and that’s the beautiful 
Milanese Loop. If only 
there were a version 
to match the Space 
Black Watch. 

Home screen
Your home for apps was 
never going to work in a 
static fashion like iOS 
devices. So, Apple’s 
quickly scrollable Home 
screen is the perfect 
solution. Although tiny, 
those round app icons are 
easy to press individually.

Digital Crown
With such a small screen 
space, the Digital Crown 
not only fixes the problem 
of covering the screen 
with a finger, it also 
enhances apps. In Maps 
it’s better than pinch-to-
zoom, and the Contacts 
wheel is a joy to use.

Glances
With the clock as your 
main screen, you don’t 
want to always press one 
of the buttons to bring up 
info or an app. Swiping up 
from the bottom of the 
clock screen gives you 
quick access to Settings 
and up to 20 apps.

Activity
Workout is the app for 
runners and cyclists, but 
your general fitness is 
logged with the simple 
and beautiful Activity app. 
Set your goals and track 
progress in detail with the 
companion app that’s 
installed on your iPhone.

Ping iPhone
It’s not been talked about 
much, but one swipe up 
from the clock screen and 
you’ll get Settings as your 
first Glance. Here you can 
activate Airplane Mode 
and more, and ping your 
iPhone if you’re not sure 
where you put it down.

Paul, Managing Art Editor

Having large hands and wrists, 
I went to a fitting for my Apple 
Watch with a bit of trepidation. In 

the past I have had to send my watches 
back to the manufacturer for the strap 
to be adjusted to fit. With a vast array of 
straps, surely there had to be one that 
fitted me. I initially pinned my hopes on 

the black stainless steel strap but it didn’t fit. The 
assistant then showed me that the links are removable 
and he assured me that a little later, after launch, you’ll 
be able to buy extra links – so I could purchase the 
strap and later buy the extra links to make it 
fit me. Next up I tried the bright 
blue Leather Loop strap, which 
fitted and was extremely 
comfortable for me.

Having spent 20 minutes 
going through straps, 
I finally spent some time 
with the interface. Like 
the iPhone, the touch 
control is best in class, 
my huge fingers were 
able to easily pick the 
smallest icon on the 
screen, the UI was 
extremely responsive, 
and I love the new 
San Francisco font.

Alan’s
choice

Paul’s
choice

MacFormat’s top five features

AppleWORLD
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Hot gear on the horizon... what’s got us excited?

The world is full  
of cases and stands 

of a distinctly 
average flavour, 
which is why the 

Phorm caught our 
eye so much

What is it? Slide the built-in button on the 
back of the case and a tactile keyboard 

emerges right there in front of you on the screen 
– raised bumps to guide your fingers to the 
correct keys. This lets you type in a much more 
natural way, pounding out your next masterpiece 
of prose by touch, rather than having to stare 
pointedly at your iPad’s graphical keyboard. 

When’s it due? Pre-order now (ships to the USA 
in summer 2015, UK release TBC).
Why are we excited? Seeing those little bumps 
pop up out of nowhere is almost magical. It’s a 
simple idea, but one with an awesome mystique. 
It’s available for the iPad mini, with an iPhone 6 
Plus version in the works. Vote for devices the 
Phorm should be developed for on its website. 

We’re most excited about...

Phorm
$99.99 (about £70) tactustechnology.com
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Gadgets

Flow
$119 (about £80) senic.com

What is it? If you’re a designer, video editor or 
other creative type, chances are a mouse and 

keyboard just don’t deliver the type of precision you 
need in your work. Enter the Flow, a touch-sensitive, 
programmable device that features haptic control 
and gesture recognition.
When’s it due? August 2015.
Why are we excited? The three control inputs – 
trackpad, touch-sensitive outer ring and gesture 
recognition – allow for much more flexibility and 
precision than a mouse could ever offer. We also love 
that you can program in your own commands, so its 
compatible with tons of different apps. It might just 
change the way you work.

Coolest Clock
$199 (about £135) coolestclock.com

What is it? Sometimes a name 
says it all. The Coolest Clock has 

no physical clock face, instead 
projecting the time onto your wall 
along with whatever else you want it 
to – the weather forecast, news, even 
Facebook updates. You can 
customise the face, adding 
photographic backgrounds or 
different layouts to suit your fancy.
When’s it due? Clocking in by 
Christmas time.
Why are we excited? It’s a beautiful 
take on something that’s often so 
mundane. Successful crowdfunding 
means its creators are looking to add 
motion sensors, so you can switch 
the clock on simply by waving at it.

Impression  
Pi VR/AR headset
$279 (about £190) for phone-based model, $349 (about 
£235) for phoneless model impressionpi.com

What is it? The Impression Pi headset is nothing if not 
ambitious. It’s wireless, will feature head tracking and 

be location-aware (something the Oculus Rifts needs a 
Leap Motion controller to do), all the while combining 
both virtual and augmented reality. Oh, and the headset 
happens to look a pretty picture too.
When’s it due? Get one in December 2015.
Why are we excited? VR is hard and the likes of Oculus 
and Project Morpheus have been beset with problems. 
The Impression Pi wants to do a lot, but if it can pull it off 
we may end up with the best headset in the world.
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Decidedly off-the-wall

PancakeBot
$179 (about £123) pancakebot.com

What is it? Because breakfast just isn’t 
exciting enough. The PancakeBot is a 3D 

printer with a difference, built by a man 
with a dream. A noble, inspiring dream. 
Specifically, a dream of being able to print 
his own pancakes. The PancakeBot smashed 
its Kickstarter target of $50,000, raising over 
$350,000 from eager batter Brueghels the 
world over keen to start making breakfast 
the most artistic meal of the day.
When’s it due? Available July 2015.
Why are we excited? It looks great fun! You 
can’t possibly be glum on a rainy Monday 
morning when your PancakeBot is making 
you an edible smiley face.

The Egg
64GB $199 (about £135), 128GB $299  
(about £200), 256GB $349 (about £238), 
‘Premium’ colours cost more eggcyte.com

What is it? With no conventional 
way to expand the storage of your 

iPhone, running out of space can be 
an issue. The Egg might just be the 
solution. It’s wireless, personal cloud 
storage that you can take around 
with you, with none of the worries 
of handing your data over to cloud 
companies, all contained in a small 
egg-shaped drive.
When’s it due? Get it in Q4 2015.
Why are we excited? Because The Egg 
operates entirely wirelessly and fits in the 
palm of a hand, it’s super portable – just pop 
it in your bag for extra storage wherever you go.

Bluesmart
Pre-order for €319 (about £230) bluesmart.com

What is it? Suitcases are really boring, but not 
the Bluesmart. This is teched-up luggage at its 

most extreme – it’s got a location tracker, a built-
in battery charger for your devices and it even 
weighs itself to help you avoid airport fines. 
The lock is phone-activated, and if you leave it 
behind – or someone else whisks it away – it’ll 
send you an alert and help you find it.
When’s it due? Shipping August 2015.
Why are we excited? It’s not just an (expensive) 
gimmick – there are some seriously useful features 
packed into the Bluesmart. With so much souped-
up hardware on board, this is the suitcase Tony 
Stark would use. 

Flic
$34 (about £23) flic.io

What is it? The Flic is a small button that can 
be programmed to do just about any function 

your phone can. Place it anywhere you like and 
you can quickly call friends, take a picture, play 
music and more.
When’s it due? Coming in May 2015.
Why are we excited? There’s a huge range of 
possibilities with the Flic. If you have a smart 
lighting system, the Flic can act as a light switch 
that you can place anywhere in your house. The 
beauty lies in its flexibility – pretty much anything 
your phone can do, the Flic can do too. Its ability 
to streamline long or complicated processes on 
your phone means that you should end up 
spending less time fumbling with your device and 
more time getting stuff done.
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Kurt Vonnegut wrote 
that many people “need 
desperately” to receive a 
message: “I feel and 
think much as you do, 
care about many of the 

things you care about, although most people 
do not care about them. You are not alone.” 

It isn’t always easy to get that message 
across, or to receive it. Our devices are 
increasingly toddlerish, demanding all of our 
attention RIGHT NOW at the top of their 
lungs. A junk text from your phone provider 
has the same priority as an iMessage from a 
loved one, an important email the same 
weight as endless offers from firms you 
bought something from years ago, the news 
that somebody’s tagged you in a Facebook 
photo arriving with the urgency of news that 
might actually matter.

Like toddlers, our iPhones can easily 
become tiny tyrants, interrupting events, 
stomping their feet and shunting your train of 
thought down dead-end tracks. It’s said that 
the best way to simulate having kids is to have 
somebody yell at you every 17 seconds. Most 
iPhones do that by default. 

The Apple Watch could change that.
I say “could” rather than “will”, because 

right now it doesn’t. Like iOS there’s an awful 

lot of messing about to be done if you want to 
differentiate messages from different sources, 
to ensure that the notifications you receive are 
only about things you actually care about, to 
prevent a bone-headed marketing message 
waking you up at 3am. Early reviews are 
unanimous: the Apple Watch is far from 
friendly and takes a lot of fiddling. But in the 
long term, it could tame the tiny iPhone 
tyrant, keeping it quiet in purse or pocket.

I’m fascinated by the Apple Watch’s haptic 
feedback, the heartbeats and pulses and 
gentle taps it delivers. Of all the Watch’s many 
wonders, I think that might just be the most 
wondrous of all. Imagine a gentle squeeze 
from a proud parent as you enter an exam 
room, your loved one’s heartbeat when you’re 

far away, a thinking-of-you touch when you’re 
going through hard times. 

If you see the Watch as a small iPhone, a 
computer on your wrist, then you’re going to 
be disappointed – but if you see it as a way to 
separate out what matters, to share a simple 
touch over distances great or small, then I 
think you’ll be as excited by the possibilities 
as I am. Vonnegut again, this time quoting his 
son Mark: “We’re here to help get each other 
through this thing, whatever it is.” With the 
Apple Watch, there could be an app for that.

One more thing...

Gary Marshall said he didn’t want, didn’t need  
and couldn’t afford an Apple Watch. What 
happened next probably won’t surprise you.

Like toddlers, our 
iPhones can easily 

become tiny tyrants, 
interrupting events 

and stomping their feet

invisible touch
The Apple Watch isn’t just a wrist computer. Its most 
exciting ability might just be something you can’t see
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Cloaked in mystery, Apple’s 
biggest secret project could be 
something no one expected –  

a driverless electric car

hings certainly move 
fast in the world of 
Apple rumours.

When the first 
murmurings 
surfaced in early 
February that Apple 
was secretly working 
on new automotive 

technology, many commentators quickly 
dismissed it as some sort of unannounced 
CarPlay innovation, an improvement of 
Apple Maps or battery life research.

Then news emerged of Apple poaching 
Tesla employees by the bucketload – Tesla 
employees specialising in fields like 
mechanics and manufacturing, specifically. 
Mysterious Apple vans loaded with cameras 
started appearing on the streets of 
California, New York and Hawaii. Initial 
cautious scepticism began turning into 
fevered excitement – surely Apple couldn’t 
really be working on a car... could it?

T

The wheels 
of change

Words: Alex Blake  Illustrations: Magictorch, Paul Blachford
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Putting the brakes on 
expectations
Apple generates hype like no other company 
on Earth. A combination of brilliant marketing, 
a vice-like grip on leaked information and 
downright awesome products mean that the 
slightest hint of a new Apple gadget seems to 
kickstart the whole world into a flurry of 
breathless speculation and sweaty palms.

But an Apple Car? Making a car is very, very 
different to making phones and computers, 
and the sheer logistics of the manufacturing 
process raise questions about whether the 
tech behemoth really is dipping its toes into 
car-making. Cars tend to stay on the roads for 
years before being replaced; Apple, by 
contrast, religiously releases new products and 
new versions of its tech every year, and it 
would require a clear break in philosophy if it’s 
to take on the car industry at its own game.

There are also noticeably small margins 
when it comes to building cars, which could 
be an unpleasant shock to a company known 
for its record profits. Of course, the counter 
argument is that a firm fresh off the back of 
the most profitable quarter in history has 
more than enough spare cash lying around.

And the critics have certainly been wrong 
before, similarly dismissing Apple’s forays into 
the phone industry as naïve tinkering. Could 
they be wrong again?

Does it make sense?
It certainly does. Both Steve Jobs and Jony Ive 
have espoused their desire to shake up the 
automotive industry. Apple disrupts pretty much 
every market it enters, and an Apple Car could 
help create the ultimate Apple ecosystem – and 
enable the company to spend some of that 
$178bn cash pile it’s sitting on.

According to Paul Nieuwenhuis of the 
Centre for Automotive Industry Research in 
Cardiff, the idea of Apple building a car is 
believable. “The car has steadily been moving 
from a mechanical to an electric device”, he 
says. “In fact, the only truly mechanical bit left 
is the engine, so with Apple’s expertise in 
bundling both software and hardware you can 
see the logic.”

Matthew Sparkes, Deputy Head of 
Technology at The Telegraph, is even more 
forthright: “With the gargantuan pile of cash 

Apple is sitting on, the relentless pressure to 
innovate and the astonishing progress of 
automotive disruptors Tesla, I’d say it’s almost 
certain Cupertino is working on R&D projects 
around cars.”

Were those Apple vans conducting a 
mapping project akin to Google’s Street View? 
Not according to tech analyst Rob Enderle, 
who was quoted by San Francisco’s CBS Local 
as saying the van had “too many cameras” to 
be used for mapping, and that the way they 
were arranged – pointing at all four corners of 
the vehicle – wasn’t suitable for that purpose.

He told MacFormat that Apple doesn’t need 
their own fully-fledged vehicle to test out 
in-car entertainment like CarPlay, suggesting a 
car was indeed in the works.

And let’s not forget that at its Spring 
Forward event in March 2015, Apple 
announced a new MacBook packed full of 
brilliantly designed tiered batteries. That sort 
of innovation could allow Apple to fit more 
batteries in a car’s limited space, resulting in 
longer charges. Alternatively, it could allow a 
more compact battery arrangement, leaving 
more room for other tech or producing a 
lighter, more responsive vehicle.

That type of thinking gained a significant 
boost when it was reported in mid February 
2015 that Apple was being sued by A123 
Systems, a car battery manufacturer, for 
poaching its employees to work on a large-

If an Apple Car does become a reality, it will likely feature the kind 
of sleek design Apple is known and loved for – a far cry from the 
teched-up vans spotted on the streets of America.

apple disrupts every 
market it enters, and 
an apple car could 
help create the 
ultimate ecosystem

The wheels 

of change



scale vehicle battery division. With that one 
announcement, the Apple Car seemed to 
become a whole lot more real.

what might an apple car do?
There’s no doubting an Apple Car would be a 
thing of beauty, a luxury vehicle produced with 
the kind of quality Cupertino is known for. But 
what kind of features can we expect?

It would be a fantastic chance for Apple to 
push a load of its other services your way. You 
would navigate using Apple Maps, Siri taking 
voice commands. In-car entertainment would 
be handled by iTunes. By the time such a 
vehicle would be released – a minimum of 
five years from now – perhaps you would 
even be able to pay for fuel using Apple Pay.

What seems almost certain to all concerned 
is that an Apple Car would be electric. The 
company’s green credentials are well known, 
with Tim Cook’s aim being to leave the planet 
‘a better place than we found it’. He grabbed 
the headlines again at Apple’s annual 
shareholder meeting in March 2014 when he 
reportedly told shareholders to ‘get out of this 
stock’ if they opposed the Cupertino giant’s 
environmental policies.

That all places Apple far closer to Tesla than 
Tata – particularly pertinent given the number 
of Tesla employees switching allegiance. But 
what of the other big rumour that’s been 
consistently attached to the alleged Apple 

auto – that it will be completely driverless?
It’s certainly a compelling idea and aligns to 

Tim Cook’s sentiments. Road fatalities would 
tumble, journey times would be slashed, while 
parking hassles would be a thing of the past.

Sparkes was in a confident mood when he 
told us that “It would certainly be driverless, as 
the whole motoring sector is also working on 
taking the weak link – humans – out of the 
loop”. It’s a matter of ‘when’, not ‘if ’.

Jane Nakagawa, Managing Director of Portia 
Consulting, agrees, telling TechRadar.com that 
a driverless Apple Car could boost business by 
providing a fleet of connected, automated 
delivery vehicles. Taxi services could become 
similarly self-driving, enhancing convenience, 
comfort and safety in one fell swoop.

Nieuwenhuis is less sure given the 
complexity involved and Apple’s lack of 
experience in the field. “Macs are not exactly 
driverless,” he points out, “but they could 
develop many of the technologies needed to 
move in the driverless direction.” Given the 
company’s track record of doing the so-called 

MaPs sTreeT View
Although Rob Enderle 
disagrees, those cameras 
mounted on the alleged Apple 
Car could suggest that Apple 
is working on a Google Street 
View rival, or perhaps crafting 
improvements to Maps.

rounD waTch
The Apple Watch hadn’t even 
been officially unveiled before 
the first rumours of a platinum 
version that could be circular 
surfaced. With Apple targeting 
the elite circles of the fashion 
world, it’s not a bad call.

iPaD Pro
iPad sales have been 
stagnating due to competition 
from larger iPhones and other 
tablet makers, so a larger 12.9-
inch device could potentially 
help turn things around for 
Cupertino’s finest.

aPPle TV seT
This one has been talked 
about for just about eternity, 
and analyst Gene Munster is 
sure it’ll be out within two 
years. Perhaps the Apple TV 
box is finally set to get a 
bigger brother.

force Touch iPaD
Apple’s newly-announced 
Force Touch trackpad tech has 
been rumoured to be making 
its way to the iPhone 7. Might 
that open the way to a new 
iPad boasting Force Touch? It’s 
a tempting thought.

Where Will 
Apple go 

from here?

The most obvious point of comparison for an Apple Car – and 
potentialliy its biggest rival  – is Tesla, another Silicon Valley 
tech firm making waves in the auto industry.

The Honda Jazz has shown that hybrid cars can succeed in the 
mass consumer market. Might Apple follow suit with an 
electric car of its own?
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impossible – and the potential profits for 
Apple – it’s difficult to completely write off the 
self-driving element.

no ordinary car
It doesn’t take a genius to work out that an Apple 
Car would be loaded to the hilt with all manner of 
stunning gadgets. As Enderle puts it, “it would 
basically be an iPod on wheels.”

Sparkes agrees: “You could imagine it being 
immaculately designed, with fantastic in-car 
entertainment: great screens, quality audio. Its 
Maps service would handle sat-nav duties.”

A car represents an amazing opportunity 
that Apple would surely find hard to turn 
down – a complete, self-contained ecosystem 
where every element, every user need, could 
be catered to by Apple. The company can’t 
(yet) provide every solution for your home life, 
but a car? Well, that would be a very different 
situation indeed.

As Nieuwenhuis suggests, the oft-mooted 
comparisons with Tesla are closer than ever 
when it comes to in-car tech. “Look at how 
the Tesla works – its user interface is like a 
large iPad, and its software can be updated 
and upgraded while it is charging overnight. It 

is the sort of thing that you do not currently 
find in other cars where Apple’s first moves 
are likely to be.”

is apple changing its focus?
Despite all the cynical warnings of the various 
naysayers, the car of the future will likely suit 
Apple down to the ground. 

But the obvious question to ask from all this 
is whether Apple is changing from a 
computer company into something else 
entirely – a company looking to expand its 
reach and its ethos into uncharted waters.

The most conspicuous clue lies in Apple’s 
presentation of its Apple Watch. From hiring 
fashionistas like Burberry’s Chester 
Chipperfield and Paul Deneve of Yves St. 
Laurent to the decision to market a luxury 
gold model selling for upwards of $10,000, the 
inescapable implication is that Apple is 
starting to see itself as not just a technology 
giant, but a certified lifestyle brand.

Apple Watch is a clear expression of this 
newfound identity, and all clues point to that 
being the case for the prospective Car too. 
Given Apple’s penchant for eye-watering 
design closely matched by some eye-watering 
prices, there’s little doubt any such vehicle 
would be a luxury item, much more a 
prestigious status symbol than a functional set 
of wheels for budget buyers.

The Apple brand holds a certain cachet, an 
air of elegance and style hitherto unmatched 
by its rivals in the geeky world of gadgets and 
gizmos. An Apple Car would transfer that to 
an entirely new realm for the darling of Silicon 
Valley. It’s a different ball game, but as Apple 
has shown with its confident move into the 
heady world of high fashion, that’s unlikely to 
put off Tim Cook and friends.

PriVaTe 
sPaceflighT
If Virgin can do it (or 
claim to be able to), 
Apple certainly can. 
Things don’t get much 
more aspirational than 
getting to experience 
weightlessness on your 
very own private space 
flight, after all.

new Vr 
heaDseTs
With Microsoft 
demonstrating how 
Hololens could be used 
to fix broken appliances 
around your home, a 
similar gadget from 
Apple could tie in well 
with its exciting new 
HealthKit framework.

whole house 
enTerTainMenT
Apple has a large stake in 
the music biz with iTunes, 
Apple TV and Beats under 
its belt. What better way 
to link them all up than 
through a connected 
in-house entertainment 
system powered by its 
very own HomeKit?

3D PrinTing 
Technology
3D printing is a fledgling 
market still finding its 
feet, making it a 
potentially ripe target for 
Apple. Given its massive 
future potential, there’s 
plenty of money to be 
made if Tim Cook is 
ambitious enough.

a gaMes 
console
It seemed an odd 
decision when Microsoft 
moved into the games 
console world, but just 
look how well that’s 
panned out. Apple’s been 
there before with the 
Bandai Pippin but that 
was an age ago (1995)!

five CrAzy things Apple might do next

Apple’s forays into the world of 
fashion suggest it no longer sees 
itself purely as a tech company, but 
as a lifestyle brand as well.

a car represents 
an amazing 
opportunity that 
apple would 
surely find hard 
to turn down

The wheels 

of change
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Supercharge your Mac’s performance with  
hot system tweaks and amazing add-ons
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Power up
Yosemite!

osemite adds a huge range of new 
features and functionality to your 

Mac and it’s important to get the 
most out of them. After all, getting 
more out the software also means 
getting better value out of your 

hardware investment. 
Just upgrading to the latest version 

of OS X is to give your Mac a power boost. 
Each new version of the operating system 
introduces new features designed to make the 
Mac a more productive, useful and graceful 
experience. Yosemite is no exception to this, 
and new features such as Continuity, Handoff 
and Instant Hotspot bring a sense of delight 
to those who use them. These features enable 
a Mac to tap into your iPhone and make phone 
calls, send SMS texts and use a mobile internet 
connection without even having to unlock 
your iPhone. Meanwhile, iCloud Drive and 
Handoff enable you to move between a Mac 
and iOS device and seamlessly continue work.

Getting the most out of Yosemite means  
knowing your way around it. Sometimes a 
feature‘s visual presence doesn’t reflect its 
usefulness, so we’ll tell you how to find subtle 
enhancements that aid your productivity.

Yosemite’s enhancements aren’t all about 
iOS integration, though. With this version, 
Apple’s chief designer Jony Ive got a chance to 
bring his vision of the OS X interface to life. 
Yosemite uses translucent interface elements. 

You’ll see the effects of this throughout the 
apps that come with the operating system, 
including Mail, Calendar, Preview, and the 
iWork and iLife apps. You might find this gets  
in your way, but don’t worry – there’s an app 
for that and it comes with OS X.

If you’re running an older Mac with limited 
resources, or you don’t like certain aspects of 
OS X, either because you find they slow things 
down or they don’t fit with how you work, 
you’re in luck because you can use hidden 
settings and third-party tools to change your 
Mac’s behaviour and boost its performance. 

Make your Mac work for you
If you have an older Mac that struggles to run 
Yosemite and you’re missing the latest and 
greatest features, don’t worry. There’s a lot  
you can do with any Mac to improve your 
experience. Long-time Mac users have learnt 
many tricks over the years to keep OS X 
running smoothly on older models, and we’ve 
had a lot of time to discover hidden features 
that can be unlocked. We’ll show you how to 
do this. Even a brand new Mac can be 
encouraged to run faster. 

That’s what this feature is all about: getting 
the most out of Yosemite, whether that’s by 
typing a couple of lines into a Terminal window 
or by downloading extra tools that tailor the 
system to your needs. We’ll show how to make 
your Mac run better and be more flexible. 

Y
Words: Lucy Hattersley Illustration: Paul Blachford
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What’s improved?
pgrading to OS X Yosemite brings a raft 

of new features, the most obvious 
being the new-look interface. While 
not wholly different from previous 
incarnations, the new style has 
received a mixed reception. Apps 

such as Calendar and Contacts no 
longer mimic real-world objects, a style 

some thought hammy. Many apps feature a 
blurred transparency effect with interface 
elements that react to the colour of the desktop 
or objects behind them. The Dock is a 
translucent rectangle, rather than like a 3D shelf.

New features
Radically for Apple, OS X’s system font has 
changed for the first time. Out goes Lucida 
Grande and in comes Helvetica Neue. There are 
new-look icons for many of Apple’s apps, which 
come in two styles. There’s the familiar circular 
icon produced to Jony Ive's icon grid, and a new 
rectangular one with a 9° tilt.

Yosemite also introduces a ‘dark 
mode’. When enabled, the menu bar 
and the Dock take on a different look 
with a black background and white text.

Another striking interface change  
is that the behaviour of the Zoom 
button (the green button found at the 
top-left of most windows) has been 
changed. Now when you click that 
button, most apps switch to full-screen 
mode. Some Mac users find this odd 
and disconcerting. Holding down å 
while clicking the green icon reverts to  
the traditional behaviour of toggling the window 

by choosing  > About This Mac > More  
Info, and checking if the model name listed is 
within the ranges listed at support.apple.com/
kb/PH18947.

If your Mac isn’t compatible with these  
features, you may be able to activate them by 
connecting a Bluetooth 4.0 LE adaptor to your 
Mac and using a hack known as Continuity 
Activation Tool (http://bit.ly/continuityhack).

Another great, but resource hungry, new 
feature is the upgraded Spotlight, which now 
combines search results from apps, files and 
metadata on your Mac with content from online 
sources. Sources include Wikipedia, Bing Web 
Search, and content from the Mac App Store and 

Feast your eyes on all the 
features you can enjoy in 
the latest edition of OS X

between two sizes – typically the one 
you’ve chosen and a perceived best fit  

for the content.
OS X Yosemite isn’t just a visual 

refresh. Three big new features are 
Handoff, AirDrop with iOS, and 
Instant Hotspot, all of which 
integrate your Mac with nearby iOS 
devices. You will need a relatively 
recent Mac to access these features, 
because they rely on a combination 
of Wi-Fi and Bluetooth 4.0 LE. This is 

the latest version of Bluetooth (the 
LE stands for Low Energy). You can 

check whether your Mac is compatible 

Handoff
Handoff enables you to 
seamlessly move from one 
device to another and carry on 
working in the same app in an 
instant. If you are working on 
a document on your Mac – in Pages, for example – 
and you pick up your iPhone or iPad, you’ll see 
that app’s icon at the bottom-left corner of the 
Lock screen. Swipe upwards from it to be taken 
to the same app and document on your iPhone, 
ready for you to continue working.

Transparency
Many apps feature transparent 
areas that display a blurred 
view of the contents behind 
(typically either the desktop 
background or another 
window). The effect is like 
looking through frosted glass.

Full-screen button
The green button in the top-left 
of all windows is now a full-
screen button. Clicking it now 
takes an app into full-screen 
mode. Hold the Option key 
down to return to the older 
Zoom function.

Dark mode
OS X’s new ‘dark mode’ can be 
found in the General pane in 
System Preferences. Select the 
‘Use dark menu bar and dock’ 
option to give OS X a darker 
style with white menu text.

U

http://bit.ly/continuityhack


AirDrop
Yosemite expands 

the AirDrop feature to 
work not only between 

Macs, but also iOS 
devices. It’s much more convenient than 

transferring files using iTunes or email. 
Click on AirDrop in the Finder’s sidebar 
to locate all nearby devices. Like 
Handoff, only the more recent Macs 
feature the ability to transfer files 
between OS X and iOS.

Instant 
Hotspot

Yosemite improves 
how you get your Mac 

online using your 
iPhone. With both devices 

signed into the same iCloud account, you 
only need to click the Wi-Fi icon in the 
menu bar and click your iPhone’s name. 
Yosemite recognises that the phone 
is yours, so you won’t need to enter 
a password. It’s a real time-saver.
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Today
Notification Center has been 
overhauled and features two 
views: Today and Notifications. 
The Today view can also display 
small interactive apps, known 
as widgets.

iTunes Store. If you find these new search results 
intrusive, or don’t want to be upsold on iTunes 
content while searching your computer, then 
open System Preferences, click the Spotlight  
icon and, on the Search Results tab, deselect 
the options you don’t like.

Privacy advocates are pleased to hear that 
Yosemite introduces support for DuckDuckGo 
in Safari. DuckDuckGo is a search engine that 
promises not to track user behaviour. You can 
find its privacy policy at duckduckgo.com/about. 
If you dislike Google and Bing tracking your 
every move, open Safari and then choose Safari 
> Preferences > Search and change the search 
engine setting to DuckDuckGo.

The next edition of OS X is 
expected to be numbered 10.11, 
although Apple could jump to 
OS 11. We have no idea what 
codename Apple is using – it 
recently switched away from 
using the names of big cats to 
areas of California. While nothing 
is for certain, our first look at OS X 
10.11 will be at this June’s WWDC 
2015 event – we’ll tell you about 
that in issue 289.

There have been very few leaks 
regarding new features in OS X 
10.11. Apple is very good at 
controlling software secrecy, and 
most leaks come from factories 
and relate to hardware. We 
expect Apple to continue 
tweaking the interface and to 
continue blending features 
between OS X and iOS (perhaps 
Watch OS also). The new Force 
Touch trackpad will provide a 
new aspect to gesture-driven 
interaction and Apple is sure to 
find further uses for its next-gen 
touch-sensitive surface.

Integration with the Apple 
Watch may also arrive, and it’s 
time for Siri to make its way to 
the Mac. Read about our wishes 
for the next version of OS X in 
The Missing Pieces of OS X and 
iOS, which starts on page 78.

A new-look Dock 
and app icons
The Dock and icons have been 
redesigned with a new flat 
look. The Dock’s edges are now 
square, rather than diagonal 
and many icons are thinner 
and angled at 9°.

Spotlight
Spotlight has been radically 
expanded to include online 
information. As you search it 
displays results from online 
sources such as Wikipedia, 
iTunes Store and the App Store.

OS X 10.11 
rumours
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Quickfire tweaks
Give Yosemite a quick boost with these crafty tips

osemite is packed with options, features 
and modes that can radically change 

the way you use your Mac. These 
tips are a simple yet sure-fire way 
to improve your Mac experience for 
your personal needs, rather than 

fighting with defaults that might 
make life more difficult than it has to be.

Accessibility
The Accessibility pane in System 
Preferences contains a range of 

options designed primarily for users with 
impairments or disabilities. This causes most Mac 
users to overlook these options, which is a 
mistake because there are some options here 
that are useful to a wider audience. Go to System 
Preferences > Accessibility > Display to access  
a whole bunch of interface settings. Some, like 
Invert Colors are a bit too radical, but options like 
Increase Contrast, Use Grayscale and Reduce 
Transparency have practical benefits. Try 
combining the options here with the dark mode 
(go to System Preferences > General and turn  
on ‘Use dark menu bar and Dock’) to create a 
stylish alternative to the regular look.

Enhanced Dictation
While OS X doesn’t support Siri, you 
can dictate to it as an alternative to 

typing on the keyboard. Use the Shortcut 
command (by default, press the ƒ key twice) to 
bring up a microphone window. Speak whatever 
you want and it’ll be converted into text and 
dropped in at the insertion point in the active 

window. Dictation is surprisingly versatile, so 
don't be afraid to try it out in apps like Maps, 
Safari and Mail – say “Show commands” to see 
the instructions you can give in the current 
context. You can improve the experience by 
turning on Enhanced Dictation in System 
Preferences > Dictation & Speech, which enables 
you to use the feature when you’re offline. 

Automatic updates
Software updates often improve the 
performance, reliability and security of 

your Mac. Open System Preferences > App Store 
and put a check in the 
boxes next to  
‘Automatically check for 
updates’, ‘Install OS X 
updates’ and ‘Install 
system data files and 
security updates’. You 
can also choose to 
install updates for apps 
purchased from the 
Mac App Store and, if 
you don’t want updates 
to automatically install, 
you can have them 
download in the 
background so that 
they’re ready to install 
when you want to.

Search current folder
Finder’s preferences are easily 
overlooked because they aren’t 

located in System Preferences. That’s a shame 
because they include practical changes that 
make a world of difference. One tweak we like is 
to adjust the search bar so it looks in the current 
folder instead of the whole Mac by default. Click 
the desktop to switch to Finder, choose Finder > 
Preferences > Advanced and then change the 
bottom option to ‘Search the Current Folder’.

Manage Extensions
Extensions enable you to quickly send 
information from one app to another, 

or to share it online. Open System Preferences > 
Extensions to see those that are installed. 
Beneath each one are checkboxes that control 
where they appear, such as the Share menu and 
Notification Center’s Today view. Drag them up 
and down to change the order in which they 
appear in the corresponding part of OS X.

Additional gestures
In System Preferences, choose Mouse 
or Trackpad to view the gestures 

available for Apple’s trackpads and Magic Mouse. 
Some are turned off by default. Move the pointer 
over an option to see a video that demonstrates 
how that gesture works. Put a check mark in the 
box next to any gesture you want to activate.

OS X’s Accessibility preferences include options that are useful even if you don’t have difficulties with mobility, sight or hearing.

Some very useful trackpad and Magic Mouse gestures are turned off by default.
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Improve performance
Make your Mac move 
faster with our guide to 
optimising operating 
system performance

ne Yosemite feature everybody requests 
is that the operating system could 

simply run faster. A computer can 
never move quickly enough, and  
all slowdown and stutters are cause 
for consternation.

Perhaps the first, biggest and 
best advice you’ll ever hear for Mac 

performance is to free up more space on its 
storage. OS X continues to run even when your 
drive is full, but performance takes a major hit  
as it struggles to manoeuvre files. Freeing up 
storage space is often the single biggest 
enhancement you can give to OS X.

There’s no consensus as to how much free 
space you should have, but general advice 
seems to be at least 10% or at least 10GB, but 
we generally aim for at least 30GB of free space 
so we have ample room to work.

You can get a smaller, but useful, performance 
boost by removing all items from the desktop. 
Each item on the desktop takes up a small 
amount of memory. Having hundreds of desktop 
icons can cause slowdown on your Mac as those 
small amounts of memory accumulate. Try to get 
into the habit of not storing files on the desktop.

The same applies to third-party extras in the 
menu bar (those found on the right-hand side). 

Get into the habit of removing any third-party 
menu bar extras that you no longer use.

Spring cleaning 
Removing unwanted fonts can also give your 
Mac a pep up. Open Font Book (located in the 
Applications folder), select a font and choose 
File > Remove [font name] Family.

Alternatively you can revert to the default 
OS X selection by choosing File > Restore 
Standard Fonts. This removes all custom fonts 
from Font Book and installs the default selection. 

You can recover removed fonts from ~/Library/
Fonts (Removed) – the ~ means your user folder.

Older Macs running Yosemite run a lot more 
smoothly if you disable some of its advanced 
visual effects. Open System Preferences, click the 
Accessibility icon and select Display on the left. 
Turn on the Reduce Transparency option. On 
MacBook with 2013 or later in their model name, 
check that Power Nap is disabled when running 
on battery power (System Preferences > Energy 
Saver) as it can leave you with no power by the 
time you try to wake the Mac.

Start by right-clicking the Trash 
and choosing Empty Trash. Now 
choose old files and folders you 
no longer need and trash them. 
DaisyDisk (daisydiskapp.com) 
helps here. It displays your Mac’s 
storage as segments that show 
what’s using the most space. (The 
website version has features not in 
the Mac App Store version.)

Check your Music, Movies and 
Pictures folders. Remember that 
images in iPhoto must be deleted 
from within the app, which has its 
own Trash (choose iPhoto > Empty 
iPhoto Trash). If you’ve already 
moved to Photos, you can tell it to 
optimise files for available space.  
In its preferences, choose iCloud 
and then Optimize Mac Storage.

Monolingual (bit.ly/monomac) 
is great for removing unused 
languages from OS X. Often the 
biggest file hogs are old and little-
used apps. AppZapper (appzapper.
com) can removes application 
support files and preference files 
along with the app.

Cleaning 
up your 
storage

Keeping plenty of space free on your Mac’s system volume can help ensure OS X performance doesn’t grind to a halt.

O
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To take things further, you will need to 
upgrade the hardware in your Mac. Two 
upgrades can make a big difference: installing 
extra RAM and switching from a traditional hard 
drive to the newer technology of an SSD (Solid 
State Drive). The easiest way to determine if your 
Mac’s RAM can be upgraded is to visit Crucial  
(uk.crucial.com). Here you’ll find two tools, Crucial 
Advisor and Crucial System Scanner. The Crucial 
Advisor guides you through selecting your 
model of Mac, while the Crucial System Scanner 
is an app that automatically identifies it. You’ll 
need to bypass Gatekeeper to install it though. 
When you try to open the app it will warn you 
that the app is from an unidentified developer. 
Instead, right-click the app and choose Open, 
then press the Open button to run the app.

Installing a 2.5-inch SSD (which you can buy 
from some high streets retailers as well as online) 
is only an option on Macs with a Serial ATA 
connector inside, rather than more modern Macs 
which use storage that has a PCIe connector. The 
best way to discover what’s inside your Mac is to 
download an app called MacTracker (www.
mactracker.ca). Choose This Mac in its left pane 

Using OnyX to keep your Mac clean and tidy

and then Connections. Scroll down to find the 
Expansion category and check if ‘Serial ATA 
(SATA)’ is listed next to Hard Drive Interface. 

The easiest way to perform this upgrade is to 
get a USB to SATA cable and connect the SSD to 
your Mac. Next, use SuperDuper (shirt-pocket.
com) or Carbon Copy Cloner (bombich.com) to 

clone the internal drive to the new SSD. A quick 
guide to swapping out a Mac’s storage can be 
found in MF283.

Cleaning your Mac, turning off unused 
features and upgrading the hardware can turn 
even the oldest Mac into a snappy computer.  
So don’t leap into abandoning an old Mac.

Under Maintenance, you can check the startup disk’s 
structure and fix permissions, run OS X’s periodic 

maintenance scripts on demand, and fix service, cache and 
index problems. Check an option and click Execute to run it.

Under Cleaning, you can delete a wide range of system 
caches. This can recover storage space, although it can 

be counterproductive in the short run as apps use caches to 
load content, such as fonts, more quickly.

The Automation tab enables you to run a selection of 
operations to a schedule. There are three main sections: 

Maintenance, Rebuilding and Cleaning. Tick to select the 
options you want to run and click Execute.

On the Utilities tab, Terminal fans will appreciate manual 
pages for Unix commands. You can show and hide files, 

folders and even volumes here, and execute hard-to-find 
built-in apps such as Directory Utility. Geeks will enjoy rooting 
around here, but be careful before using some features.

Parameters enables you to adjust several defaults used 
in various places around OS X. You can disable visual 

effects and animations, Mission Control and Dashboard, and 
customise many hidden options in Finder, Dock, Safari and 
iTunes. Click Restore Defaults to return to the original settings.

Under Log you’ll find a list of all operations that have 
been executed by OnyX. Click ‘Reveal in the Finder’ to 

open a Finder window with the OnyX.log file selected. It’s a 
text file of this information, which you can search in TextEdit.

OnyX (titanium.free.fr) is a handy app 
for performing Mac maintenance. It can 
also turn on hidden functions and assist 
you in cleaning up your Mac. If you have 
Gatekeeper enabled you’ll need to 
right-click the app and choose Open, 
and then press the Open button in the 
next dialog to allow OnyX to run. 

On first run, OnyX has to verify the 
startup disk, a process that may take 
some time. It’s important to use Time 
Machine or another backup solution 
prior to running OnyX as it can make 
changes to the file structure.

You’ll find a tutorial about other things 
OnyX can do on page 52 of this issue.
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In Font Book, removing fonts that you no longer need or restoring OS X’s default set can free up valuable resources.
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Boot up faster
Get your Mac to start more quickly with these simple tricks

ne area that most people want to see 
improved is their Mac’s startup time. 

Even if you have the fastest, most 
modern Mac, it can still take 
minutes to start up, and the whole 
process is excruciating if you need 

to use your Mac in a hurry.
On the hardware side of things, 

upgrading to an SSD ensures that a Mac boots 
more quickly. However, many performance tricks, 
such as cleaning out the hard drive and reducing 
animations and effects, have minimal impact 
because OS X hasn’t yet loaded into memory. 
Having said that, there is a range of tweaks you 
can perform to ensure Yosemite loads quickly.

The first thing to do is check what is listed 
under Login Items in System Preferences, and to 
remove any you no longer need (see the steps 
opposite for details). These aren’t the only items 
that Yosemite loads at startup, though. You can 
find more in StartupItems in the system’s Library 
folder – to get there quickly, choose Go > Go 
to Folder… in the Finder and enter /Library/
StartupItems). These are the system-wide startup 
items that apply to all user accounts. It’s worth 
taking a look to see if any of the items relate to 
things you no longer use. You’ll need to enter an 
Admin account’s credentials to delete items here.

A third place to check is the Dock. Restart your 
Mac to see which apps are started by default 
(these are the ones with small white circles 
beneath them in the Dock). Control-click the 
app’s Dock icon, select Options and select the 
Open at Login option to remove the tick from 
next to it. Rather than asking an app to open 
each time you log in, it is better to open it when 
you actually need it.

Security slowdown
FileVault is a security feature that encrypts all 
of the contents on your Mac’s startup volume. 
While FileVault has its uses, it slows down the 
login process and some Yosemite users have 
noted extremely slow login performance with it 
enabled, so you should turn it off if you can live 
without it. Open System Preferences > Security & 
Privacy, click the FileVault tab, then the lock icon 
(enter your password) and click Turn Off FileVault.

Sometimes peripherals can slow down the 
login process, so if you find login sluggish, try 
disconnecting peripherals and reconnect them 
one at a time. Keep any devices that you don’t 
use regularly disconnected.

Finally, learn to put your Mac to sleep instead 
of shutting down, so you can pick up where you 
left off without enduring the whole startup cycle.

Quick-start  
your Mac

Disable Login items
Open System Preferences > Users & 
Groups > Login Items to reveal a list of 

items that open when you log in. The more 
items, the slower your startup process will 
be. You might no longer be using some of 
these items. Clearing the checkbox doesn't 
stop the item from loading. Instead, select 
an unwanted item and click the ‘–’ button.

Don’t reopen windows
Choose  > Shut Down and deselect 
the ‘Reopen windows when logging 

back in’ option. This prevents OS X wasting 
valuable time opening unwanted apps and 
windows. Click Cancel if you’re not ready to 
stop your Mac just yet; the option stays 
deselected until you re-enable it.

Fast user switching
This feature is handy in that one 
person can quickly do something in 

their account without disrupting another’s 
workspace, but it’s best if accounts aren’t 
left logged in on a Mac with limited system 
resources. It can be entirely disabled under 
Login Options in the Users & Groups pane.
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Advanced commands
Get under the hood and tweak Yosemite to your heart’s content

ong-term OS X users will be well aware 
that Terminal hacks can be used to 

adjust aspects of OS X. Over the 
years of its existence, the operating 
system has accumulated a bunch of 
commands that can be used to 

make it work better for you. These 
commands typically start with 

defaults write. Most users copy and paste 
them from a website into the Terminal app, 
which provides a command line from which to 
enter Unix commands and interact with OS X. 
Terminal will feel familiar to older users who 
remember what it was like before graphical user 
interfaces became commonplace. Far from being 
underhand hacks, these hidden settings are 
created – but often unpublicised – by Apple.

Hidden preferences
There are more settings available than you are 
given access to in System Preferences. You can 
make adjustments to these settings using the 
defaults command in Terminal. It’s also possible 
to set values for settings without being limited to 
the range that’s presented in System Preferences. 
For example, you can make the Dock huge, and 
you can completely turn off Mission Control.

Most people copy and paste defaults 
commands without really realising what it’s 

doing. There’s nothing wrong with doing that, 
but it’s important to know how you can reverse 
the process prior to doing it.

If you want to know what’s going on when 
you use the defaults command, open Terminal 
and enter man defaults. Read through the 
command’s manual by tapping any key, and 
press q to get back to the command line.

Most tweaks are made by typing defaults 
followed by write, which tells the command 
you want to make a change. After that comes 
the name of the system file containing the 
preference to change, such as com.apple.
finder or com.apple.dock, and after that 
comes the name of the preference itself, such as 
magnification, followed by the value type 

Customise the login window

1
 Install Deeper

Customising OS X’s Login window is 
one of the coolest things you can do 

to personalise your Mac. The default image is 
your desktop wallpaper with a blur effect, but 
it’s really just a file called com.apple.desktop.
admin.png tucked away in /Library/Caches 
which you can manually replace, though it’s  
a lot easier to use Deeper (titanium.free.fr).

2
Change the 
background
Open Deeper and click the Login 

icon in its toolbar. Click the Select button next 
to Background, browse to the file you want to 
use in place of your desktop background and 
select it. Click Choose and it will be formatted to 
the correct dimensions (1920x1080 pixels) and 
saved in the correct place for OS X to use.

3
Add a custom 
message
You can also add personalised text to 

appear above the Login window’s Sleep, Restart 
and Shut Down buttons. Select ‘Show message 
in the login window’ option and enter your 
message in the text box below that. Click Apply. 
Now choose  > Log Out… to view your 
customised login image and message.

If you’re reluctant to type commands that modify your Mac’s behaviour, apps such as TinkerTool give you many of the same results.
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Tweak your settings with TinkerTool

You can show hidden files using the 
Finder options in TinkerTool. But we like 

many other options found here, such as the 
ability to add a Quit item to the Finder menu, 
and restrict access to features such as Connect 
to Server, Eject, and Go to Folder. Handy if you 
want to create a foolproof system.

One item to look out for is ‘Use 
transparent icons for hidden 

Under General are options to adjust the 
format of screenshots, and where they 

are saved. ‘Prefer expanded Save dialogs when 
using new applications’ makes apps display 
the expanded dialog when you choose Save 
As. These become active next time you log in.

Developers will appreciate the debug 
and diagnostic menus that can be 

enabled for various apps. Quit each app, check 
the box for the menu you want to enable, log 
out and in again, and then reopen the app.

You can adjust the fonts and their sizes 
for various parts of OS X’s interface. Click 

Change and choose a new font for apps. This 
only affects the native apps, but it’s a neat way 
to adjust a lot of the interface.

The Reset option provides two options: 
‘Reset to pre-TinkerTool state’ and ‘Reset 

to defaults’. The latter is useful if you have 
adjusted things using Terminal commands 
and want to reset OS X to its default state.

TinkerTool (bresink.com) is a long-standing app 
for tinkering with various system settings. It’s a 
smart tool to have in your Applications folder, 
because it enables you to adjust far more 
options for Finder, the Dock and the desktop 
than are available in System Preferences. 
TinkerTool offers a graphical interface for many 
of the defaults commands you would otherwise 
have to type into Terminal, making it a much 
less intimidating way to fine-tune OS X.

and the new value you want to set – for example, 
-boolean true or -integer 128.

If you want to see what’s going on inside the 
.plist files that store preferences, try substituting 
read for the command’s write parameter. For 
example, enter defaults read com.
apple.finder in Terminal to read all the 
settings for the Finder.

For the most part you’ll enter the commands 
we present here, or that you find on the internet 
to change the settings – leave it to OS X experts 
to discover what commands work in each version. 

You should close any app before adjusting its 
preferences, and if the thing whose behaviour 
you’re modifying is a fundamental part of OS X, 
such as the Dock or Finder, you will need to 
enter a command to relaunch it, such as the not-
as-scary-as-it-sounds killall finder or 
killall SystemUIServer.

Here are some useful commands to get you 
started. To show all files, including system ones 
that are normally hidden, in the Finder, enter 
defaults write com.apple.finder 
AppleShowAllFiles true; killall 
Finder followed by ®.

To change the format of screen shots, type this 
command: defaults write com.apple.
screencapture type jpg; killall 
SystemUIServer followed by ®. You can 
substitute jpg, gif, png, pdf or tiff as the value.

Make the Dock comically large by typing 
defaults write com.apple.dock 
largesize -int 512; killall Dock 
followed by ®. Reset it to a sensible size by 
dragging the Magnification slider in System 
Preferences > Dock.

Selecting a file in the Finder and pressing the  
spacebar displays a preview of it. Enter this 
command and you’ll be able to copy and paste 
from it: defaults write com.apple.
finder QLEnableTextSelection 

-bool true; killall Finder and then 
press the ® key.

Turning on single app mode makes it so that 
switching to an app will instantly hide all others. 
While it's not the easiest way to use a Mac, it’s 
great for concentration. Enter this: defaults 
write com.apple.dock single-app 
-bool true; killall Dock and press 
® . Turn it off using the same command again 
with false at the end instead of true.

 There are hundreds of other defaults 
commands available, and keen Apple fans are 
often finding new ones. Keep an eye on websites 
such as defaults-write.com and secrets.blacktree.
com to discover fresh commands when a new 
version of OS X is released.

applications’. When enabled, the Dock icon 
for any app that’s hidden will become 
transparent. Also, the Launchpad options 
make that feature much faster to use. Click 
Relaunch Dock to put these into effect.

The defaults command can be used to tweak many behaviours that have no graphical control in System Preferences.
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HyperDock (€6.95 – about £5, hyperdock.
bahoom.com) adds new features to the Dock, 
perhaps the most useful being previews of 
each window that’s open in an app when 
you place the pointer over its icon. It also 
enables additional functionality for specific 
apps when you hover over their icon. For 
example, Calendar displays upcoming events 
and iTunes displays album art and playback 
controls. Holding down å while clicking an 
icon switches to Mission Control for that app's 
windows (similar to how Exposé worked in 
older versions of OS X). 

Finally, HyperDock features handy shortcuts 
for automatically resizing windows. Holding 
≈+å and tapping the arrow keys resizes 
the active window and moves it to the left- or 
right-hand side of the desktop. It adds 
Windows Snap-like shortcuts to OS X as well.

HyperDock

Alfred or 
QuickSilver

Cocktail

Satellite Eyes

These popular apps 
both offer similar 
functionality: they 
enable you to replace 
many of the 
commands you’d 
normally perform 
with a mouse using 
the keyboard. Alfred 
(alfredapp.com) and 
QuickSilver (qsapp.
com) can move files, 
search your contacts, perform system commands (such as Sleep or Empty Trash). They offer a 
huge range of extra functionality, but both take some learning. Keen OS X users swear by the 
productivity gains acquired by taking some time to learn about their extensive capabilities.

Cocktail ($29 – about £19, maintain.se) is a general-
purpose optimisation utility for OS X that runs 
maintenance scripts. Many of its features are similar to 
OnyX, but it has a much friendlier interface. It has 
a mode called Pilot that enables you to schedule when 
maintenance scripts run. Network administrators can use 
it to tweak network performance, including capping the 
speed at which interfaces connect. Cocktail also enables 
one-click fixes of databases used by Spotlight, Mail and 
Time Machine, making it a quick way to overcome 
problems you might encounter with those features.

Satellite Eyes (satelliteeyes.tomtaylor.co.uk) 
turns your Mac’s desktop background into 
satellite photography of the computer’s 
current location. It’s a fantastic tool if you 
work on the move with a MacBook because 
it gets you closer to whatever area you’re in. 
It’s basic, but also a lot of fun. The app needs 
access to your location through OS X’s 
Location Services feature, which is managed 
in System Preferences’ Security & Privacy pane.

Cool customisations
Investigate these apps to radically change OS X Yosemite

Nerdtool (free, 
mutablecode.
com) enables 
you to display 
information on 
your desktop. 
You can overlay 
the desktop with 

calendar information, quotes, map data, 
weather information, web pages and 
information about the status of your Mac. 
The app enables you to choose which font is 
used, and the size and colour in which things 
are displayed. It can be quite a complex 
experience for newcomers, but follow this 
tutorial at MakeUseOf to get the hang of 
things: bit.ly/nerdtooltutorial.

If you miss the coloured folders from earlier 
editions of OS X then check out TotalFinder 
($18 – about £12, totalfinder.binaryage.
com). Yosemite’s coloured tags appear as 
small circles. TotalFinder enables you to 
change the colour of a whole folder, which 
is great for highlighting important items. 
It also adds a split-pane view and makes 
a Finder window only ever a key press away.

NerdtoolTotalFinder
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Make a Retina-
like display
Make OS X look sharper on a regular 
monitor by turning on HiDPI mode

Switching to HiDPI mode

1  Enable HiDPI
In Terminal, enter: sudo defaults 
write /Library/Preference

s/com.apple.windowserver.plist 
DisplayResolutionEnabled -bool 
true followed by ®. You’ll then need to enter 
an admin account’s password. Afterwards, when 
you see the command prompt again, log out of 
your account, and then log in again.

2  Select a HiDPI otption
Open System Preferences and click 
the Displays icon. Hold down å and 

click on the Scaled option to reveal a list of 
resolutions. Several are marked as ‘low 
resolution’. If you select one of those options, 
the desktop will be proportioned for that 
resolution, but it will be rendered in HiDPI 
mode, so it will appear sharper than normal.

3  Quickly switch modes
You can switch between HiDPI and 
normal resolutions in the Displays 

pane at any time. If you find yourself doing so 
frequently, try SwitchResX (free, madrau.com). 
This adds an icon to the menu bar that enables 
switching between resolutions in a couple of 
clicks – something that Apple used to allow 
from the Displays menu extra but took away!

any Apple fans covet the Retina display 
found on the iMac and MacBook 

Pro. What many don’t realise is that 
the special rendering mode OS X 
this uses to draw the desktop in 
finer detail is available on Macs 

with regular displays, too, and that 
it can have practical benefits.

HiDPI mode is enabled by default on Macs 
that have a built-in Retina display, and that’s why 
the desktop is drawn at sensible proportions. 
You won’t see any reference to HiDPI in System 
Preferences’ Displays pane on these Macs. Rather, 
clicking the Scaled option reveals settings similar 
to ‘Looks like 1440x900’. The display itself has 
many more pixels than that. The scaling options 
tell OS X to draw things at the same proportions 
they would appear on a non-Retina display, and 
to use the extra pixels that are available to draw 
things in much finer detail. That’s why you see 
increased detail in icons and text has a much 
smoother appearance on a Retina display.

If you connect an officially-supported, external 
4K display to a Mac, the desktop should appear 

Less fits on the screen – you won’t be able to see 
as much of a web page or a document at once, 
for example – but things look clearer. You might 
find this trade-off between space and clarity is 
beneficial if you find things are normally a little 
too small or you have trouble distinguishing 
characters. You could switch to a lower resolution 
without enabling HiDPI mode, but OS X will draw 
the desktop at that resolution and then upscale 
it to fill the screen, which can make things fuzzy.

Enabling HiDPI is as easy as running a Terminal 
command (see below), logging out and back in 
again, then picking a new display resolution.

at similarly sensible proportions. 
However, some displays cause 
OS X to display things at a very 
small size, making text difficult – 
if not impossible – to read. In this 
case, it’s essential that you enable 
HiDPI mode.

HiDPI on low-res
HiDPI mode isn’t only available on 
displays that genuinely have a high 
pixel density. It can be enabled on any  
Mac using a simple Terminal command.

What this won’t do is increase the number of 
pixels in your display beyond what’s there in the 
first place. However, when enabled on a 27-inch 
iMac with a regular display, on which the display 
has a 2560x1440-pixel resolution, HiDPI enables 
everything to be drawn at twice the size but 
with increased fidelity. In effect, this halves the 
usable workspace on the desktop, so everything 
is proportioned like it would be on a 1280x720-
pixel display. You might find this uncomfortable 
at the distance you normally sit from your Mac. 

M
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If you’ve installed Yosemite 
on your Mac, by now you 
have probably updated it 
to version 10.10.3, which 

introduces the new Photos app to 
replace iPhoto. If you’ve used the 
eponymous app on an iPhone, iPod 
touch, or iPad, the Mac version will seem 
familiar. It provides the same ways to 
explore your photo library, the same 
methods for organising photos into 
curated albums and sharing them with 
other people, and the same easy-to-use 
yet powerful toolset that makes it 
possible even for a newcomer to make 
photos look their best.

When you select the Photos view at 
the top of the window, the app displays 
all of your photos in chronological order. 
The arrow buttons at the top-left of the 

window zoom in and out through 
several levels. At the most zoomed out, 
photos are grouped into years. Click and 
hold on a thumbnail to see a larger 
preview, and let go to have that photo 
enlarge to fit the window. Alternatively, 
just click once to see Collections. These 
group photos by broad geographical 
regions, possibly over long periods of 
time. The click and hold technique 
works here too, or you can click a 

thumbnail to see Moments, photos 
taken over shorter periods of time and 
at more precise locations. Double-click 
a picture here to enlarge it, and then 
swipe left and right (with two fingers on 
a trackpad, one on a Magic Mouse) or 
use the arrow keys to step through the 
Moment. You don’t need to click the 
back button to quickly reach a specific 
photo. Instead, click the button to the 
right of that one to split the view, which 
will show other pictures from the 
Moment down the left of the window.

The app manages the contents of 
these views for you, based on data that 
your camera attaches to each photo you 
take. If your camera isn’t a phone, ensure 
its clock is correctly set. Some cameras – 
especially those built into phones – can 
automatically attach location data to 

Learn how to manage your photo library with Apple’s brand-new app

SKILL LEVEL
Anyone can do it

IT WILL TAKE
Give yourself at 
least 30 minutes

YOU’LL NEED
OS X 10.10.3

Discover the power of Photos

The Mac version of 
Photos has eight 
built-in filters and 
manual controls for 
manipulating colour

Photos is packed with 
simple yet powerful 
tools for editing images.
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Various views
1  Photos shows your pictures in 

chronological order. Albums 
contains your curated collections. 
Shared shows photos you’ve 
published to iCloud for others to 
see, and Projects is where you 
design calendars, books and other 
things to be professionally printed.

See more or less
2  Drag this slider to resize the 

thumbnail previews below.

Make things
3  Click the + button to make 

albums and to showcase your 
photos in printable projects.

Share things
4  Click this to email what’s 

selected, publish it to a social 
network, or share it using iCloud. 

QUICK LOOK | FInD YOur WAY ArOunD PHOTOS FOr OS X

photos. If yours can’t, you can look up 
places by name or postcode and attach 
this detail.

You can curate your best photos into 
albums, either manually or by specifying 
criteria, such as locations and keywords 
you’ve attached. The latter method, a 
Smart Album, is powerful because the 
app updates its content over time to 
reflect changes in your library.

Thankfully, Photos hasn’t ditched its 
predecessor’s creative projects, so you 
can add your photos to books, calendars 
and greeting cards, and have these 
mementos professionally printed.

Photos can use iCloud to make your 
entire photo library available on all of 
your Apple devices (well, those running 
Yosemite or iOS 8) without you having 
to choose when and what to sync. Take 
a photo with your iPhone and the next 
time that device goes online using Wi-Fi, 
the photo will sync to iCloud and then 
appear on your Mac. It works the other 
way too, for photos added on your Mac.

Sadly, the Mac version of Photos lacks 
some extensibility found in its iOS 
counterpart, so photography apps are 
unable to make their filters and editing 
tools available within it. For now, at least, 

you’re limited to eight built-in filters. 
That’s not all the creative control at your 
fingertips, though. You also get manual 
controls for manipulating colour.

It’s not all bad news where expansion 
is concerned, either, because Photos 
provides an AppleScript library, which 
enables developers to extend it with 
new behaviours. OS X Automation 
(macosxautomation.com) has already 
tapped into this to provide a set of 

Automator actions, which are a much 
easier method of tailoring the app to 
your needs than learning a scripting 
language. On the site, you’ll find 
examples of how you might use these 
actions, including one that opens the 
Maps app at the location where the 
selected photo was taken. After reading 
our tutorial, it’s worth exploring these 
actions to see how they might work 
for you. Alan Stonebridge

GO OLD-
SCHOOL
If you dislike 

Photos’ layout, 
you can bring 

back the sidebar 
method of 

navigating your 
albums and 
projects by 

choosing View > 
Show Sidebar.  

This removes the 
view buttons 

from the top of 
the window and 

expands their 
contents down 
the app’s left-

hand side.

Photos turns dark when editing images, which is a great opportunity to use Yosemite’s so-called dark mode.

1
2

3

4
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If you’ve already amassed 
a library of photos in either 
iPhoto or Aperture, Photos 
can import its contents. 

For most people this is a straightforward 
process. If you have just one library on 
your Mac, you only need to open Photos 
and click Get Started. The app will copy 
the contents of the existing library into 
a new one that’s used only by the 
Photos app, and the old one will remain 
so that you can continue to use iPhoto 
or Aperture. (That said, making a backup 
first is wise, in case you run into an 
unexpected problem.)

When you click Get Started, Photos 
might complain that permissions on 
your library need to be repaired before 
it can be imported. To fix this, make sure 
the old app isn’t open, hold å+ç and 
then open that app to display its 
maintenance options. run the option 
that repairs permissions, then close the 
app and try again in Photos.

If Photos detects that there’s more 
than one iPhoto or Aperture library on 
your Mac, it will ask which you want to 
import. Afterwards, Photos’ File > Import 
option doesn’t import or merge another 
library (it is for importing files stored 
loose on a disk into the current library). 
Photos provides no way to merge the 
contents of two libraries (at least not 
without an iCloud trick).

Just like iPhoto and Aperture, you can 
create and switch between several 
libraries in Photos. To import a second 
library into Photos, close the app, hold 
å and reopen it to display a list of other 
detected libraries, along with options to 
browse for one that isn’t shown and to 

create an empty library. Choose another 
library to import and a new copy for use 
with Photos will be created alongside 
the original version.

 Photos uses a feature of the unIX 
system on which OS X is built to enable 
its library, and iPhoto’s, to point to the 
same data without storing it twice. OS X 
counts references to that data, and your 
iPhoto library can be trashed without 
removing the data it and Photos share.

If you’ve ever used the option to store 
photos outside of the library package 
(possible in both iPhoto and Aperture), 
those master files will remain where 
they are and be referenced from your 
old and new libraries. referenced files 
have a consequence for iCloud Photo 
Library – they won’t be uploaded to it. 
Find out on page 48 about this feature 
and how to overcome this limitation.

You can migrate as many iPhoto and 
Aperture libraries as you want, and one 
will be designated as the System Photo 

Library. Only this one’s contents are kept 
in sync with iCloud Photo Library, and 
appear in the Media Browser in other 
apps, including Pages and iMovie.

Earlier, we mentioned a technique for 
merging libraries. In the dialog that 
appears when you open Photos with å 

held, the System Photo Library is 
denoted. Open a different one, choose 
Photos > Preferences > General, turn on 
‘use as System Photo Library’ and, in the 
iCloud tab, turn on iCloud Photo Library. 
The library’s contents will be merged in 
iCloud with whatever has previously 
been uploaded. This cannot be undone. 

Photos will warn you if your iCloud 
storage is insufficient for all of your 
photos. If you don’t want to pay for 
more, or the maximum tier of 1TB isn’t 
enough, follow Apple’s suggestions at 
support.apple.com/HT204410.

iPhoto and Aperture enable you to 
denote the relative worth of a photo by 
assigning a star rating out of five, and 
to flag a photo as a reminder to do 
something with it. Photos doesn’t have 
such granular options. Instead, you can 
simply mark a photo as a favourite. 
However, your ratings and flags aren’t 
lost when moving to Photos. Apple’s 
solution is to convert these attributes 
into keywords, which you can look up 
from the search bar and in the criteria 
of a Smart Album.

Import your existing library
Some things to note if you’re migrating from iPhoto or Aperture

Star ratings and flags 
are converted into 
keywords, which can 
be inspected by a 
Smart Album’s rules

iPhoto Events are converted into albums and placed in a folder called iPhoto Events in the Albums view.

If you use iPhoto 7 or 
lower, run its library 
through iPhoto Library 
Upgrader (support.
apple.com/kb/DL1523)

LOOSE 
FILES

Photos that are 
stored outside of 

the library 
package can be 
copied into it. 

Select them and 
then choose File 
> Consolidate. 

The app tells you 
if none of the 

selection is 
stored externally, 
otherwise it asks 
you to confirm 

before it 
proceeds. 
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1 Create an album
Choose File > New Album and name it. 

The window will show your photos as moments 
(taken around the same place and time). Click a 
photo to select it for inclusion in the album, or 
put the pointer over a moment’s title row and 
click Select Moment to mark all of its contents.

4 Organise your albums
In the Albums view, those you’ve created 

can be dragged around to rearrange them. 
Folders can be used to group albums (and other 
folders). Choose File > New Folder to make one. 
When a folder is selected, the Play and Share 
buttons will act upon its entire contents. 

6 Mark a favourite photo
To mark a photo as a favourite and have 

it appear in the Favorites album, put the cursor 
over it and click the heart at its top-left, or select 
several photos and click the heart on one to 
mark them all. Or, while viewing a single photo, 
click the heart in the toolbar or press the . key.

2 Add photos to an album
While marking photos for inclusion, click 

Selected (top-left) to review your choices. Click 
a photo again to remove the tick and exclude it. 
When you’re satisfied, click Add (top-right) to 
see the album’s new contents. Click Albums or 
the back arrow in the toolbar to see all albums.

5 Play a slideshow
Select one or more albums or folders, or 

open an album and select some of its contents 
(hold ç to select more than one item), then 
click the Play button in the toolbar to choose a 
presentational theme and music (including from 
iTunes) to accompany your slideshow.

8 Quickly find people
The Faces album shows people detected 

in your photos. Double-click and name one. 
You’ll see other photos thought to be of them, 
and be asked to confirm or correct. When done, 
the person’s face appears larger in the album 
and acts a shortcut to all photos of them.

7 Show more information
Select Window > Info to see metadata for 

the selected photo, such as camera settings and 
where it was taken (if recorded). You can add a 
title, description, and keywords (press ® after 
each), all of which Smart Albums can inspect. 
You can also manually identify people.

3 Create a Smart Album
Pick File > New Smart Album to set rules 

that automatically gather photos from your 
library. Click the + to add more criteria, and 
choose whether any or all must match. Later, in 
the Albums view, click the cog next to a Smart 
Album’s name to modify its criteria.

HOW TO | OrGAnISE YOur PHOTOS

SLIDESHOWS
Slideshows created with the 
Play button aren’t saved, but 

those made with the + 
button are kept in the Projects 
view. They can be turned into 

videos using File > Export. 
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1 Upload from iOS
Using your iOS device, take a photo. 

Next, connect your device to a Wi-Fi network. 
That’s it – your device will upload the photo you 
took to iCloud. You can confirm this is done in  
Settings > iCloud > Photos, which shows a 
count of how many uploads are pending.

3 With other cameras
If you use another type of camera, don’t 

worry – pictures you import to your Mac’s photo 
library will be uploaded to the online one, too. 
After importing, open Photos’ preferences and 
click iCloud if you want to monitor the progress 
of the upload, or if you want to postpone it.

2 Upload burst photos
All shots in a burst photo (where, on a 

recent iOS device, you hold down the shutter 
release to take several photos and then let iOS 
pick the best) are uploaded by default. To save 
space in iCloud, turn off Upload Burst Photos so 
only shots marked as favourites are uploaded.

using iCloud Photo Library
Discover how your photos are stored online and synced to your devices

iCloud Photo Library 
is Apple’s new 
method for making 
all your photos 

available on all of your devices, no 
matter what camera they’re taken 
with or which device’s photo 
library you import them into. To 
use it, your Mac must have 
Yosemite and your iOS devices 
must be running iOS 8.

In Photos’ preferences, click 
iCloud and check the iCloud Photo 
Library box. It starts uploading 
photos from its library to iCloud. 
This can take a while, so if you 
need bandwidth to, say, more reliably 
stream online video, return here and 
click the ‘Pause for one day’ button. 
(That button‘s behaviour then changes 
to enable you to manually resume 
photo uploads without waiting.)

Enable iCloud Photo Library in iOS 8 
in Settings > iCloud > Photos. While 
connected to Wi-Fi, your iOS device will 
upload the photos it contains. 

Both OS X and iOS offer a choice of 
whether photos are downloaded at full 
quality or as smaller versions optimised 

for the device you’re using. Bear in mind 
that you’ll need plenty of iCloud storage 
for all of your photos, and that it’s also 
used to store email, backups and more.

In Photos’ preferences, under General, 
is an option that determines whether 
image files you drag into the app are 
copied into the app’s monolithic library 
file. If you turn this off, dragged photos 
are referenced in their current location. 
This gives some freedom to organise the 
originals, but has a significant drawback: 
referenced photos aren’t uploaded to 

iCloud Photo Library. To determine if 
your library links to any photos in this 
way, switch to the Photos view and 
press ç+A to select everything. next, 
choose File > Consolidate. If everything 
is stored inside the library, the app will 
confirm. Otherwise, you’ll be warned 
first that the process can’t be undone.

note that iCloud Photo Sharing is 
a separate feature with a different 
purpose – to share photos with other 
people and, optionally, comment on 
them. See opposite to learn more.

PHOTO 
STrEAM

This old method 
of getting 

photos onto 
other devices 

(bit.ly/photostr) 
remains available 
in case you have 

devices that 
can’t run iOS 8 or 
Yosemite. If you 

don’t need it, 
make sure it’s 

disabled in the 
iCloud tab 
in Photo’s 

preferences.

With iCloud Photo Library enabled, photos taken with your iPhone are automatically added to your Mac.

HOW TO | MOVE TO iCLOuD PHOTO LIBrArY
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1 Add keywords
Keywords can be added to a photo by 

two methods. The first is to choose Window > 
Info. In the window that appears, you can type 
keywords or phrases. Press ® after each one. 
You’ll be offered suggestions from previously-
used keywords as you type.

4 Subscribe to an album
When someone shares an album with 

you, you’ll be alerted by email and whatever 
methods you’ve configured for Photos in the 
Notifications pane in System Preferences. Open 
the app, click Shared and double-click Activity 
to see options to accept or reject the invitation. 

6 Import shared photos
To keep a copy of shared photos (in case 

the owner removes them from the shared 
album), select them, right-click on one of them 
and then choose Import. Note that if you try to 
edit a shared photo, you’ll be offered the option 
to import it to make that possible. 

2 The Keyword Manager
Choose Window > Keyword Manager to 

see all keywords you’ve used. Click one to apply 
it to the photos you’ve selected, or remove it if 
already applied. Click Edit Keywords to create or 
destroy keywords (the latter clearing them from 
photos, too) and to assign keyboard shortcuts.

5 Shared album settings
Double-click an album in the Shared 

view to open it. At its top-right is an option to 
add to it, and a button with a silhouette of a 
person. Click the latter to check who can view 
the album, who can add to it, and whether you 
get notifications for new items and comments.

8 Delete photos
When you right-click a photo and choose 

Delete, it is hidden on all of your devices. For a 
short time, it can be recovered by choosing File 
> Show Recently Deleted. Click photos you want 
to keep, then Recover, or click the Delete button 
to properly get rid of them right away.

7 Hide photos
A photo can be hidden from the Photos 

view by right-clicking it and choosing Hide. 
(It will remain visible in albums to which it has 
been added.) To unhide a photo, choose View > 
Show Hidden Photos Album, browse to that 
album, right-click a photo and choose Unhide. 

3 Share photos on iCloud
You can share photos with other people 

using albums hosted on iCloud. Select some, 
choose File > Share > iCloud Photo Sharing, and 
click New Shared Album. Name it and enter 
names or addresses of contacts to share it with, 
and then Create to send the invitation. 

HOW TO | CATEGOrISE AnD SHArE YOur PHOTOS

COMMENTS
To comment on or indicate 

that you like a photo in a 
shared album, double-click it 

to view it larger and then 
click the speech bubble at 

its bottom-left corner.
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1 Quickly edit a photo
Select a photo and press ®. The app’s 

interface turns dark to put the emphasis on the 
picture. OS X’s dark mode (in System Preferences 
> General) complements this look. Among the 
tools on the right, Enhance will try to improve 
your photo with a single click.

4 Clear up blemishes
The Retouch tool clears up blemishes by 

sampling pixels from one area as the basis for 
filling in another. The tool picks a source area. 
Override its choice by holding å and clicking 
somewhere. Let go and then brush out the 
unwanted detail. [ and ] adjust brush size. 

6 In greater detail
Click the arrow to the right of the Auto 

button and the components of that adjustment 
are revealed. They can be adjusted individually 
using the same click and drag action. Do this for 
Light, but drag on its main bar to see how this 
changes its components by different amounts.

2 Adjust framing
Rotate turns a photo in 90° increments. 

The Crop tool can rotate to any angle while 
maintaining the overall rectangular shape. 
You can manually drag the white border to crop 
without rotating. Pressing Auto attempts to 
straighten things along a perceived horizon.

5 Advanced adjustments
The Adjust tool displays adjustable 

attributes as horizontal bars. Click and drag 
along a bar to adjust that attribute. Moving the 
pointer over an adjustment’s title row reveals an 
Auto button which, like the Enhance tool, sets 
the attribute to a good level with just one click.

8 Reuse a photo’s look
If you find you adjust the same attributes 

often, check them all in the list and choose ‘Save 
as Default’ in the list. To apply adjustment values 
from one photo to another, right-click the photo 
and choose Copy Adjustments, edit another, 
right-click it, and choose Paste Adjustments.

7 Even more adjustments
Click the tick next to an adjustment to 

disable it, or click its name to reset or remove it. 
Click Add (top-right of the list) for other effects 
that work in the same way except for Levels, on 
which you drag the dots below the histogram to 
fix things such as colour balance and exposure.

3 Apply a filter
The Filter tool offers a range of premade 

looks for your photos. Click one to toggle it on 
or off so you can judge its aesthetic. Click Done 
at the top-right to apply it. The same eight filters 
are available in Photos on iOS, so any you apply 
will be preserved as you move between devices.

HOW TO | IMPrOVE THE LOOk OF  YOur PHOTOS

rOLL BACK
Changes to a photo can be 
reversed by editing it again 

and clicking revert. To make 
Independently editable 

copies, select a photo and 
then press ç+D.



Digital version 
with this 

book!

FREE

pages of 
practical OS X 

advice

180

Available at all good newsagents or visit
www.myfavouritemagazines.co.uk/computer

http://www.myfavouritemagazines.co.uk/computer


52  |  MacFormat.com  |  June 2015

improve   |   Mac Apps  

Think of OnyX as 
a Swiss Army knife 
for your Mac. It 
incorporates a number 

of tools which allow you to carry 
out maintenance and cleaning, 
verify your startup disk and file 
structure, and access hidden 
parameters so you can customise 
how the OS and many of its 
included applications work.

OnyX incorporates two other 
tools from the same company, 
Maintenance and Deeper. So if you 

use it, you won’t need either of 
those. Though, for example, if you 
only want the customisation 
options, and find the interface of 
OnyX a little intimidating, Deeper is 
more straightforward to use.

The good news is that all three 
applications are free to download 
and use. The bad news is that 
documentation and support is very 
limited. That’s where we come in. 
Over the next couple of pages, we’ll 
show how you can use OnyX to 
make sure your Mac runs smoothly 
all the time and that you have it set 
up just the way you want it. 

A word of warning. OnyX can’t 
destroy your system, but things you 
do while working in OnyX may 
produce unexpected results, 
including moving or deleting files. 
So before you start, be sure to back 
up your Mac. Kenny Hemphill

Maintain your Mac with OnyX
Access hidden features of OS X, do maintenance and clean up your machine

SKILL LEVEL
Could be tricky

IT WILL TAKE
30 minutes

YOU’LL NEED
OS X 10.10,  
OnyX 2.95 

The menu bar
1  The menu bar is 

split by type of 
job. The customisation 
functions are all 
in Parameters. 

Tabbed 
sections

2  Each group is 
further divided 

into tabbed sections. 
Tabs denote the 
application or OS 
function being 
customised. The number 
of options in each 
section varies widely.

Restore 
Defaults

3  The Restore 
Defaults button 

is your friend. If your 
Mac starts to behave 
unexpectedly, press it to 
put things back the way 
they were and problems 
should disappear. 

Finder reboot?
4  OnyX will either 

make a change 
immediately, need to 
restart Finder, or even 
take over your Mac for 
a few minutes. 

OnyX may produce 
unexpected results. 
So before you start, 
be sure to back up 
your Mac

1

2

3

4

QUICK LOOK 
The PArAMeTerS PAne 
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1 Re-instate Dashboard
Remember Dashboard and its widgets? 

It’s still there, but it’s switched off by default. To 
switch it back on, click Parameters, then the 
Mission Control tab. Now click on the box next 
to Dashboard. You’ll see a warning telling you 
OnyX needs to restart the Dock. Click Continue. 

4 Delete Mail downloads
The Mail Downloads folder can fill up 

with attachments and take up disk space. To 
empty it, click on Cleaning then the Misc tab. 
Check the box next to Items in the Mail 
Downloads folder. Uncheck any items you don’t 
want to delete. Click Execute. 

6 Custom screen captures
Taking a screengrab results in a PNG file, 

named ‘Screen Shot…’ appended with the date 
and time. And window grabs display a shadow. 
You can change all of that in Parameters. Go to 
the General tab, then the Screen Capture 
section and choose the options you want. 

2 Allow text selection 
We use Quick Look all the time to 

preview files, but having to open the file to 
select text from it is a bore. To change that in 
OnyX, go to Parameters, then Finder and look 
down the list for ‘Misc. Options.’ Check the ‘Turn 
on Text Selection in Quick Look’ box. 

5 Stop icons bouncing
Do you hate the way icons bounce up 

and down in the dock when you launch an 
application? Stop their needy dances by going 
to Parameters, then Dock. Uncheck the box in 
the Graphic Effects section, next to ‘Opening 
applications.’ No more bouncing! 

8 Show login message
For a dose of motivation in the morning, 

or to remind other users of something, set a 
message to display when you log in to your 
Mac. In Parameters click the Login tab. Check 
the ‘Show message in the login window’ box 
and write your message in the box. Click Apply. 

7 Find elusive utilities
OS X has lots of Mac maintenance tools, 

but they’re tucked out of view. Click Utilities and 
Applications to show them. The diagnostic tools 
and Screen Sharing are harmless, but only use 
Directory Utility and System Image Utility if you 
know what you’re doing. 

3 Hide any folder or file
If you share your Mac, you may want to 

hide a file or folder from view. Go to Utilities and 
click the Visibility tab. Now click on Hide File or 
Hide Folder, then Continue, then select the file 
or folder. Repeat the process, selecting ‘Show 
Folder’ or ‘Show File’ to make it visible again. 

HOW TO | The beST wAyS TO uSe OnyX

ApprOAch  
WITh cAUTION

There are so many options 
available in OnyX, that you’ll 
probably either be tempted 

to click around randomly and 
see what happens, or be too 
terrified to touch anything at 

all. we think the best 
approach is somewhere in 
between – exercise some 
caution initially and try to 
gain a good idea of what 

something does, then make 
your decision.
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Even a simple video can 
involve a significant 
amount of effort, and the 
idea of losing that work 

due to a hardware failure, or having 
to reconstruct a previous film because 
you’ve lost the original project, is a 
worrying prospect. The majority of 
the effort lies in your editing decisions.

Final Cut provides a way to preserve 
the database part of a Library 
periodically – though more frequently 
than Time Machine, which only 
preserves changes to files once every 
hour. Your Library’s database is what 
contains details of your edits, but it 
doesn’t include the associated media, 
so this isn’t a full backup. For that 
reason, you must keep a copy of your 
original media somewhere so that if you 
have to fall back on one of these project 
files, the media can be relinked to it 
using File > Relink Files. To configure 
this feature, choose Final Cut Pro > 
Preferences in the menu bar, then 
select the General tab. Put a tick in the 
box next to Save Library Backups then 
use the item below, labelled Library 
Backups Location, to choose a folder 
on a different disk to where your Library 
and media are stored.

A network drive is allowed, though 
you should consider how frequently you 
will edit away from the network without 
remote access to it. With these items 
configured, backups of your library will 
begin to appear in your chosen location 
as you work. However, Final Cut 
automatically removes backups that are 

a few days out of date. Don’t mistake 
this feature as a long-term backup – it’s 
meant as a fallback should anything 
happen to the copy of the library that 
you’re actively working on.

Backups
Final Cut provides a way to back up 
a whole event or specific project. It’s 
important to bear in mind the different 
options you had for how media is added 
to a Library when you originally 
imported it. Remember that media can 
be copied into a Library, but that while 
a Library appears as a single file in the 
Finder, the events (and your projects) 
within it may contain links to external 
media. However, there’s a simple 
technique to gather and archive all 
media in one place.

Select an event (or events) in the 
Libraries browser. If you’ve hidden the 
list of libraries, remember that the 
button at the bottom left of the browser 
will reveal it. Next, choose File > Copy 
Event to Library > New Library… This 

will copy all of the projects and clips 
inside your selection.

Alternatively, select one or more 
projects inside an event instead. The 
menu option’s name will change to 
reflect this context, and the result will 
be a library that contains only media 
needed by those projects. Clips in the 
event that are not used at all by the 
selected projects will not be copied 
into the new Library.

Give a name to the Library that will 
contain your archived events or projects, 
then choose a location on your backup 
or network drive and click Save. Final 
Cut asks if you want to include 
optimised and proxy media. Clearing 
these options will save space in the 
archived Library, but the original media 
will be copied across; the optimised and 
proxy media can be recreated from it if 
you decide to resume work on the files. 
While the process of copying media 
takes place, the new Library will be 
displayed with a yellow alert symbol 
to tell you it isn’t finished.

External media
What you’ve done so far only copies 
media stored within the original library, 
along with projects; external (referenced) 
media remains elsewhere on your Mac. 
You can verify where media in a Library 
is stored by holding ≈ and clicking on 
a file, then choosing Reveal in Finder 
to see its location.

Keep a copy of your projects while freeing up space on your Mac

SKILL LEVEL
Anyone can do it

IT WILL TAKE
10 minutes

YOU’LL NEED
Final Cut Pro X 10.1, a 
second external hard 
drive or space on a 

network drive

Archive Final Cut projects

In Preferences, Final 
Cut Pro can be set 
up to preserve the 
database part of a 
Library periodically

Optimised and proxy media 
can be omitted from an 
archive, and recreated from 
the original copies using 
File > Transcode Media.

Render files are generated inside a Library as you work, and may constitute a large part of its size.

improve   |   Mac Apps
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Final Cut has opened the new Library. 
Select it (not an event within it) in the 
top left pane and choose File > 
Consolidate Library Files… In the next 
dialogue, the new Library will already be 
selected. Just press oK and any external 
media that’s referenced in the Library 
will be copied into it. Final Cut will 
display an explicit alert if there is no 
external media to copy into the Library.

Cleaning up
The original Library is still in place on 
your Mac. You may be able to free up 
some of the space used by it. Select an 
event in it, then choose File > Delete 
Event Render Files… (or Delete Project 
Render Files… if you’ve been more 
specific and selected a project instead) 
and you’ll be asked if you want to get 
rid of all render files, or only unused files 
that have been leftover from your work. 
If you only want to keep the project to 
hand but don’t anticipate referring to it 
often, if at all, choose All and click oK.

Hold ≈ and click the Library you 
created as an archive, then choose Close 
Library so you don’t accidentally make 
changes to it. You can close and remove 
the original Library from your Mac to 

free up space. But Final Cut requires at 
least one Library to be open, so if it’s the 
only one in the top left pane, you’ll need 
to create another, empty Library to do 
this. Alan Stonebridge

STOrAgE
Storing archives 

in the same 
building as your 
Mac gives you a 
quick way to use 

that media in 
future, but good 

practice is to 
keep an offsite 

copy of anything 
with sentimental 
or financial value. 

The aim is to 
spread copies of 

irreplaceable 
work across 

many locations 
to minimise the 
potential for a 
single event 
to wipe out 
every copy.

Final Cut can create backups of a Library’s database for you to fall back on if the working copy gets damaged.

What gets 
copied

Final Cut can 
point you in the 

right direction, and the 
exact wording of these 
media management 
features also serves as  
a reminder of what will 
be copied when you 
follow the archiving 
steps as discussed on 
this page.

Management
options

2  What you select 
in the top left 

pane is important when 
using Final Cut’s media 
management features. 
Make sure you take 
notice of the different 
types of purple icon for 
Libraries (four shapes 
inside a square) and 
Events (a white star 
inside a circle).

2

1

3

4
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Multiple items
Remember that you can select more than one event or more 
than one project at a time by holding ç, which allows you 

to selectively archive multiple items in a Library. 

4

Library list
You can hide the list of Libraries and Events to give yourself more 
room to work with your media, but at some point you may need 

to bring them back. Just click this button to reveal the list.  

1

3
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Just how secure are the 
passwords you use to 
protect your online 
accounts? Chances are 

that even if you’ve upped your game in 
recent times, you’re still relying on the 
same memorable (and therefore easily 
crackable) password for a number of 
websites. However secure you think 
your passwords are, it’s always a good 
time to test them, just in case.

Auditing passwords by hand is time 
consuming: you’d have to go to each 
website in turn and write down your 
details before manually comparing the 
list for duplicates, assuming you can 
remember every site. Changing a 
password is awkward too, as coming up 
with a secure sequence is only half the 
battle. Have you recorded it accurately? 
Where’s a safe place to store it?

This is where LastPass comes in. The 
free online password manager allows 
you to securely store all your login 
details in an encrypted ‘vault’. This vault 
is protected by a single master 

password – the only password you’ll 
have to remember. Install the browser 
extension and it’ll offer to save your 
login details as you visit each of your 
sites, allowing you to both store them in 
your vault and quickly log in in future, 
thanks to its automatic form-filling tools.

More importantly, once you’ve 
recorded your passwords, you’re in 
a position to run the all-important 
security audit, to reveal weak and 
duplicate passwords, and a chance to 
replace them with something better. 
Read on to find out how. Nick Peers

Secure your online passwords
Let LastPass audit your passwords to track down and replace insecure ones

1 Install the app
First download and install the 

LastPass app through the App Store. Click 
Open and either create an new account or 
log in. If setting up an account, you’ll need to 
provide your email address and then create 
a strong but memorable, Master Password – 
use a combination of letters (upper and 
lower case), numbers and even symbols. 
Provide a cryptic reminder to jog your 
memory in case you forget your crucial code.

2 Record login details
When prompted, install the LastPass 

browser extension, then log into your 
account through it. Now log into your first 
online account through your browser. After 
providing your username and password, 
LastPass prompts you to save your login 
details. Click Save Site to do so, then verify or 
edit the name and suggested category. Click 
Save Site again to store the login in your 
vault. Repeat as you visit other sites. 

3 Speed up login
Now when you visit a site with its 

login stored in LastPass you should see an 
asterisk appear in the login box, click this 
and a list of matching logins (you can store 
more than one per site) will appear. Click it 
to automatically fill in the username and 
password details. Review the passwords in 
your vault via the main LastPass app, where 
you can also set up form fills and record 
other sensitive data in Secure Notes. 

HOW TO | geT STARTed WITH LASTPASS

SKILL LEVEL
Taking things further

IT WILL TAKE
One hour

YOU’LL NEED
OS X 10.9 or higher, 

LastPass for Mac, 
compatible web 

browser

LastPass plays a key role in helping you generate unique (and secure) passwords for all your sites.
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Perform audit
1  Log into LastPass, click the LastPass icon and choose 

Tools > Security Check before clicking the Get Your 
Score button. Your vault is then opened, your passwords 
decrypted, and then they’re analysed for weaknesses as well 
as duplicate entries. Once complete, you’ll be given a full list 
of any email addresses stored as usernames – leave these all 
ticked and click Continue to allow LastPass to check they’re 
not linked with any security breaches. 

Review score
2  You’ll be given a score between 1 and 100, the higher 

the better. This is a general summary, you still need to 
check each password individually. First, LastPass also offers 
to audit your master password – use the provided link to 
get that rated. Next, click Improve Your Score to see what 
things you’ll need to do to boost your security score – 
basically, eliminate weak passwords as well as make sure 
you’re not using passwords more than once. 

Check results
3  Scroll down your browser window to review the 

results, or access them through the main LastPass 
app, which we recommend. All your passwords will be listed 
in order, with each given a rating and the least secure listed 
first. You’ll may find a large number of weak and duplicate 
passwords at the top of the list scoring as low as 1%. 

Change and update
4  Click the Update button next to the first entry in the 

list, to open the page in your browser. Log in using 
your existing credentials, then go to Account Settings and 
look for the option to change your password. You should see 
a lock icon appear on the right-hand side of the New 
Password box – click this to reveal a tool to generate a new 
password. Review any password guidelines provided by the 
site, then set the password length and choose Advanced 
Options to include symbols like @, $ and #. Click the 
Generate Password button and when you’ve found one you 
like, click Use Password. The password should automatically 
fill the boxes – click Yes, Use for this Site to confirm the 
change to LastPass, then update the password on the site. 

Move on
5  Select the next password and update it in the same 

way, then repeat. If you have a large number to 
process, don’t force yourself to do it all in one sitting, but 
do try to get it completed sooner rather than later. 

Keep testing

6  Get in the habit of running the Security Check on a 
regular basis – say, once a month. It’ll continue to 

highlight weaknesses, plus alert you to passwords you’ve 
not changed in a while. It’s a good idea to keep changing 
passwords on a regular basis. 

1

2

3

5

6

4

VISUAL GUIDE | AudIT And uPdATe yOuR PASSWORdS

MObILE AccESS
These days, web logins are also used on 

other platforms, such as your iPad or 
iPhone. Access to LastPass via mobile 

requires an upgrade to LastPass Premium, 
which costs $12 (around £8) a year. Once 

done, install the LastPass app – this 
speeds up the process of updating your 
passwords after you’ve performed your 

security audit by allowing you to quickly 
copy and paste passwords from your 
vault into the relevant apps (such as 

dropbox) or accounts (such as Settings > 
Mail, Contacts, Calendars).
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At some point we’ll 
be able to verbally 
tell a Mac what we 
want to work on or 

with and it’ll quickly serve the 
respective document or app. In the 
meantime, we must make do with 
manual searches via Spotlight, or 
use a file manager. 

Finder is an app built into every 
Mac for rummaging around your 
drive (and beyond) and it can be 
customised a little, helping you 
work faster and more efficiently.

One area that can be bent to 
your will is the sidebar. This is 
initially populated with shortcuts 
Apple has determined most Mac 
users will require, including All My 
Files, Applications and Documents, 
but as our walkthrough shows, you 
can add your own. Also, some 
applications – such as Dropbox – 
provide direct integration with 
Finder and add shortcuts, although 
these can always be removed.

Folders in the sidebar work as 
they do elsewhere in Finder, 
meaning you can drop items into 
them. This makes the sidebar a 
handy place to temporarily house 
a folder shortcut if you plan on 
moving a lot of documents to it. It’s 
typically faster to drag documents 
to the sidebar of any Finder window 
than to a specific Finder window or 
Dock shortcut. Craig Grannell

Customise the Finder sidebar
Be more efficient, by making use of Finder sidebar shortcuts and searches

SKILL LEVEL
Anyone can do it

IT WILL TAKE
10 minutes

YOU’LL NEED
OS X 10.10 (although 
most steps work with 

previous versions)

The sidebar
1  By default, the 

sidebar appears at 
the left-hand side of all 
Finder windows, 
providing fast single-
click access to folders, 
mounted media, shared 
computers and tags. 

Sidebar groups
2  Items stashed in 

the sidebar are 
grouped into categories: 
Favorites, Devices, 
Shared and Tags, to help 
make it easier to find 
what you’re looking for.

Sidebar items
3  You can store 

custom items 
under Favorites. Folders 
and searches are the 
best things to place 
there. Add documents 
and apps if you like, but 
avoid too much clutter. 

Preferences
4  In Preferences you 

can adjust what’s 
shown in the Finder 
sidebar. Individual folder 
preferences and view 
options can also be 
amended to suit. 

Finder can be 
customised a little, 
helping you work 
faster and more 
efficiently too

1

2

3

4

QUICK LOOK 
FInDer’S SIDeBAr 
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1 Understand the basics
Firstly, the sidebar can be hidden. App 

install windows often hide the sidebar, for 
example. View > Hide/Show sidebar 
(å+ç+S) toggles its visibility. Also, select a 
sidebar item and it loads relevant items into the 
window. So click Applications to see your apps. 

4 Access a hidden folder
Your user Library folder is hidden by 

default, but can be added to Finder’s sidebar. 
Hold å and go to Go > Library. Ensure the 
Finder path bar is visible (View > Show Path Bar) 
and drag Library to the Favorites section of the 
sidebar. The folder is then just a click away. 

6 Save a search
In any Finder window, press ç+F to 

load the search view – results can be restricted 
to a folder or your entire Mac. Define results 
criteria and click Save. In the sheet that appears, 
check Add To Sidebar and click Save. Your 
dynamic smart search appears in the sidebar. 

2 Show predefined items
Go to Finder > Preferences and choose 

Sidebar. You’ll see items grouped into Favorites, 
Shared, Devices and Tags. Checking an item 
adds it to Finder sidebars; deselect an item and 
it will be removed. (Most items can be managed 
manually, though that’s a slower process.) 

5 Manage the sidebar
Add too many items and the sidebar 

becomes cluttered and requires scrolling, so 
prioritise. Delete unused items and click-drag to 
move key ones up. Categories can be dragged 
via their titles, or collapsed by clicking the Hide 
button (shown when the cursor’s over the title). 

8 Make everything bigger
Sidebar items can be resized. In System 

Preferences, click General and set ‘Sidebar icon 
size’ to Large (this may affect other apps.) Third-
party utility XtraFinder (trankynam.com/
xtrafinder) adds sidebar colour, via Appearance 
> Show colourful icons in the sidebar. 

7 Use All My Files
All My Files is a smart search that groups 

your files, initially by type and in reverse 
chronological order. The folder’s view and item 
arrangement can be adjusted via the toolbar 
and it will remember changes when reopened. 
The same goes for other folders in the sidebar. 

3 Add and remove items
If you want quick access to a folder not 

shown in Finder’s preferences, select it and use 
File > Add to Sidebar (≈+ç+T), or just drag 
the folder into Favorites. To remove any item’s 
shortcut, drag it outside the Finder sidebar or 
≈-click it and select ‘Remove from Sidebar’. 

HOW TO | MASTer The FInDer SIDeBAr

OpEN Up
Changes made to Finder’s 

sidebar are reflected in Open 
and Save dialog boxes. 

Placing frequently accessed 
folders near the top of the 

sidebar is a time-saver. 
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Modern technology 
continues its inevitable 
shift towards appliance-
style devices. Gone are the 

days when you could easily open up 
and tinker with hardware, expanding 
and customising it. Today, this thinking 
tends to stop with a snazzy sleeve or 
something you can plug into something 
else. And that’s OK. There’s nothing 
wrong with hardware that works well, 
and where the user doesn’t have to fret 
about maintaining anything beyond 
occasionally prodding ‘OK’ when asked 
to update some software.

There is one major exception, 
however, and that’s storage. No iOS 

device is expandable, 
and so you’re stuck 
with whatever you 
plumped for when 
purchasing your 
phone or tablet. At the 
time, 16GB might have 
seemed plenty, but 
iPhones and iPads 
soon fill up once you 
start installing apps 
and games, shooting 
photos and videos, 
and even when using 
certain apps a lot. 
Social networking 
apps, for example, 
have a tendency to bloat from their 
initially tiny download sizes, primarily 
because they cache imagery and video 
for later playback.

PhoneExpander (which, despite its 
name, works fine with the iPad and iPod 
touch) is a quick fix for gaining back 
chunks of space on your device. The 
version we used was a beta, so might 

differ slightly from what you see when 
reading this; what won’t change is the 
app’s speed, efficiency and results.

Go to phoneexpander.com to find 
out more and download the app to 
your Mac. To get cracking with our step-
by-step walkthrough here, simply plug 
in your device using your USB cable and 
launch the app. Craig Grannell

Reclaim iPhone space
Get back storage on your iPhone or iPad with PhoneExpander

1 Trash temp files
Click on Clear Temporary Items. 

PhoneExpander will build a list of caches on 
your device that can be removed. To get rid 
of them all, click the Clear button (which 
will denote the space saving). To be more 
selective, use the checkboxes before clearing 
the caches. Once you’re done, a sheet will 
advise regarding how much was cleared, 
enabling you to continue (Delete More) or 
return to the main window (Finish).

2 Remove weighty apps
Click Remove Apps. Again, the app 

will create a list of relevant items on your 
device. Apps are initially listed from largest 
to smallest. As with the temporary files, the 
process for removal is simple: select one or 
more items then click the Remove button. 
Note that in removing apps from your 
device, you will also remove all associated 
data and settings at the same time (unless 
the app stores such things in iCloud). 

3 Delete old videos
Click Clear Photos. The interface here 

is different from the others, in that it gives 
you a slider to determine the age of what 
you want to remove. Drag the slider left to 
include older (and therefore, likely, fewer) 
files. Use the checkboxes to select whether 
to remove videos and/or photos, then use 
the menu to determine where the backups 
of removed files go. Click ‘Backup & 
Remove…’ to complete the process. 

TOP 3 FEATURES | ClEAR SOME SPACE wiTh PhONEExPANdER

SKILL LEVEL
Anyone can do it

IT WILL TAKE
30 minutes

YOU’LL NEED
 OS x 10.8 or higher, 

iOS 7 or higher 
PhoneExpander,  
a USB connector  
for your device

PhoneExpander  
is a quick fix for 
gaining back 
chunks of space on 
iPhones and iPads

PhoneExpander is a fast 
way of getting space 
back on your iOS device.
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Using PhoneExpander
1  On launching PhoneExpander, you’ll see your device’s 

name and how full it is. When devices get too full they 
run into problems, such as not being able to download and 
install large apps, and possibly not being able to update iOS. 
Once you get in the higher end of 90% it’s time start 
deleting things. (Depicted here is Craig’s iPhone after 
already having done a couple of rounds of PhoneExpander 
testing – it was even more full before!) 

Temporary files
2  Apps often use temporary files, to load more quickly 

or appear more responsive. Most are small and best 
left alone. But some apps have monster caches that are 
worth deleting if you’re very tight on space. Be mindful 
caches will likely rebuild when you subsequently use an app, 
and that temporary files for Newsstand apps are mostly 
magazines. Delete them and you’ll need to redownload. 

App removal
3  Apps can be massive, especially games and music 

ones. The size you see on the App Store is the 
download – apps can then take up significantly more space 
as assets expand. Although you can of course remove apps 
using only your device, PhoneExpander is much faster when 
dealing with multiple apps – you don’t need to make the 
icons jiggle then delete them one by one. 

Photos and videos
4  Newer iOS devices have great built-in cameras but 

higher-quality photos, and especially videos, rapidly 
eat into your storage space. Regular iPhoto (and, we 
presume, Photos for OS X) imports can offload video, but 
PhoneExpander is fast, quickly removing content from your 
device, and enabling you to later import it into your 
favoured app. Whatever you do, though, don’t delete videos 
if you’re tight for space – back them up instead. 

iTunes back-ups
5  Although we had no problems with PhoneExpander, 

we recommend you back up your device before using 
it, just in case. You can back up to iCloud, but since you’re 
plugging in your device via USB anyway, also back up to 
iTunes. Select your device, click ‘Back Up Now’ and iTunes 
will get to work. This backup will be stored on your Mac,  
and can later be used to restore a device. 

Seeing what’s where
6  Another reason it’s worth checking in with iTunes is 

because it gives you a handy bar chart that outlines 
what’s taking up space on your device. If you’ve got few 
apps but tons of audio, it might be worth cutting back on 
albums. But if apps or videos are taking up the majority of 
storage, pruning them with PhoneExpander could be smart. 
(‘Other’ reportedly mostly comprises temporary files.) 

1

2 3

5

6
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VISUAL GUIDE | SAviNG SPACE wiTh PhONEExPANdER ANd iTUNES

ALL IN OrDEr
Two of PhoneExpander’s sheets helpfully 
enable you to reorder items by name, size 

or last use. last use is handy for 
unearthing possibly large apps and 

games you haven’t launched in ages, and 
therefore could probably get rid of 

without any problems. Note that you can 
also easily select or deselect ranges of 

items in such lists – to do so, click an item 
and then Shift-click another. ≈+click and 

then choose ‘Check selected’ or 
‘Uncheck selected’, depending on 

your requirements.
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Keynote is an app 
particularly well suited 
to iPad. The landscape 
screen orientation and 

ease with which you can enter and 
edit text, pictures and transitions 
mean it’s perfect for working on 
presentations even when you’re 
on the move. 

Traditionally though, you would 
have had to take a laptop and hook 
it up to a projector to show the 
presentation to a group of people. 
But with Keynote for iPad, plus an 
Apple TV, it’s even easier, with no 
compatibility issues to worry about. 
The Apple TV itself is very portable, 
much more so than a projector. 

The two devices need to be on 
the same wireless network, though 

you can create an ad hoc one from 
a laptop or phone if necessary. 
And the Apple TV will need to be 
connected to a TV or perhaps a 
projector, to work this way. 

Once you have built your 
presentation, the trick is to activate 
AirPlay Mirroring on the iPad to the 
Apple TV. Thanks to the way Apple 
has built the app, this won’t merely 
mirror the screen but will actually 
send a specially configured signal 
to the Apple TV and display your 
presentation correctly on the big 
screen. Even better, Keynote has 
tools to let you annotate and 
control the presentation in real 
time, so you can use the iPad as 
a presenting tool rather than just 
a beaming device. Hollin Jones

Beam Keynote to Apple TV
Show your iPad presentation on Apple TV – with real-time annotations

HOW TO | BEAM yOur PrESEnTATiOn

1 Create your presentation
Build your presentation in Keynote for iPad. Naturally 

you’ll want to test it before it goes before an audience, so 
you can use the play controls at the top-right corner of the 
screen to run it locally on the iPad. Any object or text can be 
tapped on to edit, move or add transitions. You may also 
want to export a Keynote project from your Mac or open it 
directly from iCloud on the iPad using Handoff. 

2 Activate AirPlay
On your Apple TV, go into Settings and choose the 

AirPlay option. Make sure AirPlay is enabled and create a 
password. In the home this might not be necessary, but in a 
public venue it’s a good idea, to stop anyone hijacking your 
AirPlay feed from their own device, even by accident. On the 
iPad, swipe up from the base of the screen to open Control 
Centre, tap AirPlay and you should see the Apple TV. 

tool 
school
The app only 

works in 
Landscape mode 

when you are 
creating your 

Keynote 
presentation, 
and this is the 
same for the 

content that you 
beam to the 

Apple TV. During 
presentation, 
however, you 

can switch the 
iPad to Portrait 
mode to show 

more content at 
the same time 
on your device.

SKILL LEVEL
Anyone can do it

IT WILL TAKE
15 minutes

YOU’LL NEED
iPad, Keynote for iPad, 

Apple TV, television 
or projector
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iOS   |   improve

3 Mirror the signal
If you have set a specific name for the Apple TV it 

should appear, but it may just be called Apple TV. Stay in 
the Apple TV menu and scroll it down a little. You will see an 
option called Mirroring and you need to activate this by 
tapping it. This tells iOS to send the whole output of the iPad 
to the Apple TV. In this case, Keynote is designed so that it 
will know to display your presentation in the correct format. 

5 Modify your view
Helpfully, what Keynote displays on iPad and the 

Apple TV can be different. The Apple TV will always show the 
presentation, whereas the iPad can show you different views 
such as the next slide, notes and even alternate orientations. 
So you can use the iPad to keep track of where you’re up to 
without showing that to your audience. This is really useful 
and means you can do away with reams of paper notes. 

4 Play the presentation
You should now find that your iPad screen is displayed 

via the Apple TV on the big screen to which it’s connected. 
It’s only when you play the presentation using its Play 
button, however, that it will become fullscreen on the Apple 
TV, so it’s worth only switching the main screen on when 
you’re ready to present. Tap Play and the presentation 
begins. You even get a handy time display at the top. 

6 Annotate slides
You can make annotations in real time. Tap on the pen 

icon in the top-right corner for a selection of coloured pens 
to draw on slides with. The pen symbols are not shown 
on-screen but the results of drawing with your finger are. It’s 
a useful way of emphasising points mid-presentation without 
going back into edit mode. Annotations can be quickly 
removed with the Undo icon next to the Done button. 

HOW TO | BEAM yOur PrESEnTATiOn (cOnTinuED)

JARGoN 
BUstER
Mirroring usually 
means sending 
an exact replica 
of your iPad or 
iPhone’s screen 
to the Apple TV. 
in some apps, 

however, it can 
send a specially 

modified version 
of the signal to 
just display a 

video stream, for 
example – or in 

this case, a 
presentation.

USE AN 
AD-hOc 

NETWOrK
if you are 

presenting in a 
public venue it’s 
likely there could 

be no wireless 
network, or at 
least none that 

you have access 
to. in this case it’s 
quite possible to 
use any Mac or 

iPhone to create 
an ad-hoc network 

complete with 
password. Then on 
the Apple TV and 

iPad, join this 
network and 

everything should 
work fine. 
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Have your say on 
everything Mac, 

OS X and iOS

Welcome...

Get involved
Apple Mail 64
Photo Stream 66
Mac User Groups 67
Win a Freecom drive 69
Ask the Experts 71

There’s always plenty to say 
about Apple, whether it’s 
good or bad. And we’d 

particularly love to hear what 
you think! Write to us at 
letters@macformat.com  
and remember, the Star 

Letter wins a prize!

  Email your questions to 
letters@macformat.com

  Visit macformat.com for 
more great Mac news

  Join the conversation with  
our Facebook page

  Keep up to date by following 
us on Twitter at @MacFormat

Are you on App.net? So are we!  
We’re @MacFormat there too

Subscribe to our videos at 
 youtube.com/MacFormatUK

Join us online

You’re a winner!
Drop us an email at letters@macformat.
com. If yours gets picked as the 
MacFormat Star Letter, you win a 
Native Union JUMP Cable, a charger 
and battery combo for your iPhone.

Cautionary tale
I have been using Macs since 1997, 
from my still-trustworthy PowerMac 
7300/166, through an iMac G5 to my 
present 27-inch iMac.

Despite several offers from Apple 
to upgrade free of charge, I’ve stayed 
with Mountain Lion. I am becoming 
increasingly aware that upgrades to 
several of my apps require Yosemite.

Yes, I’m nervous! Why? In view of 
Yosemite’s diverse customer ratings: 
265 five- and four-star, but 320 one- 
and two-star, and three on average 
from 5,022 people. Promises of “The 
apps you use every day will have 
powerful new features”, “It’s like getting a 
whole new Mac – free” and “The 10.10.2 
update improves the stability, compatibility 
and security of your Mac” apparently need 
to be taken with a pinch of salt.

Among the thousands of comments are 
complaints about speed, Wi-Fi, battery and 
other problems. Can MacFormat help with 
some wise, in-depth, definitive guidance, 
and urge Apple to put right Yosemite’s 
reported shortcomings?
Kenneth Watkins

Alan Stonebridge says…
Issues like those you mention certainly are 
a concern, but also consider that people 

are likely to leave negative feedback in anger, and 

that many more just accept something works and 
so don’t bother. One of our MacBooks had Wi-Fi 
issues, but that seems to have cleared up with one 
of the small updates – at least for us. That doesn’t 
negate all bad feedback. Problems that look the 
same might be caused by different combinations 
of software and hardware, so it’s worth sending 
relevant details to sos@macformat.com – say, your 
router make and model for Wi-Fi issues. If a flood 
of people tell us about a problem, we’ll ask Apple 
what’s going on. Major things, like the update that 

broke many iPhones’ mobile networking 
tend to get fixed very quickly.

Not rushing to upgrade for the sake 
of it is wise, though. Time Machine helps 
with trying out OS X updates (difficult to 
do on iOS). Recovery mode can roll back 
your setup even to an earlier major 
version from a full backup, though take 
care to preserve work from the interim.

It’s difficult to feel reassured that software updates will make 
your Mac run better when you hear other people’s horror 
stories, but there are things you can do to protect your setup.

mailto:letters@macformat.com
mailto:letters@macformat.com
mailto:sos@macformat.com
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Sizing up
I notice that on the digital edition I can 
resize many of the general pages but 
when I start reading the main articles 
I can no longer make the text larger, 
making it much more difficult to read 
on the iPad. Am I missing the 
opportunity to make the text larger or 
is that not possible? I can do so in 
many other digital magazines, 
throughout editions.
Mike Smartt

Paul Blachford says…
When MacFormat’s app edition first 
launched, we took care to make 

sure that body text would resize when you 
tap the arrow at the bottom of the screen 
and then tap the ‘A’ buttons at the top-right 
corner of the screen. It has been necessary 
to compromise on this in some recent 
features to give them a more dynamic 
layout. Feedback from some readers is that 
our text is too small by default. We apologise 
if the compromise we’ve made has given 
you difficulty when reading some features at 
the moment. Please be assured that we’re 
looking into improving text size and line 
spacing throughout the app edition. 

Driving me mad
I’m saving documents in iCloud but I 
continue to be disappointed. I have 
downloaded the beta version of Photos 
so I can see them on all my platforms. 
I only have a 16GB iPad and yet again 
this process uses all my storage and 
therefore the service becomes 
redundant and of no value. Surely it’s 
time Apple does something about this.
Phil Ashwell

Alex Blake says…
In this issue you’ll 
find our guide to 

Photos (page 44), which 
discusses the app’s option to optimise 
photos for your device. A 16GB iPad sounds 
roomy enough at first. 

The other thing you’ll find discussed in 
that feature is the app’s ability to create 
several libraries. One is always designated as 
being the System Photo Library, which is the 
only one that gets synced to iCloud. Doing 
things this way needs discipline in choosing 
where you store different photos, and it 
sounds like, very reasonably, you want your 
entire photo library on all of your devices.

However, if you have a large enough 

iCloud Photo Library’s option to optimise photos for your device might manage to fit your whole library in your device’s storage.

photo or music library, it doesn’t fit well with 
the images that are automatically synced to 
your device from services such as iCloud 
Photo Library and iTunes Match. Those 
images – even in thumbnail form – have to 
be stored somewhere. This sort of thing is 
why we bemoaned the 16GB capacity being 
kept for the iPad Air 2. It’s increasingly going 
to be a tight fit for many people.

In short
I am trying to create a shortcut in Mail 
similar to one I have created to the 
Archive folder. However, using 
System Preferences’ Keyboard pane I 
have been unsuccessful in creating 
shortcuts to iCloud Mailboxes. I have 
four folders called, ‘Next Actions’ 
‘Someday’ ‘To Read’ and ‘Waiting’ in 
my iCloud Mail account which I can 
drag and drop to in Mail. I cannot get 
the keyboard shortcuts to work 
though. Please can you help?
Jim Waddell

Christian Hall says
By creating shortcuts to a mailbox, 
do you mean those you create by 

dragging a folder from full list of mailboxes 
to the Favorites Bar (under the toolbar)? You 
don’t need to manually assign shortcuts in 
the Keyboard preferences pane to work with 
those, because Mail will automatically assign 
two keyboard shortcuts to each mailbox you 
drag into that bar – at least, it does for the 
first nine mailboxes from left to right.

Pressing ≈+ç and the number key that 
matches a mailbox’s position in the bar 
(starting from 1 at the left, which is your 
inbox by default) will move the selected 
messages to that mailbox. Pressing ç and a 
number displays the corresponding mailbox.

If keyboard shortcuts, including those 
provided by the system or an app, aren’t 
working for you, have you checked that no 
other utility you’ve installed, such as those in 
the menu bar that you might want to access 
at any time, is using the same ones?

We’ve had to make a compromise 
on dynamic text resizing in some 
recent features in our app edition.

Mail automatically sets up keyboard shortcuts to 
move messages and switch the view to any of the 
first nine mailboxes in the Favorites Bar.
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Send the best of your iPhone shots to photos@macformat.com

Bridging the gap This shot of a bridge over Lake Vyrnwy in 
Wales was taken on an iPhone 5 and edited with Afterlight by 
Gregg Taylor. He’s experimented with dozens of photo apps and 
keeps going back to Afterlight (79p).

dock of the bay Michael Bain took this panoramic shot of Crail Harbour in Fife, Scotland. This gorgeous April sunset was taken with his iPhone 6 Plus on Pano mode.

mailto:photos@macformat.com
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Find fellow Mac enthusiasts near you! 

Search the list below to find your local Mac user group – and if  
you can’t find one, why not start one yourself? It’s easy and fun.

Bracknell Forest MUG, 
Bracknell, Berks
bfmugoffice@gmail.com
bfmug.org

Bristol and Bath MUG
robert@bbmug.co.uk
bbmug.co.uk

ClubMac Ireland, Dublin
secretary@clubmac.ie
clubmac.ie

Cork University College, Cork
d.murphy@cs.ucc.ie
ucc.ie/mug

Cotswold MUG
paul@cotsmug.org
cotsmug.org

Cumbria Mac Enthusiasts, 
Barrow-in-Furness
contact@macenthusiasts.co.uk
macenthusiasts.co.uk

Edinburgh MUG, Edinburgh
Twitter: @edmug
edmug.org.uk

Exeter MUG, Exeter
examug@mac.com
examug.org.uk, Twitter: @examug

London MUG, London
secretary@lmug.org
lmug.org.uk, @londonmacgroup
Facebook: facebook.com/
groups/35108081221

Midlands MUG, 
Birmingham
mmug.org.uk

OxMUG, Oxford
oxmug.org

South Essex MUG, Wickford, Essex
seal-apple.co.uk

Suffolk Mac User Group, 
Ipswich
mikekwasniak@me.com
suffolkmacusergroup.co.uk

Sussex MUG
adamfield@gmail.com
sussexmug.org

Three Counties MUG Luton, 
Bedfordshire
chris@3cmug.org.uk
3cmug.co.uk

Wessex MUGs Fareham, 
Dorchester, Bournemouth  
& Salisbury
info@wamug.org.uk
wamug.org.uk

statue of david Nick Short went noir for this photo of Michelangelo’s masterpiece in 
Florence. He used an iPhone 6 with the noir setting activated.

mailto:bfmugoffice@gmail.com
mailto:robert@bbmug.co.uk
mailto:secretary@clubmac.ie
mailto:d.murphy@cs.ucc.ie
mailto:paul@cotsmug.org
mailto:contact@macenthusiasts.co.uk
mailto:examug@mac.com
mailto:secretary@lmug.org
mailto:mikekwasniak@me.com
mailto:adamfield@gmail.com
mailto:chris@3cmug.org.uk
mailto:info@wamug.org.uk
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his month we’ve got a fantastic giveaway for 
anyone looking to revamp their external 
storage setup. Up for grabs, for three lucky 

winners, are one of three hard drives from Freecom, with 
one to suit your every need. 

First up is the Tough Drive Mini SSD, a lightning fast 
256GB solid state drive that fits in your pocket. Its 
portability is matched by a sturdy anti-shock exterior 
that will keep your work safe and sound for drops of up 
to four metres.

If it’s extra storage space you’re after, the Quattro 
should be right up your street. Its 3TB capacity will let 
you store thousands of songs, pictures and documents, 
perfect if you need to beef up your storage in a big way.

And for portable storage that’s bound to turn heads, 
we’ve thrown in the Mobile Drive Mg 1TB. With a smooth 
metal finish made from lightweight magnesium, this 
gorgeous Thunderbolt drive will look a  
pretty picture alongside your Mac.

T
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By taking part in this competition you agree to be bound by the Competition 
Rules: www.futureplc.com/competition-rules. Entries must be received by 

midnight on 18.06.15 (UK time). Open to UK residents aged 18 and over. 
There will be one winner of each of the three prizes available. The prize is 

non-transferable and non-refundable. There is no cash alternative.

COMPETITION  
CLOSES: 18/06/2015

COMPETITION

Mobile Drive 
Mg 1TB
£169 Quattro  

3TB drive
£176

Tough Drive 
Mini SSD Pro 
£192

WIN! £537  
of storage kit  
from Freecom

To enTer, SIMply vISIT  
WWW.T3.COM/COMPETITIONS/
WINFrEECOMharddrIvES  

AnD AnSWer The 
FolloWInG QUeSTIon:

The Tough drive Mini SSd can 
withstand a drop from what height?
A/ one metre
B/ Two metres
C/ Four metres

http://www.futureplc.com/competition-rules
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Your questions answered by our Apple 
expert in residence, Luis Villazon

Get in  
touch

If you have a technical 
issue that you need 

help with, please 
email us at:   

sos@macformat.com

Dust gets sucked into 
your iMac through the 
air intakes, so be sure 
to give them a clean 
now and again.

If you use your 
Time Machine 
disk to archive 
important data, 
you should keep 
a separate 
backup as well.

   I use a 2009, 27-inch iMac, 
with a 4GB memory. It’s been 
rather slow since installing 

Mavericks. The 1TB hard drive was 
only 20% full, so I suspected memory. 
Sure enough, Activity Monitor showed 
that memory used was usually about 
3.95GB of the 4GB available, despite 
Memory Pressure being in the low 
green. I upgraded to 8GB and find that 
memory used has gone up to around 
7.95GB, with Memory Pressure still  
a low green. Can you explain please?  
Andrew Frost

  When you open an application  
in OS X it’s loaded into free RAM. 
The other open apps are left in 

memory, even if they aren’t being used. Once 

you get to the point where there isn’t any 
free memory left, the OS starts actively 
managing the memory in use. Initially it will 
request that apps dump unneeded data and 
it compresses the data in memory pages that 
haven’t been accessed for a while. When it’s 
doing this, the Memory Pressure graph 
shows yellow. If that isn’t enough, memory 
pages will start getting swapped out to the 
disk and the graph changes to red. Unless 
Activity Monitor consistently shows Memory 
Pressure in yellow or red, adding more 
physical RAM won’t help. On a six-year-old 
Mac, it’s more likely that the graphics chip 
and CPU are lagging behind the 
requirements of modern apps. It’s also 
possible dust has built up inside. If your fans 
are normally running full blast, consider 
opening the case for some dusting. 

What does memory pressure 
actually mean?

   I bought a LaCie D2 Quadra 
hard drive in 2007, for use 
with Time Machine. There 

have been no problems until a couple 
of weeks ago when the icon was 
suddenly not visible on my desktop. 
I’ve restarted the iMac, switched off 
the LaCie drive, unplugged it and 
restarted it, changing from FireWire 
to USB, trying it with another iMac – 
nothing. The drive doesn’t show up 
in Disk Utility. LaCie has offered to 
attempt a data recovery but it’s 
expensive. Do you know how I might 
retrieve some items from Time 
Machine which I can no longer find 
on the iMac? 
Harry Kessler

  Does the front panel LED come 
on? This could be a fault with  
the USB enclosure, rather than 

the drive itself. As you’ve nothing to lose,  
I suggest you crack open the case, extract 
the bare drive and plug it into another USB 
3.0 enclosure (under £20 on Amazon). 
There’s a 50:50 chance this will magically 
reunite you with your backup data. But  
if it doesn’t, I’m afraid the drive is junk. Time 
Machine should be for backups only. If it 
contains data you don’t have anywhere 
else, it’s an archive and you 
need a backup for 
Time Machine  
as well. 

When is a backup, 
not a backup?

mailto:sos@macformat.com
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   In MF285, Susan 
Platter couldn’t 
download OS X. One 

possibility could be that she has 
a BT modem/router. All their 
models more than two years 
old block downloads exceeding 
4GB. I experienced this and 
resolved it with a new modem. 
However the new one had no 
VoIP facility, so I now have to 
swap between two models!  
John Marsh

  That’s a good point, John. 
Some older modems, 
especially the BT Home 

Hub have had problems with 
Internet Recovery in the past. Some 
of them actually stall after just 53MB. 
Most of us stick with the same 
broadband provider for years and 
years, through sheer inertia. There’s 
really no excuse for this. Once you 
have a Gmail or iCloud email address 
that isn’t tied to a specific broadband 
company, you can switch providers 

with a minimum of fuss. If you stay 
with the same bank or electricity 
company for too long, you might  
be missing out on the best deals.  
But if you don’t change broadband 
provider every few years, you might 
also find yourself stuck with out of 
date router hardware. Most 
companies only send you a new 
router when you first sign up. So 
when your initial contract comes up 
for renewal, it’s definitely worth 
getting in touch with your provider 

even if you don’t plan to switch, and 
asking them for a new modem. 

Blame the router, not the ISP

What is re-balling  
and does it work?

Yosemite is over 5GB to download and 
older broadband routers may block it.

Repairs involving the logic board are very 
expensive and there’s no guarantee they’ll work.

   I’m near the point of 
throwing my 2009 MacBook 
Pro off the end of Blackpool 

Pier. It started having screen glitches 
and random ‘lock-ups’, which 
apparently are the symptoms of the 
Nvidia graphics fault. I also found it 
would refuse to boot up fully (the 
progress bar would get about a 
quarter way across, pause, and then 
reboot continually). Apple quoted me 
£450 to have a new logic board fitted, 
so instead I went to an independent 
repairer to have the graphics 
processor re-balled. I have spent £89 
on a ‘re-balling’ repair plus another 
£45 to have a new graphics processor 
fitted. After the first repair the 
graphics seemed OK, but the 
rebooting problem still occurred 
randomly. That’s when it went back 
for a new Nvidia processor to be 
fitted. For about two weeks it 
behaved flawlessly until on a cold day 
I got it out of the boot of my car and 

took it with me to 
a coffee shop. 
Yes, you guessed 
it, it just 
continually 
rebooted 

making it completely unusable!  
I don’t suspect Yosemite, because  
it still exhibits this fault when trying 
to boot from an external HDD loaded 
with Mavericks.
Mike O'Dea

  Re-balling involves desoldering  
a chip from the circuit board and 
applying a new grid of tiny solder 

balls to the underside to reattach all the 
pins. Theoretically it can fix problems with 
dry solder joints, but in practice it’s not 
something I recommend. Screen glitches 
and random crashes could indicate a fault 
with the graphics chip, but there could 
equally be a fault with one of the other 
chips on the motherboard, or one of the 
etched tracks on the circuit board itself.  
Also the re-balling process involves 
applying a lot of heat to the whole 
motherboard, which stresses chips and  
can cause other connections to fail. 

Now that you are £134 in, it might be 
tempting to persevere with other repair 
options, or even pay the £450 for a new 
motherboard. My advice though, is to eBay 
the MacBook Pro “for parts or not working”. 
You should get at least £100 for it and you 
can put that towards a new laptop. Five or 
six years is a respectable lifespan for a 
laptop and there comes a point where you 
are just throwing good money after bad. 

Any pop-up warning worth its salt will wait for 
you to acknowledge it before it disappears.

A mysterious 
warning 
message

   My pop-up message says 
something about something 
not being supported and  

will end soon. As this is a rare pop-
up message, I don’t ever get time to 
finish reading it. It’s worrying –  
I don’t know who it is sent by and  
I never know what to do. 
Carol Wade

  In all likelihood, you don’t need  
to worry about this. It’s probably 
just a warning from an app that 

you are using an old version of something 
and the developers will soon no longer  
be offering technical support for problems 
with that version. 

Pop-up messages normally wait for you 
to click OK before they close, but you can 
always hit ç+ß+3 to capture a 
screenshot (which is saved to your 
desktop). Try to do this the next time your 
mysterious message pops up and send it  
to me, and I’ll be able to give you more 
specific advice on what – and whether – 
you need to upgrade.  
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Mac SOS

Let’s be clear: £9,500 is a ridiculous 
amount to pay for a watch. It’s a 

ridiculous amount, even for a 
handmade, one-of-a-kind watch that 
will last your lifetime and beyond. But 
for the rose-gold Apple Watch Edition 
with the white sport band – mass-
produced in a factory – it goes beyond 
ridiculous and into the realm of 
delusion. This is a first-generation 
product so in two years it will be 
obsolete. No, the Apple Watch Edition 
will be bought by just a handful of 
rappers and children of Russian 
oligarchs. The Apple Watch Sport looks 
more promising. £340 is still too much 

to interest me right now, but with the 
right app I could be swayed. Ingress 
players already have the Moto 360 
watch and Android Wear. 

Apple Watch needs its own 
augmented reality game. The subtle 
wrist-tapping alert system is perfect for 
playing discretely during boring 
meetings. A secret agent game, 
perhaps. Players could receive missions 
from virtual drop boxes around the 
world. When you walk past a physical 
drop box location, your watch alerts 
you and you retrieve instructions. This 
could be carrying a message to another 
physical location, taking a photo of a 
landmark or tracking down another 
player. An Apple Watch that lets me 
play that, and get notifications on my 
wrist, might just tempt me.

Luis’s first watch was a cheap clone of the 1970s 
James Bond Pulsar P2. It showed the time.

Tech
Talk
by Luis Villazon

   Recently I have seen a lot of 
connection attempts to port 
44642 being blocked by 

Norton. Is there a way of finding out 
where the connection attempt is 
coming from? Also is it safe to trust 
the address? If you take a look at the 
export log the host is host86-168-61-
113.range86-168.btcentralplus.com – 
is this BT Internet? I’m glad to see 
the firewall is doing a job of blocking 
attempts to access ports on my Mac, 
but I’m concerned about the amount 
that are coming from this address. 
Richard Olivier

  This is just your firewall doing  
its job. The btcentralplus.com 
domain is indeed owned by BT 

and used to route traffic for its customers.  
If you use a tool such as ip-tracker.org, you 
can see that this host is located in the 
Sheffield area, but that’s not especially 
useful because hackers often route their 
traffic through other computers to make 

tracing them harder. Most probably, the 
numeric part is the IP address of some poor 
soul who has a Windows PC infected with a 
trojan that’s using his connection to launch 
exploratory attacks on random IP addresses.

You definitely shouldn’t tell your firewall 
to trust this address. In fact, you shouldn’t 
normally look at firewall logs at all. Firewalls 
exist to silently block these intrusion 
attempts, precisely so you don’t need to 
worry about them. In most cases there’s 
nothing useful that you can do to help. 

   Both my iMac and MacBook 
Pro running Yosemite 10.10.2 
aren’t receiving all my 

emails, although my iPad and 
Windows PC are. When I open Mail 
it can be hours before emails arrive, 
then all in one slug. I get the triangle 
with exclamation mark appearing, 
suggesting I’m disconnected from the 
internet, and the unread emails 
number showing although I’ve read 
every email on the screen. Now, two 
days after this started, the MacBook 
Pro is not receiving any emails at all. 
This all started after I received 
Security Update 2015-002 Version 1.0. 
Jeremy Taylor

  I don’t have enough data points 
yet to be sure whether this was 
caused by the security update, 

but I agree it’s a Yosemite bug. Apple does 
too, because it posted a support page in 
entitled “Mail (Yosemite): If you can’t receive 
messages”. It’s a list of the obvious first 

things to try, like checking passwords and 
making sure you aren’t in the middle of 
downloading a huge attachment. This is 
what Apple does when it has a rare bug 
developers can’t reproduce. The page is 
designed to filter out things that could 
cause the same symptoms, in the hope 
people who submit a bug at apple.com/
feedback/mail.html, can provide hard data. 

Should I trust this intruder?

Did the security update  
 kill my email?

Sending feedback to Apple whenever you encounter  
a bug will help vote that particular problem to  
the top of the queue for fixing.

Firewall logs may look rather scary, but all those 
intrusion attempts are just evidence of how well 
your firewall is keeping you protected.

The Apple Watch 
Edition will be bought 

by just a handful of 
rappers and children 
of Russian oligarchs
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   I’ve tried connecting a 
number of devices to my 
MacBook Pro but have found 

if I try to connect two or more, using 
either USB ports or a USB hub, the 
computer reports ‘disk not ejected 
properly’. Sometimes it fails to 
recognise the device and removes  
it from the desktop, or it stalls 
operation and I have to turn the 
computer off at the power button.

I’ve tried erasing the hard drive 
and reinstalling the OS. I contacted 
Apple Support and they suggested  
a SMC and NVRAM reset, and 
restarting in recovery mode. None of 
these have helped. The computer has 
been to an Apple dealer who tested 
the hardware but found nothing. 
Could a virus be present on the USB 
devices I’m trying to connect?
Dominic Orosun

  This has nothing to do with 
viruses or your hard disk or OS X. 
It’s a hardware problem. 

Something is causing the motherboard to 
lose the connection to one of your devices. 
This can be caused by too much current 
draw on the USB bus. I’ve heard of cases 

where unticking the ‘put hard drive to sleep 
when possible’ box in Energy Saver 
preferences helped, maybe because it 
avoids the brief current surge on the USB 
bus when the drives need to spin back up 
again. But in most cases it’s simply a matter 
of replacing your USB cables. Old or worn 
cables can have a broken wire with the 
ends loosely touching, or a dry solder joint 
at the plug end. The connection breaks and 
the Mac thinks the plug has been pulled. 
Sometimes the bad connection is on the 
device and a Thunderbolt port may work 
instead, if available. It probably isn’t a loose 
connection on the USB ports of your 
motherboard. You most likely only need to 
invest in new USB cables. 

Putting hard disks to sleep when possible saves 
energy, but this has been reported to cause 
problems with USB devices on some Macs.

   In MF285 you advised Martin 
Tuck he doesn’t need security 
software. For someone writing for 

an international magazine to be naïve and 
blinkered enough to believe security 
software isn’t needed is utterly deplorable.

Macs are just as prone to attacks from 
viruses, malware and security holes as 
PCs. Have you forgotten the recently 
exploited NTP, OpenSSL, WebKit, RSA 
(FREAK) and numerous others? How 
about the increasingly large number of 
malicious viruses and malware being 
developed and deployed for OS X? Security 
is NOT sticking one’s head in the sand!  
Stuart Clark

  It’s definitely good to be vigilant about 
security for our Macs. However, third-
party security software wouldn’t have 

protected OS X from any of those vulnerabilities 
you mention. All of them were security flaws 
discovered by researchers and patched soon 
afterwards by Apple. 

Kaspersky or Norton Antivirus can’t provide  
any extra security there. And I’m not aware of any 
OS X viruses that are actually present out there  
‘in the wild’ – just some proof-of-concept viruses 
developed by researchers. 

Since Snow Leopard, OS X has had its own 
built-in malware scanner that already checks file 
downloads against a database of known trojans 
and malware. I have yet to be persuaded that any 

third-party security software adds any real benefit 
for a Mac user. I’m open minded though, and if 
the situation changes, I’ll certainly discuss it here. 

I can’t connect more than 
one USB device

OS X wasn’t affected by the Heartbleed bug because Apple 
had already replaced the vulnerable OpenSSL library.

If you don’t use Setup Assistant 
you can run Migration Assistant 
to move apps and data across.

The hard truth about Mac security

Setting up  
a new Mac

   I’ve just ordered a new 
27-inch iMac to replace my 
Mac mini. My current mini is 

loaded with all my apps and content. 
Where do I stand with apps I’ve paid 
for such as Word, Excel and 
Parallels? Will they be transferred 
via Migration Assistant? I’m worried 
I’ll have to purchase more product 
keys if I start moving these across? 
Tom Mendoza

  Relax, you’re fine. When you turn 
on your new Mac, the first thing 
you’ll see is the Setup Assistant 

wizard that will walk you through the 
process of transferring everything from the 
old Mac or a Time Machine backup. Paid-for 
apps will transfer just fine and so will 
everything else, unless you have some 

weird app that 
ties its licence 
to the Mac 
address of 
your network 
card or similar. 
I’m not aware 
of any such 
apps though. 
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Mac SOS

   I have 10.6.8 Snow Leopard. 
It’s doing everything I need 
here: VMware 3 using 

Windoze XP, SQL Server and Crystal 
Reports all work perfectly, sharing 
Mac folders. So why upgrade? 
VMware 7 won’t go on 10.6.8, I don’t 
think. Is it easy to go to Yosemite 
(and keep using VMware 3 or does it 
need an upgrade to 7?) Will I lose my 
apps or files? Will XP still be usable? 
I have a 2008 Mac Pro 2x 2.8GHz 
Quad Xeon model.
Mike Bird

  There’s certainly a strong 
argument for not fixing things 
that ain’t broke. But both Snow 

Leopard and Windows XP are no longer 
supported by Apple and Microsoft 
respectively. That means no new security 
updates and, for XP especially, that may be 
a concern if your Mac Pro is connected to 
the internet. Any viruses or trojans you pick 
up in Windows can’t cross-infect OS X, but 
they will affect you all the time you are 

running Windows and can spread to clients 
or friends. But on the other hand, the 
upgrade to Yosemite, Windows 8 and 
VMware Fusion 7 is big enough that  
I would be strongly tempted to upgrade 
the Mac Pro as well. 

Your mention of SQL Server makes me 
think that this machine is used for work 
and I’d be very nervous of changing so 
many things at once on a computer that  
I used to earn a 
living. By starting 
with a new Mac, 
you can keep the 
old one running, 
and set up the 
new one running 
alongside until 
you are confident 
you’ve ironed out 
any kinks. 

   I have an Acer V223HQV 
monitor I would like to reuse 
as an external display for my 

2012 MacBook Pro (Retina display). 
I’ve tried using a VGA to DVI 
adaptor connected to a DVI to 
Thunderbolt connector but I get no 
picture. The monitor is detected in 
System Preferences, but the screen 
stays blank. Can this work?
Jack Maslin

  Yes, but not with those cables. 
The Thunderbolt port on your 
MacBook Pro can output both 

analogue and digital video, but when you 
connect it to the DVI to Thunderbolt 
adaptor, only the DVI-D portion of the 
signal is carried, which is digital only. 

The VGA to DVI adaptor plugged into 
that is expecting the DVI-A (analogue) part  
of the signal, but hears nothing, because 
those pins aren’t connected.

To fix this, you need a single Mini 
DisplayPort to VGA adaptor. Mini 
DisplayPort uses the same connector as 
Thunderbolt and is backwards compatible 
with it – you can use a Thunderbolt port to 
connect any Mini DisplayPort devices.

Apple sells these adapters for £25 but 
there are clones on Amazon for around £6. 
Connecting a VGA monitor to a Retina 
MacBook isn’t going to give you a fantastic 
picture though. The signal is converted 
from digital to analogue and back again 
and simultaneously downscaled from 
Retina resolution to whatever the monitor 
supports. Expect small fonts to look blurry. 

Do I even need to upgrade?

The beauty of 
using your Mac 
Pro for work is 
that you can claim 
it against tax!

Some sneaky tricks and fixes that we’ve 
stumbled across this month. If you find  
one yourself, send it in!

Spotlight normally closes as soon  
as you click the search window. If 

you are using it as a calculator, it can be 
annoying to have to remember the result 
when you switch back to the email you 
were writing. Right-clicking the magnifying 
glass icon on Yosemite’s menu bar will 
make Spotlight stay on top. 

If another application is using the 
microphone then FaceTime won’t be 

able to open the device and won’t transmit 
audio (or warn you that it failed to open 
the mic). This happens even if the other 
app is running on another user account.  

If you close the lid on a MacBook  
Air without shutting down and  

the battery runs flat, it can sometimes 
mistakenly think it’s plugged into an 
external display and the screen won’t turn 
on again. Fix this by pressing ≈+ç+ 
P+R+power button. 

Find empty folders on your Mac  
by creating a smart folder in Finder 

that matches ‘Kind is Folder’ and ‘Number 
of items equals 0’. 

 If iTunes seems to start itself 
spontaneously, check that no one  

in your household is using Bluetooth 
headphones that have previously been 
paired with the Mac. iTunes will start every 
time the headphones are turned on,  
if the Mac has Bluetooth on. 

Spotlight is more useful as a calculator, when you 
can make the results window ‘sticky’.

fix it yourself

Apple’s VGA adaptor cable seems overpriced, but 
there are some active conversion electronics inside 
and cheaper clones may have cut corners there.

An old monitor as  
a second screen
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Get in  
touch

If you have a technical 
query with your iOS 

device that you need 
answering, please  

email us at    
sos@macformat.com Christian Hall fixes your iPad 

and iPhone problems

   My iPhone 5c regularly gets 
stuck in a loop of insisting on 
my Apple ID and password. 

I’m sure I’m entering the right details 
but the login pop-up just comes back 
again. Is this the fault of iOS 8.1? 
Sian Roberts

  This can occasionally happen if 
your phone can’t connect to 
Wi-Fi. iOS notices it isn’t logged 

into iCloud and assumes that’s your fault. 

Unfortunately the constant pop-ups 
prevent you from manually connecting. 

Powering off the phone and on again 
will give you a few pop-free seconds for 
you to jump to Settings > Wi-Fi and join  
a network. If that’s not enough time, back  
it up in iTunes, dismiss the pop-up, and  
it shouldn’t return until the backup 
completes, which gives you time to sort 
out the Wi-Fi. If you don’t have access to a 
network, do a full restore. Sign into iCloud 
and the cycle should be broken. 

Drifting drone

Locked in a login loop

Can I just get rid 
of the app?

   What is the purpose of the 
Nike + iPod setting on my 
iPhone? Does it only work  

if I have a pedometer? I have no 
intention of suddenly taking up 
running and I’d like to clear some 
space. Can I get rid of it? 
Tim Southern

  Yes, it only does anything if you 
have the Nike + sensor kit to 
measure your strides. It’s only 

bundled with the iPhone and iPod, not  
the iPad (who goes jogging with an iPad?). 
But it’s a core app, so you can’t remove it.  
If you swipe the Nike + iPod setting off in 
Settings, the corresponding app will 
disappear from your home screen. But this 
doesn’t actually save you any storage space 
because the app is still there – it just 
doesn’t show its icon. There’s no way to 
actually uninstall it altogether. 

A phone that 
doesn’t make calls

   I’m planning to go to the US on holiday 
in a few weeks. I want to use my iPhone 
6 as a camera while I’m away but I don’t 

want to risk running up roaming charges if I 
receive calls or texts. Is there a way of avoiding 
this? I can turn off cellular data, but I can’t find 
a setting to turn off phone calls and texts. 
Lyn Moore

  Turning on Airplane Mode disables all wireless 
communication systems in your iPhone. 
Counter intuitively, you can then switch on 

Wi-Fi in isolation, keeping all other systems off. (This also 
works for Bluetooth, should you need to use, say, 
headphones.) You’ll be able to get online over Wi-Fi and 
the camera will work just fine.

Drones like the Parrot 
BeBop let you control 
them through your iPad.

   I was recently treated to the 
Parrot AR Drone for my 
birthday by my wife. I have 

flown RC planes before but this is my 
first quadcopter and I’m still getting 
to grips with the FreeFlight app. I 
have the drone in ‘flat trim’ mode, but 
I find it often drifts quite badly in one 
direction – and not always the same 
one! I’ve tried compensating with the 

manual trim settings but I have to 
adjust the values on each flight. Is 
this a bug or is my drone faulty? 
Alastair Crewkerne

  I haven’t played with the AR 
Drone myself, but from the 
manual and the FAQ at ardrone2.

parrot.com/faq, I think you might be 
enabling Flat Trim while your quadcopter is 
sitting on a slope. The Flat Trim mode 
zeroes the trim values for the onboard 
gyroscopes, assuming the drone is sitting 
on a level surface. If you’re on the side of a 
hill, you are essentially programming in a 
control bias that will try to move the drone 
in whatever direction was downhill when 
you enabled Flat Trim. To fix this, put the 
drone on a horizontal surface, open the 
FreeFlight app and tap the Flat Trim button. 
You should be able to leave the Trim Select 
settings on Auto and it will still fly level.

mailto:sos@macformat.com
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How do i get mine?

Download back issues onto your iOS  
device – get our award-winning app at 

bit.ly/macformatipad

To order back issues of the print 
magazine, go to http://goo.gl/B7aFdk  

or phone +44 (0)844 848 2852 
and we’ll post them out to you

To become a subscriber so you never miss 
another issue in the future, go to page 26.

Looking for a back issue? Look no 
further. Search for ‘MacFormat’ on 

the App Store to get our award-
winning app for iPad, iPhone and 
iPod touch! There are lots of issues 

of MacFormat inside it, ready to 
be downloaded immediately. 

And remember, from issue 250, 
MacFormat became a fully 

interactive iPad app! 

http://goo.gl/B7aFdk
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uring the next few months we’re 
likely to see major updates to 
OS X and iOS (Apple’s WWDC is 
June 8). It’s operating system 
upgrade cycle in recent years has 
been almost like clockwork, 
providing us with new features, 

along with the occasional interface overhaul. 
These things have kept our Macs and iOS 
devices fresh and made them more versatile. 

OS X and iOS are great, but we think they could be better. 
Here is MacFormat’s wish list of features and fixes for when 

Apple updates its operating systems later this year 
However, as well as Apple does, there are some 
missing pieces we hope will one day arrive.

In this feature, we explore those features we 
hope are waiting in the wings. Some are rough 
edges that need polishing, while others are what 
we consider fairly major omissions we feel Apple 
needs to deal with quickly, before the Apple 
faithful rises up and marches on Cupertino (well, 
writes a fairly sternly worded but nonetheless 
extremely polite email to Tim Cook, anyway).

Given that Apple has increasingly mixed and 
matched features from its two operating systems, 
some of the missing pieces we’ve written about 
are common to OS X and iOS, and these are the 
first things in our list. Stability, iCloud, FaceTime 
and app discovery all have pretty big problems. 
Afterwards, we’ve concentrated on a range of 
possible fixes and features for OS X, before 
outlining a raft of improvements we would love 
to come to our iPhones and iPads.

D
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The App Store and Mac App Store (pictured) offer a selection of 
editors’ choice apps and games, and some curated collections, 
but Apple should do more to make apps discoverable.

As online storage becomes essential, it’s time 
for Apple to stop being so miserly

Apple needs to make it easier to find the right apps for you

It’s time for Apple to squash those bugs 
and make OS X and iOS rock-solid

Apple’s video-chat is frozen in time; surely 
we should have group chat by now?

There’s no denying Apple makes impressive 
hardware, but Macs and iOS devices would 
be nothing without apps. Of course, when 
you first power up your Mac, iPhone or iPad, 
you already have some preloaded software, 
but it’s with third-party apps that things 
become interesting, enabling you to turn 
a device into anything from a full-featured 
music studio to a gaming powerhouse.

The snag is that finding new apps is 
hard. Apple attempts to simplify things on 
its app stores by highlighting new products 
it considers of interest, and curating 
collections so that you can quickly find 
apps for photography, writing and various 

other tasks. But beyond this and the odd 
promotion – kudos, Apple, for the indie 
showcase on iOS – everything feels 
a little… last century.

We want app stores that understand 
who we are and what we’ve bought, and 
suggest further purchases accordingly. 
When Apple offered ‘Genius’, it was 
anything but. (“You’ve bought a Twitter 
client. How about another Twitter client?”) 
It’s 2015, so we should at least expect some 
intelligent recommendations to be rather 
more prominent, perhaps backed by social 
network integration that tells you what 
your friends are buying.

Apple has got itself into a position where it’s expected to 
release new hardware like clockwork, and with that comes 
the demand for new and improved software. Every year, 
OS X and iOS are refreshed, but there’s a widespread 
feeling stability suffers and that bugs are commonplace. 
As much as we enjoy new features in Apple’s operating 
systems, we’d be happier if things didn’t crash so much. 
Apple could slow down a bit, or offer more updates that 
concentrate on bug fixes.

FaceTime is incredibly easy to use, assuming you want 
to talk to someone else who has a piece of Apple kit 
that’s equipped with a suitable camera. Where it falls 
down really badly is if you want to talk to two or more 
people at once, and they don’t all happen to be in the 
same room. (Even if they are, things get a bit cosy.) 
Skype has group video calling, entirely for free, and 
Google Hangouts can do something similar. It’s time 
Apple caught up and made FaceTime a bit more magical.

iClOuD STOrAGe

APP DISCOvery

STAbIlITy

FACeTIMe

The first time you ever use iCloud, 
you’re probably quite happy to see 
that Apple has given you 5GB of 
space entirely for free. That seems 
pretty generous, but any joy rapidly 
evaporates when you realise just how 
fast that space fills up. The problem is 
that Apple wants you to use iCloud 
for everything. It’s where your iOS 
backups live. It’s where all of your 
photographs are supposed to be 
stored. And it’s increasingly where iOS 
and even OS X apps default to when 
you try to save anything.

Naturally, when you 
blaze through 5GB, that’s 
not the end. Apple provides 
four monthly payment 
options for upgrading your 
storage: 20GB for 79p; 
200GB for £2.99; 500GB for 
£6.99; and 1TB for £14.99. 
(Your eyes aren’t deceiving 
you – it’s actually more 
than twice as expensive to 
buy 1TB per month than two 
lots of 500GB would cost you, if that 

happened to be an option.) It’s 
perfectly justifiable to ask heavy 
users to splash out, but we’re 
reaching the point where a single 
iOS device backup can stretch that 
5GB, and two device backups is 
often impossible. We don’t know 
what the solution is – 5GB per new 
Mac/iOS device purchase, or free 
backup storage; we just know 
backups at the very least should just 
work. As it is, lots of people see a 
storage error and stop backing up.

You should always be able to back up 
your devices, however many you own.

OS X and iOS Apple’s operating systems might 
share genius, but they also share 
things we’d sooner be shot of
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It’s funny to think that iTunes was once a highly 
regarded, industry-leading music player. But 
time hasn’t been kind to Apple’s jukebox. It has 
been saddled with far too many tasks, resulting 
in it becoming a complex, buggy behemoth.

The most recent major update attempted to 
simplify things, mostly by hiding stuff that was 
previously more readily accessible. It was a 
great example of rearranging the deckchairs 
on the Titanic, although we suspect if iTunes 
was confronted with a massive iceberg, it 
would smash right through. There’s just no 
getting rid of it. The app blunders on, despite 
syncing being broken for loads of users, and 
the app seemingly being desperate to shove 
you towards a storefront at every available 
opportunity. We shudder to think what will 
happen when Beats is integrated.

On iOS, everything is rather different. 
Apple’s mobile operating system was 
based on efficiency and focus. On starting 
from scratch, Apple decided against 
remaking iTunes for iPhone, and instead 
provided separate apps that dealt with 
specific areas of iTunes’ functionality. 
Today, there’s quite a range, including 
Music, Podcasts, Videos and iTunes U. The 
iTunes app exists in name only, simply being 
a means of accessing the iTunes Store.

On OS X, we could conceivably have the 
same – a set of simple, sleek, reliable apps, 
each designed to do one thing really well 
rather than lots of things in a sometimes 
bearable fashion. At the same time, Apple 
could bring across some of the other ‘missing’ 
iOS apps, including Weather and Voice Memos. 
(And even Stocks, for the literally several 
people who can’t do without it.)

Of course, it’s highly unlikely to ever happen. 
Although iTunes is less relevant than it once 
was, with Apple making iOS devices optionally 
independent of Macs and plenty of people 
preferring Spotify for music playback, it still has 

a wide audience, much of it on Windows. 
Apple might conceivably put the effort into 
making a bunch of new apps for Macs, but it’s 
hard to see it doing so for Windows. And there 
are people who rather like the fact all their 
media is bundled up in a single app (those 
crazy fools!), even if they’d be equally well 
served by a separate sync product.

So given that iTunes will likely survive until 
the heat death of the universe, please fix it, 
Apple, if you don’t have it in you to scrap it. 
iTunes is starting to feel like a practical joke 
when it was once actually really good.

The interface mode pros were 
clamouring for proved disappointing

Most Macs have a mic, but none of them yet have  
a digital assistant, and it’s time for that to change

When Apple revealed OS X’s ‘dark mode’ at WWDC,  
quite a few developers made very happy noises. A  
built-in alternative OS X theme has been a long time 
coming, and much requested by people who use pro apps 
with dark interfaces. The standard OS X theme’s menu bar 
and Dock can be a distraction from the blacks and dark 
greys in such software.

The problem is Apple seemingly did the least it could 
with its implementation. Beyond the menu bar and Dock, 
only Spotlight seems to be affected. We’d like Apple to 
go further, replacing ‘Use dark menu bar and Dock’ with 
a full alternative OS X visual theme.

On changing modes, your desktop background would 
optionally automatically be switched to something more 
suitable. More importantly, a much wider range of 
system components would be affected, including (but 
not necessarily limited to) windows and dialog boxes. It 
should also be something developers can hook into 
when creating apps that utilise standard Apple interface 
elements, enabling them all to have a dark mode ‘for 
free’, and on a consistent basis system-wide.

DArk MODe SIrI FOr MAC

Like Maps, Siri gets a bit of a bad rep 
on iOS, mostly from people who used 
the feature when it first appeared, 
decided (with some justification) that 
it was a bit rubbish, and haven’t tried 
it since. Today, Siri’s still a long way 
from an artificial intelligence, but can 
nonetheless quite gracefully perform 
certain tasks and grab bits of info, 
thereby saving you time and energy. 

The Mac’s always been quite good 
at talking and listening, even if most 
of the options for doing so are 
buried in its Accessibility preferences, 
but it’s never had anything quite like 
Siri. You can dictate to your Mac, and 
even control the entire thing with 
your voice, but ask it what the 
weather’s going to be like on 
Wednesday or how QPR did at the 
weekend, and your Mac responds 

much as a Labrador might if you 
asked it to sing an aria.

But with Apple pushing Continuity 
and ensuring concepts work across 
its range of kit, Siri is surely a must 
for an upcoming revision of OS X. 
That said, if it does appear, we hope 
it’s blessed with a little intelligence 
regarding the device you’re currently 
using. The last thing we need is to 
say “Hey, Siri!” and have multiple Siris 
shouting all over each-other.

NO MOre iTuNeS
Apple’s media manager is big, 
bulky, complex and buggy. It’s 

time for Apple to break up iTunes

OS X While Apple busies itself turning 
its desktop OS up to, er, 10.11, 
we’re hoping for serious refinement

When Siri does show up 
for Mac, we can ask it: 

“What took you so long?”

THE MISSING PIECES  
OF OS X AND iOS
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Dealing with multiple windows can be a fiddly 
experience, but Apple could learn from Microsoft

WINDOW SNAPPING

Window management has always 
been a bit messy on OS X, with 
controls primarily designed to hide 
windows by shoving them in the 
Dock, or shift them between two 
sizes by clicking the green zoom 
button. In Yosemite, the green button 
has been repurposed for making 
a window full-screen, and the old 
behaviour is relegated to an å-click.

There have never been 
any system controls to 
make it easier to view 
a couple of apps or 
documents in a layout 
that makes them easy 
to compare or refer to. 
This is something 
Windows got right a 
while back. Windows 
Snap enables you to 
arrange windows side-
by-side by dragging 
them to a screen edge. 
Plenty of third-party utilities for the 
Mac offer broadly similar features.

Perhaps it is unlikely that Apple 
will follow suit, given it seems 
wedded to the idea of full-screen or 
nothing these days, but if two-up 
app display arrives on the iPad, it 
would be logical for the feature to 
make its way ‘back to the Mac’. In 
the meantime, we recommend the 
excellent Moom ($10, manytricks.
com) for OS X window control.

When you’re running loads of apps, 
muting one of them should be a cinch

It’s time OS X didn’t resemble a bunch of 
visual styles competing for the spotlight

It’s a pain when you’re working away and music starts 
blaring from… somewhere. A web browser’s often the 
culprit, although not always. Regardless, it’s annoying 
that you can’t mute specific apps – only your entire Mac. 
Yet there’s a logical place for greater audio control: the 
menu bar’s volume icon. å-click it and you get output 
and input settings. A new submenu, listing noisy apps 
and enabling you to silence them, would be heaven.

We imagine this is the one wish list entry we will see in 
some way, given that Yosemite feels much like OS X 10.0 
once did – an extreme change that’s unfinished. It needs 
– and might get – refinement, such as more contrast and 
improved app icons. But there’s a specific change we’d 
appreciate: bring back old-style Finder labels. They were 
far more prominent (and so more useful) than Yosemite’s 
tiny tag circles that lurk at the end of filenames.

AuDIO SIleNCING

reFINe THe INTerFACe

While Apple ticks a lot of boxes when it comes to 
accessibility, it still ignores motion and balance issues

reDuCe MOTION

Apple obviously cares an awful lot about 
accessibility. This is evident when you delve into 
System Preferences and examine all the settings 
that are designed to aid people who need 
assistance when it comes to looking at, 
listening to or interacting with their Macs.  
It’s quite something that entirely blind or  
deaf users can interact with OS X, as can people 
with motor impairment. However, one thing  
is conspicuous by its absence: the means  
to help people who suffer from balance/ 
motion sickness.

This is a curious blind spot for Apple on the 
Mac. Although the issue is not well understood 
in the tech industry as a whole, Apple did 
respond to it when iOS 7 started making 
people dizzy and nauseated due to fast 
slide and zoom transitions throughout the 
operating system. Quite a bit of bad press  
and a couple of updates later, Reduce Motion 
was introduced, helping millions of people 

who’d suddenly found their 
devices unusable.

OS X has had similar 
problems since OS X Lion. 
There’s the slide transition 
between full-screen apps, and 
the ‘morphing’ animation that 
occurs to and from full-
screen. Slides exist 
elsewhere, too, such as 
in Safari and Preview. 
Three major versions 
later and these 
animations persist, with no means of disabling 
them. We very much hope when Yosemite’s 
successor arrives, it will finally include Reduce 
Motion – not as a default, but as an option. 

If our experience is anything to go by, while 
some users rely on accessibility settings to use 
their Macs, plenty of other people pick and 
choose the bits they like to boost their Mac 

experiences too. In other words, Reduce 
Motion would become another setting that 
could potentially benefit many people, despite 
being intended for a relative few.

Even Apple Watch has a Reduce Motion setting, so there’s 
no excuse for its omission on the Mac, where animations 
and transitions are hard to miss.

THE MISSING PIECES  
OF OS X AND iOS
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Apple wants you to download loads of apps, 
but should better help you manage them

One app at a time has been the iOS mantra, 
but we want a side-by-side option

C’mon, Apple, it’s time to let us hide 
Stocks and default to using Google Maps

When you’re working, you don’t really need 
multiple devices screaming at you

Some of Apple’s rivals have a reputation for filling new 
devices with junk. On first launch, you’re faced with apps, 
demos and even ads you can’t get rid off. However, Apple’s 
not perfect itself. New iPhones and iPads have a load of 
pre-installed apps, and the latest iOS update includes a new 
app called Apple Watch. This is designed to help you manage 
Apple’s wearable, but essentially otherwise functions as an 
advert you can’t remove.

The ability to delete default apps entirely from your 
device would be dangerous – you can imagine horror 
stories of people accidentally removing Safari or Mail. 
However, we’d like some switches ‘buried’ in Settings to 
enable these apps to be hidden, rather like how you can 
hide channels on an Apple TV. While we’re talking about 
default apps, it would be great to finally assign custom 
alternatives to Apple’s own, for those people who prefer 
Google Maps to Apple’s Maps and Mailbox to Mail.

We love Continuity and the manner in which 
Apple is thoughtfully increasing integration 
between devices, but we wish the system would 
be a bit more intelligent. If you’re busy working 
on your Mac and a message comes in, you 
might welcome a notification on your screen. 
Chances are you won’t be thrilled by all of your 
nearby iPads and iPhones blaring out the same 
notification over the next few seconds. We’d like 
devices to be more aware of their proximity to 
each other, intelligently feeding notifications 
and actionable alerts to the device you’re 
working with, not all of them. (Again, this could 
be optional should you thrive on cacophony.)

APP MANAGeMeNT TWO-uP APPS

DeFAulT APP CONTrOlS lOCATION AWAreNeSS

We’ve never been impressed by 
Apple’s ’scorched earth’ policy 
regarding iOS app deletion. No 
matter how long you’ve used an 
app for, removal takes your data 
with it. Reinstall and you then 
start from scratch, whether 
you were weeks 
into an adventure 
game or had set up 
a utility just how 
you liked it.

In theory, iCloud 
should seamlessly 
deal with this – and 
sometimes it does; 
but relatively few 
developers utilise 
it. Apple should 
take the lead here, 
automating the 
process and 

enabling you to optionally 
restore settings and data on 
any app reinstall.

Further app management 
improvements would also be 
welcome. It can take a long 

time to delete an app. 
Icons will wiggle, you’ll 
tap the cross, but it’ll 
be ages before the 
confirmation dialog 
appears, during which 
time your device will 
be unresponsive. And 
when you’ve loads of 
apps, organising them is 
a pain, so many people 
don’t. Would it kill Apple 
to add sorting options, 
so you could display 
apps alphabetically 
or by subject?

The long-rumoured iPad Pro 
is supposed to boast a larger 
display than the iPad Air, along 
with a means to simultaneously 
display two apps. The hardware 
might be elusive, but developers 
have confirmed code exists for 
two-up app display in iOS, 
splitting the screen in half and 
other ratios.

Full-screen apps can be 
beneficial by forcing you to 
focus on a single task. You can 
easily switch between apps 
using a four-finger swipe. 
But there are times when it’s 
frustrating not to see two apps 
at once, such as reference 
material alongside what you’re 
writing, or even just to browse 
the web and keep a messaging 
app open alongside it.

Should a split-screen option 
come to pass, it’ll need careful 
consideration from Apple, 
because it has the potential 
to add complexity to the iOS 
interface and confuse. Done 
right, it would definitely inject 
some ‘pro’ into the iPad, 
regardless of whether we get 
iPad hardware in a larger size.

If all your devices are in one place, there’s no need for all 
of them to fire notifications at your eyes and ears.

Apple loves full-screen mode, but we’re 
pretty sure actual people would be fond 
of viewing two iPad apps at once.

THE MISSING PIECES  
OF OS X AND iOS
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It turns out that weekdays and 
weekends aren’t the same thing!

We’d like our eyes to still 
function at night, please

DO NOT DISTurb NIGHT MODe

Apple rightly gets praised for doubling down on 
simplicity, but sometimes this approach can get in 
the way. A good example is Do Not Disturb, the 
feature that ensures your device doesn’t blare out 
notifications during certain hours of the day (or 
night). The problem is that the settings you define 
are active every day, but people’s lives are seldom 
so regimented. At the very least, you should be 
able to separately fine-tune Do Not Disturb for 
weekdays and weekends.

When iOS 7 appeared, some people 
found the stark, bright interface gave 
them headaches. Brightness levels 
can be adjusted, but some apps more 
helpfully offer a darker ‘night mode’, 
to ensure your retinas aren’t burned 
out. An accessibility setting inverts 
the screen, but that makes colours go 
weird, and so a system-wide night 
mode would be much better.

Only allowing file system access from within 
apps is unhelpful – we want an iOS Finder

FIleS APP

With iCloud Drive, Apple finally gave users access to a file system 
on iOS, no longer forcing you to access documents solely from 
the app that created them. The downside is Apple didn’t twin this 
with an iOS version of Finder. The file system is only accessible in 
apps that support iCloud Drive and include the Document Picker.

We suspect Apple’s attempting to hide complexity from 
users, but the horse has bolted. For those people who need the 
means to manage files, not having a ‘Files’ app seems like a 
major oversight. In the meantime, we’re left with workarounds, 
such as using Readdle’s Documents (pictured), to access and 
manage files on iCloud Drive and elsewhere, but we’d sooner 
see an official Apple solution on our devices.

Want an account for kids, guests or someone 
else? We certainly want more than just the one

uSer ACCOuNTS

OS X should    
rethink window 
management, 
possibly 
eliminating it. 
iOS trained me 
to focus on one 

app at a time, without worrying 
which window is ‘behind’ 
another. Getting OS X to that 
point wouldn’t just be a matter 
of consistency – it would 
genuinely improve it.

Right now, Mac screens range 
from 11 to 30 inches. A solution 
to this spectrum of sizes is 
giving users flexibility in how 
to arrange workspaces (Spaces, 
full-screen, windows and so on), 
but it would be better to 
provide APIs and guidance by 
example to ensure apps adjust 
themselves to shine on a 
MacBook Air as well as on an 
iMac. Reminders in full-screen 
on a large device is a good 
illustration of this unaddressed 
issue – it looks ludicrous when 
it should become more useful.

iOS should also get better at 
window management, along 
with introducing features and 
concepts to improve cross-app 
and multi-app workflow. Also, 
iOS should be rethought for 
iPad. Since iOS 7, it has proved 
that early joke about iPad being 
a scaled-up iPod touch. iPad 
should have its own OS features 
and ways of doing things.

Instability and lack of polish 
are real problems, too. I’d be 
happy to see Apple spend a 
year cleaning things up to 
stabilise its platforms. If there’s 
time left over, a similar spring 
clean on visual design would be 
great – too much of iOS and 
OS X still suffers from ungainly, 
rushed, or inconsistent design.

Panic designer and 
iOS game maker 
(Blackbar; Space Age; 
The Incident) Neven 
Mrgan tells us what 
he does and doesn’t 
want to see next from 
OS X and iOS

Apple clearly believes iPhones and 
iPads are inherently personal 
devices, owned and managed by a 
single person. That’s all well and 
good if you happen to be well off, 
but it’s not realistic for many 
people. Additionally, there are 
times when you want to 
temporarily hand over your device 
to someone, but don’t want them 
to have access to your data.

This is why we want to see 
multiple user accounts come to 
iOS. We doubt Apple would ever 

budge to the degree of 
providing Mac-like user 
accounts, but perhaps some 
kind of compromise would be 
possible. For example, we’d be 
happy with a stripped-back 
‘child’ account, to minimise 
‘damage’ when a young person 
wants to have a go on your 
device. Alternatively, a guest 
account that wipes itself clean 
when closed could be another 
option, albeit a sub-optimal one 
compared to full user accounts.

THE MISSING PIECES  
OF OS X AND iOS
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“Bakers rejoice – this clever 
kitchen scale makes cooking a 

piece of cake and looks great too”Drop Kitchen Connected Scale p88

 REVIEW MANIFESTO

Given solely at the discretion 
of the Editor only to truly 
exceptional products.

Our group test winner gets 
this award; it’s the best of its 
kind at the time of writing.

Our reviews are totally independent; 
we’re not affiliated with Apple or 
anyone else, nor are we influenced by 
advertisers. You can trust us.

Prices we quote for products are 
correct at the time of writing and are 
the best we can find from a reputable 
online dealer, excluding delivery.

Our ratings explained

HHHHH Rarely given; a brilliant thing 
that’s as good as you can get in its class 
right now

HHHHH A strong recommendation to 
buy; any concerns are comfortably 
outweighed by its strengths

HHHHH A good product you should 
consider buying, but there may be 
better options for you

HHHHH Fundamentally flawed either 
in concept or execution; there are 
almost certainly better options for you

HHHHH A waste of your money and 
everyone’s time; do not buy!
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Now that the smartphone is 
ubiquitous and you always 

have your music library with you, 
headphones have moved from 
afterthought to big business. 

The advantage of using bigger 
cans rather than earbuds is that, in 
general, they offer a more accurate 
and detailed sound reproduction 
thanks to their far larger diaphragms. 
A larger surface area means fewer 
compromises and tricks are required 
to generate a solid bass end. They’re 
also arguably less damaging to your 
hearing as they don’t fire sound right 
into your ear canals. Sennheiser has 
an excellent track record both in the 
pro and consumer audio worlds, and 
makes a wide range of headphones 
to suit different budgets. 

These new Momentum 2 
headphones sit at the upper end 
of the scale, an over-ear model 
designed both for listening at 
home and on the move. Over-ear 
headphones are slightly larger 
than on-ear ones but can be 
more comfortable to wear because 
they place less pressure on the 
sides of your head. They also usually 
have the advantage of isolating 
external noise and leakage from 
inside, as they completely enclose 
your ears. 

Robust package
Beautifully packaged and with a 
bundled carrying case, these 
headphones are surprisingly 
lightweight despite being very 
well built. Robust build without 
extra weight can be tricky to get 
right but it feels like Sennheiser 
has nailed it here. The finish is very 
good too, with stainless steel and 
leather featuring extensively, and 
soft ear pads. The two cups can 

actually be folded in to make the 
whole thing easier to transport and 
less prone to damage, and the 
hinges and cup adjustment sliders 
are reassuringly sturdy. 

The headphones are very 
comfortable to wear, even for long 
periods, thanks to their light weight 
and the fact that they don’t press 
down hard on your ears yet still 
remain firmly in place. 

The cable is detachable and 
comes with a remote control 
featuring play/pause controls, 
volume buttons and a microphone. 
It’s a little high up and near to your 
face so the mic can more easily pick 
up your voice for phone calls, so 
you’ll probably end up using it by 
touch rather than by sight. 

Jack of all trades
The remote supports Android as 
well as Apple’s iOS devices, and the 
headphones can of course be 
plugged into anything with a mini 

jack output – though there’s no 
adaptor provided for connecting to 
the larger quarter-inch sockets. 

The sound quality of the 
Momentums is excellent, possibly 
more so when connected to an iOS 
device than a Mac’s headphone out 
since iOS devices tend to be able to 
drive levels a little harder. Tested with 
an iPhone 6, they offered a very clear 
and detailed soundstage with a rich 
but not overpowering bass end and 
were as adept with gentler folk tunes 
as with thundering electronic 

music. Where a track had a very 
prominent mid range, usually 
meaning vocals mixed quite high, 
they did become slightly bright at 
the highest volumes. This is with 
the iOS EQ control switched off (as 
it always is here), so you could 
perhaps tweak this if you found it 
to be an issue. 

Listening to that thundering 
electronica also showed that there 
was very little leakage of sound 
either in from outside or out from 
inside even at high volumes, which 
is good news for the people sitting 
next to you on the tube or your 
colleagues at work. 

The bottom line is that these are 
great headphones, but at a shade 
under £300 they have some strong 
competition at that price point. It’s 
worth comparing with other sets 
before you buy. Hollin Jones

These beautifully packaged headphones 
are lightweight and comfortable despite 
being very well built and finished

Sennheiser 
Momentum 2
Portability without compromise 
on sound or build quality
HHHHH
£270 Manufacturer Sennheiser, sennheiser.com

Frequency 16Hz - 2200Hz Connectivity 1.4m detachable cable with  
3.5mm plug Weight 240g Impedance 18 Ω

The leather and stainless steel 
finish makes the headphones 
sturdy but lightweight.

Great sounding 
and beautifully 
engineered 

headphones, though there 
is competition at this price.

  Excellent build quality

  Very comfortable and portable

  Clear and rich soundstage

  A little pricey

The frequency 
response of 
these cans is 

at a slightly broader 
range than average 
human hearing, but the 
emphasis is clearly on 
the mid-range. I can’t 
wait to put some jazz on 
them and hear those 
horns sing!

Team Talk
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Logitech UE 
MegaBoom

HHHHH
£249 Manufacturer Logitech, ultimateears.com

Connectivity Bluetooth, 3.5mm line-in Battery life up to 20 hours  
Dimensions 22.6 x 8.3cm Weight 877g

Logitech’s little Boom speaker 
got good reviews a couple of 

years ago. As the name suggests, the 
MegaBoom (from Logitech’s 
Ultimate Ears range) sticks with the 
cylindrical design of the Boom but 
makes everything bigger and louder.

It’s larger than its predecessor, but 
you can still fit it into a backpack 
without giving yourself a hernia. The 
MegaBoom is also very sturdy and 
can cope with being dropped in 
water up to a metre deep. It uses 

Bluetooth for streaming, but there’s a 
3.5mm connector on the base, along 
with a micro-USB port for charging.

The sound quality is good rather 
than outstanding, but the chunky 
design does give it a firm bass sound 
that works well with dance music. 
There’s also a MegaBoom app that 
provides a five-channel equaliser so 
that you can tweak the sound for 
different types of music. However, 
the real attraction is the MegaBoom’s 
sheer volume. We could only push it 

up to about 60% before we started 
to worry about annoying the 
neighbours, and the 20-hour battery 
life will keeping it going all night.

There are less expensive speakers 
that can match the MegaBoom in 
terms of sound quality. However, 
the rugged design, long battery 
life and the sheer power of the 
MegaBoom make it a good choice 
if you really want to pump up the 
volume when you go on holiday. 
Cliff Joseph

It’s a bit pricey, but 
the MegaBoom’s 
power and long-

lasting battery will earn 
their keep on the move.

  Firm bass and plenty of volume

  Portable, water-resistant design

  Good battery life

  Rather expensive

A simple to use 
guitar interface 
for iOS that’s an 

absolute bargain at the 
price despite its flaws

  Compact and easy to use

  No discernible latency

  Gain dial and jack output

  Sound quality lacks richness

A sturdy new Bluetooth speaker  
that turns everything up to 11

The MegaBoom’s sturdy, 
water-resistant design is 
ideal for outdoor use.

iRig 2

HHHHH
£30 Manufacturer IK Multimedia, ikmultimedia.com

Requires guitar with jack lead, iOS device with headphone port and running 
compatible recording software

The original iRig was a hugely 
popular and entirely idiot-proof 

means of plugging a guitar into an 
iOS device. This follow-up isn’t quite 
as simple, but because of that it’s far 
more versatile.

The basics remain the same: plug 
it into your device’s headphone 
socket, then plug your guitar jack 
lead into the quarter-inch input. You 
can plug headphones into the 
3.5mm output socket too, to better 
monitor what you’re playing. The 
new additions are an input gain dial 
and jack output; with the flick of a 
switch, the output signal can be 

toggled between FX (processed) and 
THRU (clean). The case now boasts a 
clip, and there’s a strap in the box for 
attaching your iRig 2 to a mic stand.

During testing, it was immediately 
apparent this isn’t so much an 
improvement on the iRig as an 
entirely new piece of hardware. 
With our iPad Air we experienced 
no discernible latency, and the 
default input was clearer than the 
relatively thin sound you get from 
the old iRig. Apps seemed happy 
with the gain up high, which 
provided a strong signal for 
recording; when outputting to an 

amp, the ability to fine-tune gain 
levels was useful for improving the 
overall sound.

Compared to higher-end 
Lightning port guitar interfaces, such 
as Apogee’s JAM or IK Multimedia’s 
own iRig HD, the iRig 2 still comes 
off second best, lacking some 
richness and depth; but then it’s a 
fraction of the price, doesn’t stop 
you charging your device and works 
with older hardware. Craig Grannell

Rock out with this affordable  
plug-and-play iOS guitar interface

The iRig 2 expands on 
its predecessor with a 
gain dial and output.
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Drop Kitchen 
Connected Scale

HHHHH
£80 Manufacturer Adaptics, getdrop.com

Requires iPad, iOS 8.0 or higher Connectivity Bluetooth Weight 300g       
Dimensions 135x160x25mm Battery life 1 year

Digital scales are the thing to 
have if you love to bake, and 

this compact iPad accessory transfers 
the digital display into an app. 
Connect Drop up by Bluetooth and 
the free app, and you’ll have a 
kitchen scale display on your iPad. 
Either use it as a basic scale or use 
the social side of the app to run 
through a step-by-step recipe which 
can rescale your ingredients if your 
store cupboard is running low.

The Drop itself has a thick 
rubberised platform that feels very 
durable, keeps bowls steady and 
washes easily. You don’t have to 
keep syncing it up, just tap the 
button on the front and off you go. 
On the bottom is a rubber grip that 
keeps it firm on the work surface. 

But it’s the Drop Kitchen app that’s 
the star of the show. It’s beautifully 
designed and is far nicer to look at 
than your average digital scale. We 

made bread and biscuit recipes in 
this mode and found zeroing the 
scale and cycling through the 
measurement options a breeze. Just 
be prepared for a floury iPad screen!

The app is packed with more than 
100 recipes from Drop’s bakers and 
partners. It feels like an established 
social network all of its own; if more 
mainstream content partners are 
added, then Drop will be the smart 
kitchen utility to get. Christian Hall

A beautifully 
designed kitchen 
scale that doubles 

up as a helpful recipe 
recalculating assistant.

  Fast and accurate

  Clever recipe rescaling ability

  Compact and grips well

  Early days for the social side

A versatile and 
affordable 
monitor, but it 

needs an HDMI interface to 
bring it up to date.

 Very good image quality

  Adjustable height

  Built-in USB hub

  DisplayLink software is still beta

A smart scale with a tasty app that’s 
bursting with fresh features

Philips 
231P4QUPES 

HHHHH
£210 Manufacturer Philips, philips.co.uk

Display 23-inch IPS panel Resolution 1920x1080 Video interface VGA/USB 
Connectivity 2x USB 3.0, 1x USB 2.0

On paper, the 231P4QUPES 
looks good for anyone that 

needs an affordable monitor for use 
with a Mac Mini or a MacBook. 

Its 1920x1080 resolution isn’t in 
the same league as some of the 4K 
monitors now available, and the 
plastic casing does have a rather 
cheap feel to it. However, its 23-inch 
IPS panel produces a crisp, colourful 
image with wide viewing angles and 
will be more than adequate for office 

work or watching Netflix.
You can adjust the height of the 

screen and rotate it into the upright 
portrait position. However, the real 
selling point is the built-in USB hub. 
As well as providing three USB ports 
for connecting peripherals – ideal for 
the new MacBook with its single 
USB-C connector – you can send the 
video signal from your Mac to the 
display with the included USB cable.

Using the USB cable for video 

requires a special piece of software 
called DisplayLink, which is still in 
beta for Mac users. It’s not supported 
by Philips, so you won’t get any help 
from them if you encounter any 
problems. Apart from the USB 
connector, the 231P4QUPES is only 
equipped with an old VGA port, so 
it’d make more sense if the monitor 
had an up-to-date HDMI interface to 
provide a reliable alternative to 
DisplayLink. Cliff Joseph

An unusual monitor that uses USB 
video connection rather than HDMI

The 231P4QUPES 
monitor’s built-in USB 
hub will be ideal for 
the new MacBook.

Drop Scale is a brilliant 
kitchen sidekick that’ll 
make cooking a breeze.
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Hard disks are never the most 
exciting devices, but LaCie 

works hard to come up with unusual 
designs that make their hard drives a 
bit more interesting. In the past 
they’ve produced hard drives that 
look like silvery spheres and metallic 
sculptures, and now they’ve come 
up with the eye-catching Mirror.

It’s entirely covered on all sides 
with gleaming, reflective glass and is 
relatively chunky when compared to 
some of the latest portable drives. 
However, it only weighs 230g, so it’s 
still slim and light enough to slip into 
a backpack with no trouble at all.

You don’t have to worry about 
dropping it, as LaCie has used tough 
Corning Gorilla Glass to protect the 

screen. The only things it can’t seem 
to resist are sticky finger marks, but 
LaCie includes a cleaning cloth with 
the Mirror. There’s also a carrying 
pouch and even a smart little ebony 
stand for when you want to sit the 
Mirror on your desk.

The drive’s performance is 
respectable enough, with the 
USB 3.0 interface averaging 
around 100MB/s for both 
read and write speeds. 
That’s not going to break 
any records, but it’s in line 
with a number of other 
portable drives we’ve 
tested recently. LaCie 
also bundles some 
handy backup and 

encryption software too. 
The only real drawback is the 

price – it’s seriously expensive, with 
1TB of storage costing a hefty £209. 
To be honest, it’s more of a fashion 
statement than a computer 
accessory – but then that’s always 
been part of the Mac’s appeal, and 
the Mirror drive will certainly look 
great sitting on your desk alongside 
your super-slimline MacBook and 
your Apple Watch. Cliff Joseph

LaCie Mirror
Mirror, mirror on the wall, who’s the shiniest hard drive of them all?

HHHHH
£209 Manufacturer LaCie, www.lacie.com

Capacity 1TB Connectivity USB 3.0 Weight 230g Dimensions 8x12.8x1.3cm

The Mirror is covered with 
scratch-resistant Gorilla 
Glass to protect it when 

you’re on the move.

There are cheaper 
drives, but the 
Mirror will appeal 

to fashionistas who like to 
stand out from the crowd.

  Unique design

  Uses tough Gorilla Glass

 Very expensive

  Only average performance

http://www.lacie.com
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Tough Drive 
Mini SSD Pro 

DubS AcouSTic 
FilTerS

HHHHH
£192 Manufacturer Freecom, 
freecom.com

HHHHH
$25 (about £17) Manufacturer 
Doppler Labs, getdubs.com

The relentless march of 
miniature SSDs continues. 
This 256GB one is a little 

thicker than the Samsung T1 we 
reviewed in MF284, but it also feels 
like it would be more robust if 
dropped. Its 1.7cm thickness is a 
little easier to keep track of in a bag, 
too. Its peak and average transfer 
rates when reading were close to 
the T1, but it peaked at just 258.5MB/
second when randomly writing 
data. Significantly, that’s 113MB/sec 
lower than the T1’s peak speed in 
the same test. There’s also the issue 
of cost: a 250GB T1 is about £121.  
Alan Stonebridge

Many things in modern life 
have become pretty loud: 
concerts, living in cities, 

travelling on planes and so on. 
Regular earplugs block sound but 
also muffle it heavily. These specially 
designed tech earplugs target only 
the higher frequencies (the most 
damaging) and so allow you to hear 
relatively clearly but still protect your 
hearing from the loudest sounds. 
Tiny but comfortable, they are a 
especially good for gigs, where high 
frequency levels can be far more 
dangerous than most people realise 
if they’re having a good time! Not a 
bad price either. Hollin Jones

A nice case on this 
drive but only okay 
performance, and it’s 

expensive compared to other 
drives of similar capacity.

A way to protect your 
hearing from 
damaging frequencies 

while allowing most other 
sounds through.

univerSAl 
keyboArD
HHHHH
£80 Manufacturer Microsoft, 
microsoft.com/hardware

We would normally 
recommend keyboard cases 
but the Universal Mobile 

Keyboard (with a detachable dock) 
feels just as useful. It’s fairly slim and 
has a nice rubberised coating, so 
throwing it in a bag alongside your 
iPad (or iPhone) does no harm to it 
all. The dock element has two 
heights of groove that an iOS device 
slots into, giving you two different 
viewing angles. The dock looks 
flimsy but feels sturdy, although 
typing isn’t that comfortable. The 
dock also acts as the cover for the 
keyboard, which turns the keyboard 
on or off as well. Christian Hall

A handy detachable 
dock and multi-
platform appeal, but 

there’s better typing action to 
be found elsewhere.

SAnDiSk 
iXPAnD
HHHHH
From £42 (16GB) Manufacturer 
SanDisk, sandisk.co.uk

At first glance the iXpand 
looks like an ordinary 
memory stick, but as well 

as having a USB port for use with a 
Mac it also has a Lightning 
connector for an iPhone or iPad too. 
SanDisk’s Sync app lets you quickly 
copy files to or from your iOS 
devices, and the iXpand even has its 
own rechargeable battery so that it 
doesn’t drain the battery on your 
iPhone or iPad. It’s available from 
16GB to 128GB, and is a really handy 
option for adding extra storage to 
your iOS kit. Our only complaint is 
that it has a USB 2.0 interface rather 
than USB 3.0. Cliff Joseph

It’s a shame about the 
USB 2.0 interface, but 
the iXpand is still a 

really useful way to save space 
on your iOS devices.

1 2 3 4
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The original Fantastical 
was a novel Mac 
add-on for quickly 
accessing a calendar 

and upcoming events from the 
menu bar. Its natural language input 
made it a must-have, not least for 
anyone who spent a lot of time 
dealing with calendar events. Now 
it’s going for Calendar’s jugular with 
a major revamp that enables you to 
ditch Apple’s app entirely.

The menu bar component 
remains from previous versions and 
can now be detached and moved 
anywhere on your screen. But the 
big news is the full-fledged calendar 
window, complete with day, week, 
month and year views.

During testing, our calendar data 
was detected and imported in a few 
minutes (you can later add further 
iCloud, Google, Yahoo, Fruux and 
CalDAV information). The main 
window mostly echoes that of 
Apple’s Calendar, although there are 
differences in the details. For 
example, Fantastical’s event text is 
more readable, but the design as a 
whole feels less refined; its week 
view in particular deals poorly with 
calendars that have more than two 
items scheduled at the same time, 
the resulting in items being illegible.

Where Fantastical wins out is with 
the day ticker that’s permanently 

positioned on the left of the main 
window. This displays a mini 
calendar with coloured dots 
representing each day’s events; 
beneath this is a scrollable events 
list. The ticker and main view pane 
are linked – select an event on one 
and the other updates accordingly. 
The resulting interface is more 
complex than Apple’s, but richer and 

more useful; it’s a boon to always 
have a visible list of events at a 
glance, regardless of the chosen 
calendar view elsewhere. The app 
loves its animations though – if you 
have issues with speedy transitions, 
there’s no ‘reduce motion’ option.

When it comes to adding new 
events, Fantastical’s natural language 
input remains impressive and is well 
ahead of Calendar’s input smarts. For 
example, type ‘Breakfast next Friday 
at 9am for two hours’ and Fantastical 
builds the event in real time, 
correctly placing it in your schedule; 
Calendar gets confused and dumps 
a one-hour event a week early. 

Updates to calendars also prove 
reliable, although Fantastical lacks 
push updates – at most, it refreshes 
calendars every five minutes (unless 
you do so manually).

Given the clunkiness of Apple’s 
Reminders app, the integration of 
Reminders into Fantastical is a 
missed opportunity. They’re 
essentially spat out as one big list, 
which can be unhelpful. The 
problem can be mitigated 
somewhat by creating calendar sets, 
which display specific calendars and 
reminder lists activated via a 
keyboard shortcut or your location. 
These are great for anyone juggling 
multiple calendars, and preferable to 
continually clicking checkboxes to 
turn calendars on and off. 
Craig Grannell

When it comes to adding new events, 
Fantastical’s natural language input is 
thoroughly impressive

Fantastical 2
The highly regarded calendar 
grows up into a full Mac app

HHHHH
£39.99 Developer Flexibits, flexibits.com

Requires OS X 10.10, iCloud or other supported calendars

The day ticker in combination with traditional calendar views is a boon for efficiency.

The menu bar component 
is handy for rapidly 
accessing the day’s events, 
including location maps.

A capable, usable 
and smartly 
conceived Calendar 

alternative with the odd 
rough edge.

  Excellent day ticker

  Natural language input

  Menu bar app still very useful

  Iffy Reminders integration

The ability to 
switch between 
sets of calendars 

simply using your 
location makes this app 
worth the expense. 
That’s the sort of 
convenience I would 
have expected from 
Apple, given its similar 
effort in Reminders.

Team Talk
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Noiseless
Stop that noise! Noiseless smooths 
out your grainy photos

Image noise reduction 
can be an extremely 
time-consuming and 
complex business, and 

Noiseless aims to take a simpler 
approach. It offers a selection of 
preset noise reduction settings from 
‘Lightest’ to ‘Extreme’, and you can 
adjust the strength of the effect 
using the ‘Amount’ slider on the 
preset button.

You can also add presets to the 
app’s Favorites panel or create your 
own custom settings, but 
unfortunately there’s no way to 
apply selective noise adjustments to 
specific areas of the image – though 
you can adjust the strength 
separately for Highlights, Midtones, 
Shadows and Details.

We ran some quick tests with 
Noiseless against Lightroom’s inbuilt 
noise reduction tools, DxO Optics 
Pro’s default noise reduction process 
and Dfine 2 (from the Google Nik 
Collection). All three yielded great 
results but the outcomes were 
virtually indistinguishable, so in the 
end it more or less comes down to 
user preference.

Noiseless is perfect for users who 
want to take away image noise 

HHHHH
£17.99 (Standard), £49.99 (Pro) Developer Macphun, macphun.com

Requires OS X 10.8 or higher

without getting sucked into a vortex 
of sliders and checkboxes. It can 
produce quite remarkable 
transformations on images where 
noise is the only issue and the 
underlying detail is good – but it 
can’t fix the generally lower 
definition you get at slow shutter 
speeds and high ISOs.

Still, the ease of use and simplicity 
are where Noiseless really shines. As 
with any noise reduction tool, you 
have to tread a tightrope between 
noise reduction and detail 
preservation, but here it’s as simple 
as clicking a preset, dragging a slider 
and checking the before-and-after 
preview for changes.

Upgrade to Pro and you can use 
Noiseless as a standalone app or as a 
plug-in for Photoshop, Elements, 
Lightroom and Aperture. It also 
boasts extra features and advanced 
controls for further adjustments.  
Rod Lawton

Drag the ‘wipe’ bar left and right to instantly see the before and after results.

It’s no magic bullet, but 
Noiseless offers quick 
and effective photo 

improvements with little effort 
or know-how.

Instantshot!
Having screen capture problems? 

Paul loves this underrated gem

You’d think taking the perfect 
screengrab would be relatively easy, 
but despite OS X’s built-in tools and a 
wide range of third-party screen 
capture apps promising all kinds of 
bells and whistles, only one floats my 

boat – and it’s completely free to boot!
InstantShot! is responsible for all the screengrabs I 

use in MacFormat. It gives me complete control over 
what gets grabbed: entire screens, selected regions or 
all (or part) of an application window. Crucially for 
me, it allows me to include the mouse cursor in my 
shots – great for working with tutorials – which is 
often a feature missing from other apps.

The app is also infinitely customisable, allowing 
you to delay shots with a timer or shoot multiple 
snaps automatically at set intervals. You can resize 
grabs once taken and automatically save them to a 
specified folder using a pre-defined naming 
convention too. It makes screen capture simple and 
performs admirably. 

InstantShot! has always done what I’ve asked of it, 
and while it’s no longer actively developed, there are 
occasional updates to squash bugs and ensure it 
remains compatible with the latest versions of OS X. 
If you’re still hunting for a versatile – yet amazingly 
free – app for grabbing your desktop, I can’t 
recommend InstantShot! highly enough.
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Hype 3

Napkin

HHHHH
£39.99 (Standard), $99.99 (Pro; about £67) Developer Tumult, tumult.com

Requires OS X 10.8 or higher, 64-bit processor

HHHHH
£29.99 Developer Aged & Distilled, aged-and-distilled.com

Requires OS X 10.9 or higher, 64-bit processor

Tumult’s Hype 3 is an 
HTML5 design 
and authoring tool 
with an emphasis on 

animation and interaction. With 
timeline features similar to early 
versions of Adobe Flash, it can be 
used for eCards, presentations, 
website creation, iBooks content and 
even simple mobile apps. Hype 3 
Standard is a free upgrade for 
previous owners of Hype.

Hype makes animation easy – slap 
an element on stage, whether it’s an 
image, a shape or some text, then hit 
the big red record button. Move the 

playhead along and animate the 
object by moving it, manipulating it 
and changing its opacity or colour. 
Hype does the gruntwork for 
you, filling in the gaps. Everything 
you create in Hype uses HTML5 
functions, so you can view the 
output in a web browser with no 
plug-in required.

You can upgrade Hype 3 Standard 
to Pro, but most of the extra features 
are pretty fundamental and the kind 
of thing you’d expect as standard. 
When features as basic as layout 
grids are Pro only, it does feel like 
rationing for the sake of it.

Fortunately, not all of Hype Pro’s 
unique features are so mundane; it’s 
worth the extra just for gravity-based 
animation. You can add gravity to 
any element, making it responsive 
to device tilt and orientation, no 
keyframing required – with collision 
detection built-in too. Karl Hodge

Armed with an elegant 
set of markup tools, 
Napkin allows anyone 
to convey ideas or 

explain concepts in a more 
ambitious way than words alone.

For starters, you can draw lines or 
shapes with a mouse and Napkin 
will convert those scribbles into 
clean, vector-based arrows, text 
boxes or callouts. These can be 
embellished by importing images 
from your Mac or using the built-in 
screenshot feature to grab some or 
all of the display.

You can crop, pixelate or blur 

imported images in the app itself, 
while sharing your final creation is 
also easy thanks to the Share menu 
and the ability to drag and drop 
JPEG or PNG versions between apps.

Napkin makes short work of 
creating callouts. Draw around the 
area you want to draw the viewer’s 
attention to, click to lock it, then drag 
it into position. Arrows drawn 
between objects retain links when 
one is moved, and smart guides 
make it easy to reposition elements.

The app is priced at £29.99 and 
you can’t try before you buy. The 
cost of admission feels exorbitant 

compared to free markup apps like 
Skitch – that is, until you spend time 
with Napkin and realise what an 
effortless timesaver it really is.

However, there’s no way to import 
PDF files, and keyboard jockeys will 
lament the lack of shortcuts while 
taking screenshots. J.R. Bookwalter

Hype 3 Pro has a new dark interface and 
supports multiple scene sizes all within 
one document.

Napkin has a range of tools to get your 
message across with the minimum 
amount of effort.

A powerful HTML5 animation 
tool with pro features

Take ideas from your brain to the 
page with consummate ease

Some Pro-exclusive 
features should be 
standard, but it 

makes up for the oversight 
with real physics.

  Bargain price for Standard

  Great physics tools in Pro

  Clunky editable interface

  Underwhelming Pro features

Don’t let the price 
fool you: Napkin is 
our new go-to 

markup app and well worth 
the investment.

  Fast, simple image markup

  Plenty of useful features

  Expensive; no trial version

  Lacks PDF import
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Core Animator is an 
application designed 
to simplify the process 
of integrating 

animations into iOS and Mac apps. 
Apple has created a number of 
frameworks that developers can use 
to add functionality to their apps, 
among them Core Audio, Core Video 
and, in this case, Core Animation. 
These provide standardised tools to 
make app development easier, 
though it still requires some skill. 

Since animators aren’t necessarily 
coders and vice versa, this app 
provides an approachable set of 
tools for building animations, then 
translates them into complex 
Objective-C or Swift code that can 
be imported directly into Xcode for 
an app. Adobe’s Flash and Edge 
Animate are able to export 
animations to other formats, but 
they’re much more focused on 
HTML5 and browsers. 

Blank canvas
Starting with a blank canvas, you 
import your graphical assets, which 
need to have been created 
beforehand. You then arrange and 
layer them and set their properties, 
with different parts of objects made 

up of separate items. If a character 
has to run, for example, they’ll need 
feet, legs, a head and so on. The 
control section on the right lets you 
translate, scale and rotate an object 
and change its opacity, and a 
timeline lets you manage how 
quickly changes happen. Keyframes 
are added to record changes in 
movement, scaling and so on, and 

you can choose different kinds of 
‘easing’. Rather than a uniform 
movement, you might want to have 
an object speed up or slow down as 
it moves, for a more natural effect. 

The process of keyframing is very 
easy to get to grips with and you 
can set up loops and move and edit 
keyframes easily. It’s similar to 
keyframing in Flash or After Effects, 
but with fewer parameters to deal 
with it’s somewhat simpler. The 
technique of animation is of course 
a skill in itself, so to create more 
complex stuff you’ll need a bit of 

creative flair. At the simpler end, 
even beginners can make basic 
animated graphics like rubbish bins 
emptying or progress wheels. 

Once your animation is complete 
you can export it easily to 
Objective-C or Swift code, where 
it’s output as a code file and a folder 
of source images. This can be 
imported into Xcode, though coding 
entire apps is a quite different 
process to building animations. 

The beauty of Core Animator is 
it lets animators create great-looking 
sequences they can then give to 
the people building the apps, and 
also lets coders with perhaps less 
knowledge of animation build their 
own sequences. 

If you plan on using animation 
in your apps, this is an elegant and 
efficient way to do it. Hollin Jones

It’s similar to keyframing in Flash or After 
Effects, but with fewer parameters to 
deal with it’s somewhat simpler

Core Animator
Create beautiful animations 
without being an expert
HHHHH
£79.99 Developer Polished Play, coreanimator.com

Requires OS X 10.10 or higher, 64-bit processor, Xcode

Choose different types of easing to create more natural looking animations.

Import graphical 
elements and use 
keyframes to 
animate them, 
then export to 
native code.

A powerful, effective 
way to incorporate 
animated elements 

into apps with minimal fuss.

  Straightforward animation tools

 Helps animators and coders

  Export for Mac and iOS apps

  No presets or library of content

I do like to 
tinker with apps 
from time to 

time but I’ve never had 
the courage to dabble in 
animation – it’s always 
seemed too intimidating 
to me. But learning 
about Core Animator 
has persuaded me to 
give it a shot.

Team Talk
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Make sure you keep the receipt  
for this app somewhere safe

The maker of 
BusyCal is back, 
this time with its 
souped-up take 

on OS X’s lacklustre Contacts 
app. BusyContacts cleverly 
takes Contacts as its starting 
point, then adds the features 
you’ve been crying out for.  
For starters, it employs a similar 
multi-paned window, but adds 
a new Activity pane to provide 
a handy summary of your 
interaction with the selected 
contact, from your goings-on in 
BusyCal to conversations in Mail 
and Messages, as well as their 
Facebook and Twitter activity.

BusyContacts also allows you 
to tag and apply smart filters to 

contacts to help sort your list  
in different ways, and provides 
tools to quickly combine 
people’s different entries across 
multiple accounts, too.

There are gripes: we’re not 
happy that you can only link to 
the BusyCal calendar, and the 
asking price is too high for 
what’s basically a glorified 
contacts manager. A shame, 
because it’s definitely a step up 
from Apple’s tool. Nick Peers

Effective time 
management is 
ActionAlly’s aim, 
helping you plan 

and execute tasks. At a set time 
each day, it’ll prompt you to 
plan what you’re doing the 
following day, including how 
and why tasks should be done. 
When the time comes, you fire 
up work sessions to define how 
long you’ll focus on a given 
task, and you can block a user-
defined list of ‘distracting’ 
websites (although this didn’t 
seem to work during testing).

The interface is a floating 
window that covers the screen. 
Setting up tasks is easy enough, 
although it has a lack of 

keyboard-only control, which 
doesn’t feel efficient. The 
workflow model is at least 
interesting, and you get handy 
emails during your initial time 
with the app to help you make 
the most of everything. 

The seven-day free trial will 
let you see if it works for you, 
but we soon found ourselves 
returning to simpler Calendar 
lists and Breaktime sessions. 
Craig Grannell

In theory, Expense 
Manager has the 
makings of great 
financial software: 

multiple user support, password 
protection, attractive graphs and pie 
charts, auto backup and iCloud sync.

The problem is, the user interface 
seems to have been an afterthought 
and gets in the way at nearly every 
turn. Non-standard buttons make it 
hard to know what they do until 
clicked. For example, the right-hand 
Tag icon doesn’t tag anything, and 
instead displays options to filter 
graph and bar chart data.

More annoyingly, you can’t use all 
the adjacent space next to that 
button to grab and move the 
window, as with other Mac apps, 
even though this method works on 
the left-hand side above the search 
field. The layout appears to have 
been awkwardly ported from iOS, 
where these decisions make more 
sense. The lack of a Help menu or 
user manual adds to the confusion.

Expense Manager can also attach 
receipts to entries, but only from 
existing files on the Mac. The inability 
to use a built-in FaceTime camera to 

HHHHH
£7.99 Developer iLifeTouch, iLifeTouch.com

Requires OS X 10.7 or higher

BusyContaCts

aCtionally

HHHHH
£39.99 Developer BusyMac, busymac.com

Requires OS X 10.9 or higher, iCloud or other contacts service

HHHHH
$37 (about £25) Developer Nicky Hajal, actionally.com

Requires OS X 10.8 or higher

Let’s action that!

A powerful Contacts alternative

An interesting  
take on task 
management,  

which offers value – if it  
clicks with you.

Powerful, elegant 
and easy to use, 
BusyContacts’  

only real blemish is its  
high price tag. 

grab a snapshot is a lost opportunity. 
There’s no scanner support either.

Data export is also hit and miss: 
Expense Manager offers a range of 
print, CSV, text and PDF output 
choices, but with no option to see 
individual entries alongside their 
visual equivalent – PDF and printed 
data winds up being little more than 
a low-res screenshot of the app itself.

Expense Manager also commits 
the cardinal sin of pimping another 
app every time it launches – the 
more expensive Daily Expenses. This 
alone will have you regretting the 
decision to spend £7.99 in the first 
place. J.R. Bookwalter

Expense Manager offers a lot of visual flourish – largely untouched from the iOS version.

Blatant adware aside,  
it has the potential to 
be a handy finance 

app, if the questionable UI and 
usability issues are addressed.

   Wide range of features

  Cumbersome user interface

   Subpar print and PDF export options

  No Help menu or user manual

Expense Manager
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1    EverWeb 1.7
£53.93 everwebapp.com

2    Flux V
$109 (£74) theescapers.com

3    Freeway 7 Pro 
£120 softpress.com

Web building Mac apps
iWeb is long gone, but its spirit 
lives on in these six user-friendly 
web publishing programs

Apple’s iWeb was a decent little 
program that made designing 

websites super simple. It didn’t do 
much, but then it wasn’t supposed to. 
It was about making website building 
as easy as Pages or Keynote by 
removing all the pain from designing a 
website. Unfortunately, Apple never 
seemed too keen on iWeb, and when 
development officially stopped in 2011 
iWeb users were sad but not surprised. 

One of the reasons for iWeb’s demise 
was that more and more people were 
publishing using web-based platforms: 
Google’s Blogger, WordPress, Tumblr, 
social networks such as Facebook and 
so on. They all have their place, but 

dedicated desktop web publishing 
software has advantages that they 
don’t. You have more control, you get 
much faster performance, you can 
often do a great deal more with your 
design and content, and you can get 
stuff done even when you can’t get an 
internet connection. And as we’ll 
discover here, they often deliver a 
much nicer experience, too.

Apple might not want to make web 
publishing software any more, but 

many firms are happy to carry the torch 
– and in many cases in ways that are 
very Apple-y. The programs here are 
very different from one another, but all 
promise to do much the same thing: 
give you the tools to get what’s in your 
head onto the internet. Whether your 
site is personal or political, for a club or 
a company, at least one of the apps 
here should deliver the perfect 
combination of style and substance for 
your particular project.

We’ve explored six apps here: RAGE 
Software’s EverWeb, The Escapers’ Flux 
V, Softpress’s FreeWay Pro, Realmac’s 
RapidWeaver, Karelia’s Sandvox and 
Intuisphere’s WebAcappella. We weren’t 
just looking at ease of use (though 
that’s important), we also wanted to 
see if they offered the kinds of 
advanced features and customisation 
iWeb didn’t. Let’s put them through 
their paces. Gary Marshall

Web design apps 
give you more 
control, faster 
performance and 
often deliver a nicer 
experience too

1 3

2
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4    RapidWeaver 6
£69.99 realmacsoftware.com

5    Sandvox 2
$79.99 (£57) karelia.com

6    WebAcappella 4
€79 (£57) webacappella.com

web publishing programs | AT A GLAncE

EverWeb 1.7 Flux V Freeway 7 Pro RapidWeaver 6 Sandvox 2 WebAcappella 4

Developer RAGE Software The Escapers Softpress Realmac Software Karelia Software Intuisphere

Website everwebapp.com theescapers.com softpress.com realmacsoftware.
com

karelia.com webacappella.com

Price £53.93 $109 (£74) £120 £69.99 $79.99 (£57) €79 (£57)

Web hosting From £66.84 pa 
(2GB)

n/A n/A n/A From $99 (£67) pa 
(5GB)

n/A

Publish via FTP, SFTP FTP, SFTP, remote 
editing

FTP, FTPS, SFTP FTP, FTPS, SFTP FTP, SFTP, WebDAV FTP, FTPS, SFTP

Add-ons Widgets* n/A Template 
bundles*

1,000+ themes 
and plugins*

Plugins (not 
available in App 

Store version)

E-commerce 
package*

OS X OS X 10.6 or 
higher

OS X 10.9 or 
higher

OS X 10.6 or 
higher

OS X 10.9 or 
higher

OS X 10.10 
(Sandvox 2.9) OS X 
10.6 (Sandvox 2.5)

OS X 10.5 or 
higher

4

5

6

* 
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We approached all of these apps with the same 
scenario: we wanted to make our own website, 
we wanted it to look good even if we had no 
design smarts of our own, and we wanted to 
get it done with the minimum of fuss and 
without having to consult a basic web design 
manual. That meant using the apps’ supplied 
templates for our designs but bringing in our 
own images and text, editing things to get 
them just-so and then publishing them to our 
own web space. 

The thing about web design is that like 
many creative endeavours, the more you do 

the more you want to do. To reflect that we 
looked at the programs’ abilities to handle 
more ambitious projects, and how much 
tinkering they were willing to let you do. Could 
you download additional features or add your 
own code? How easy was it to add crucial 
elements such as search engine metadata (data 
that describes your pages for the likes of 
Google) or third party content?

More than anything, we concentrated on 
user friendliness. iWeb was intended to take 
the pain out of publishing online, and its true 
spiritual successor(s) need to do that too.

iWeb tried to bring classic Mac 
simplicity to web design and 

many of the apps here do exactly 
the same – in many cases by 
working very much like iWeb did. 

EverWeb, RapidWeaver and 
Sandvox all include tutorials in their 
opening offers and have friendly, 
iWork-esque interfaces, and Sandvox 
can even import your existing iWeb 
website. If you’re coming to any of 
these apps from iWeb, or if you 
haven’t used a web design program 
before, all three will make you feel 
perfectly welcome.

Freeway Pro, WebAcappella and 
Flux aren’t unfriendly, but they are 
different from the other apps. 
Freeway Pro looks like a page layout 

program, while WebAcappella looks 
like part of Microsoft Office. 
Meanwhile, Flux V makes it clear that 
it’s for people who already know 
what they’re doing, populating the 
screen with stacks of information 
that’ll look like gibberish to a web 
beginner. It’s very nice and very fast 
to use, but if you don’t know your 
divs from your DOMs, Flux really isn’t 
the web building program for you.

All of the programs here use 
the familiar choose-a-template 

approach, but there are big 
differences between what’s on offer. 
EverWeb has 32 brochure-style 
templates in a range of sectors, while 
Freeway Pro has a handful of email 
and presentation templates and 
eight generic site templates.

RapidWeaver presents five themes 
at startup (52 are actually installed, 
but that’s not immediately obvious), 
WebAcappella has nine shops and 
15 kinds of business sites, Flux has 28 
startlingly pretty designs covering 
every conceivable site including 
iTunes Extras and iTunes LPs. And 
Sandvox has 64 designs that remind 
us of PowerPoint templates. 

Editing and creating pages in 
EverWeb, RapidWeaver and Sandvox 
is simple, intuitive and very iWork-y. 
Freeway and WebAcappella will be 
obvious to anybody who’s ever laid 
out a document in a DTP app or 
designed something nice in Pages, 
while Flux makes it easy to find your 
way around code and style sheets 
and to see exactly what’s going on 
in your project.

USER intERFAcE BASic FEAtURES
can beginners get going quickly? How do you actually build your website?

test one test two

test ResULts
EverWeb 1.7 HHHHH

Flux V HHHHH

Freeway 7 Pro HHHHH

RapidWeaver 6 HHHHH

Sandvox 2 HHHHH

WebAcappella 4 HHHHH

EverWeb, RapidWeaver and Sandvox are very user friendly and remind us of iWeb. All of the apps offer a range of templates, but the quality differs widely.

the more you do, the more you’ll want to do. Make sure your 
chosen app can cope with your ambitions.

how we tested | WEAVInG OUR WEB

test ResULts
EverWeb 1.7 HHHHH

Flux V HHHHH

Freeway 7 Pro HHHHH

RapidWeaver 6 HHHHH

Sandvox 2 HHHHH

WebAcappella 4 HHHHH
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We’ve covered a wide range of apps here. 
Some scored low, not because they’re bad, but 
because they aren’t iWeb replacements: 
WebAcappella is too corporate, Flux is aimed at 
a completely different market and FreeWay Pro 
is more of a design package than a simple web 
publishing package. 

That leaves us with three very similar apps: 
EverWeb, Sandvox and RapidWeaver. They’re 
all very user-friendly, but we think RapidWeaver 
has the edge. It feels more modern, is more 
expandable, can cope admirably with more 
ambitious projects and is simply a really nice 

app to spend time in. In many ways it’s the app 
iWeb should – and if Apple hadn’t dumped it, 
could – have been. And it’s the app that we’d 
buy ourselves.

One of the things that made 
iWeb so easy to use was its 

tight integration with the now-
defunct .Mac service, enabling 
instant and effortless site publishing. 
It also had FTP for uploading to your 
own web space.

In comparison, EverWeb offers 
publishing via FTP, although 
annoyingly you need to sign in with 
your (free) EverWeb account to do it 
and it nags you about copyright too. 
RapidWeaver and FreeWay Pro 
support uploading via FTP, SFTP and 
FTPS, Sandvox local publishing or 
upload via FTP, SFTP or WebDAV, and 
WebAcappella FTP, SFTP, FTPS and 
connection to MySQL databases and 
PHP mail functions. 

To preview your site, EverWeb, 
WebAcappella and FreeWay Pro call 
whichever browser you prefer – in 
the latter you can also preview your 
site inside the app and test screen 
resolutions. Flux has integrated 
preview and live preview for data-
driven content, RapidWeaver has 
integrated preview with options to 
test for iPads and iPhones. Sandvox 
has integrated preview too.

EverWeb enables you to add 
widgets such as HTML snippets, 

PayPal buttons and social media 
shares, but it’s designed for people 
with fairly simple web design 
requirements. Sandvox offers Objects 
such as Amazon lists, maps and 
video embedding, but doesn’t 
expect its customers to spend time 
tinkering with the underlying code. 
WebAcappella enables you to add 
photo albums, forms and maps, 
while FreeWay Pro can add blogger 
items, PayPal, AdSense and other 
social services. Flux lets you add 
anything, and RapidWeaver has  
more than 1,000 downloadable add-
ons, site versioning and reusable 
code snippets. 

RapidWeaver and Sandvox 
support responsive themes that 
adjust to different browser sizes or 
devices, while FreeWay Pro supports 
responsive themes and lets you 
preview your site in different 
resolutions. WebAcappella doesn’t 
take mobile into account, EverWeb 
requires creating a separate page for 
mobile and Flux is dependent on the 
code you write or copy.

PUBliShingAdVAncEd FEAtURES
You made it. But how do you publish it?can the app cope with your ambitions?

test foURtest thRee

the most user friendly apps don’t really expect their users to do much tinkering. All of the apps we tested make it easy to upload to your own web space using FtP.

the winner | RAPIDWEAVER 6

test ResULts
EverWeb 1.7 HHHHH

Flux V HHHHH

Freeway 7 Pro HHHHH

RapidWeaver 6 HHHHH

Sandvox 2 HHHHH

WebAcappella 4 HHHHH

test ResULts
EverWeb 1.7 HHHHH

Flux V HHHHH

Freeway 7 Pro HHHHH

RapidWeaver 6 HHHHH

Sandvox 2 HHHHH

WebAcappella 4 HHHHH

fInAL ResULts
EverWeb 1.7 HHHHH

Flux V HHHHH

Freeway 7 Pro HHHHH

RapidWeaver 6 HHHHH

Sandvox 2 HHHHH

WebAcappella 4 HHHHH
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The Sims 4

Oddworld: 
New ’n’ Tasty

HHHHH
£49.99, £59.99 for Digital Deluxe edition  Developer Maxis, maxis.com

Requires OS X 10.7.5 or higher, 2.4GHz CPU, 4GB RAM, see site for graphics cards

HHHHH
£14.99 Developer Oddworld Inhabitants/Just Add Water, oddworld.com

Requires OS X 10.8.5 or higher, Intel Core i3, 4GB RAM, see site for graphics cards

The Sims 4 is deceptive. 
If you’re familiar with 
the older games in 
the famous series of 

people simulators, the new one 
might feel cartoony and simplified. 

But it’s not the case. The Sims you 
make are more customisable, but 
complex sliders have been replaced 
by a new tool that lets you push and 
pull at features like putty. Building 
houses is easy too, letting you get on 
with the good stuff: playing with 
lives, jobs and relationships.

At the core of The Sims 4 is a 
complex simulation that brings the 
digital dolls that little bit closer to 
being believable characters. Events 

and personalities interact to put your 
Sims into particular moods, which 
have unique effects on their lives.

Realistically, each Sim always 
wants more than you can manage: 
life goals with stages (such as 
training a skill to a certain level), 
special events like going on a date, 
and whatever passing wants and 
fancies their current mood inspires. 

As always with new entrants in 
this series, fans will yearn for what 
they’re used to, and for features that 
have been left out. But with updates 
already adding back in some of the 
more notable omissions (such as 
swimming pools), The Sims 4 should 
be treated like its predecessors: a 

basic but solid foundation to 
which players can add whichever 
of the inevitable expansions they 
choose. The new simulation and its 
interplay between Sims’ personalities, 
moods and desires means players of 
all kinds, even those new to the 
series, will find something for them. 
Jordan Erica Webber

This is a remake of the 
first Oddworld game 
from 1997. Not so new, 
then, though it has 

been given a graphical overhaul and 
gameplay tweaks. Leaping between 
its platforms and overcoming 
obstacles remains satisfying.

You play Abe, a worker in a food 
processing plant. With his employer’s 
fortunes floundering, Abe overhears 
plans for a new product – moreish 
morsels made from his species. So 
he sets out to escape with as many 
of his fellows as he can save.

When confronted with sleeping 
guards, Abe and his followers can 
sneak past. Those on patrol require 
manipulation by flicking coins to lure 
them and bringing machinery to life 
at the right moment. When you spot 
birds flying in a circle, that’s your cue 
to tell Abe to chant, which opens a 
portal at that position for his 
followers to escape their grisly fate.

Options for solving problems are 
limited, but that doesn’t equate to 
a lack of challenge. Abe will suffer 
plenty as you try to work out 
solutions, so areas are broken down 

with checkpoints. You’ll find yourself 
retracing your steps through many 
challenges only to fail repeatedly 
at the same spot. To alleviate the 
frustration, you can fall back on the 
quick save option, which preserves 
things on the spot, but it’s best used 
sparingly so that the experience isn’t 
diluted. Alan Stonebridge

Chat, date, launch a rocket… The Sims 4 is 
the latest in the person-simulating series.

Abe’s world is full of brutal delights like 
getting rid of the floor under this guard.

An emotionally mature people sim

Abe’s odyssey is tough but satisying

Cleverly hides the 
complexity from 
previous versions of 

the game, but has a better 
simulation at its core.

  Newly complex simulation 

 Shortcut building options

 Sims’ moods affect gameplay

  Now has loading screens

New ‘n’ Tasty is the 
type of game that’s 
fun even when it’s 

grinding you down, which 
it most certainly will.

  Excellent puzzles

  Looks great and full of character

  Well structured for snacking!

  Puzzles sometimes infuriate
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HHHHH 
£9.99 Developer BulkyPix, lonewolfthegame.com

Works with iPhone, iPod touch, iPad, iOS 6 or later

Joe Dever’s Lone 
Wolf Complete

iPads are great for 
reading, whether 
catching up on news 
on your commute or a 

lazy Sunday morning with a book 
and a cup of coffee. So it’s fitting that 
Joe Dever’s Lone Wolf Complete, a 
new video game adaptation of the 
long-running adventure game series, 
is all about reading.

Lone Wolf falls somewhere 
between the interactive fiction of 
Device 6 and a traditional RPG. After 
reading through the story, you must 
choose your own adventure like the 
books of old, relying on 
predetermined skills such as 
camouflage, animal mind melds or 
good old-fashioned face punching. 
Your choices genuinely affect the 
course of the story – companions 
that join your party, available actions 
in future encounters – and the game 
forces you to commit to that course. 
The plot is the usual hokey fantasy 
nonsense, but a sense of urgency 
keeps it compelling.

No matter what your choices, 
you’ll eventually get into a scrap. 
Lone Wolf’s battles aren’t far off Final 
Fantasy’s Active Time Battle: a careful 
balancing of stat bars through 
efficient use of weapons and 
techniques. Every attack has a 
cooldown period, including 
blocking, and you must learn to 
control enemy hordes with stuns 
and magic attacks. Tactical decisions 
don’t end when the fight is won: 
meditating to heal is another 
gamble that can lead to an ambush.

Look past the clichés and the 
clunky user interface and Lone Wolf 
will engross you in its world more 
than RPGs with 10 times the budget. 
It’s a smart and surprising take on 
the genre. Alan Williamson

The classic adventure gamebooks 
of old return to the iPad with style

A fond return to vintage 
gamebook questing, 
Lone Wolf Complete 

is an impressive piece of fantasy 
fun given new life on iOS.

Aerena is 
steampunk 
speed chess 
with bells and 

whistles on. But also a rich 
take on turn-based tactics. 

Matches take place in small 
arenas, pitting your team of 
three units against other 
players (or AI in practice and 
survival modes). The aim is to 
take out your foe’s ship, either 
by attacking it directly or 
defeating enemy units.  

It sounds simple, but there’s 
lots of variation. Aerena’s 16 
units are appreciably distinct, 
especially in their special 
moves. The hammer wielding 
dwarf may seem slow and 

sturdy, but wait until he jets 
off to deal huge kamikaze 
damage. Those game-
changing moves are tied to 
‘aether’ – energy you gain 
both by attacking and being 
attacked. It’s a clever 
mechanic, ensuring matches 
feel unpredictable yet fair. 

The developer has wisely 
tied in-app purchases to 
cosmetic skins only and 
removed ads. Sinan Kubba

AerenA: MAsters edition

HHHHH
£3.99 Developer Cliffhanger Productions,  
cliffhanger-productions.com

Works with iPhone, iPad, iOS 7 or later

Are you ready for love?

It may be fast-
paced, but 
Aerena and its 

turn-based tactics offer 
plenty of long-term value.

Buy low, sell 
high, gain 
revenge on your 
family’s enemies 

as time permits. Merchants of 
Kaidan is part trading, part 
roleplaying, but mostly a 
complicated game that 
throws every idea it can think 
of into the pot only to still 
end up feeling shallow.

Dungeon delving. Knife 
games. Exploration. It’s as if it 
realises that the basic trading 
isn’t desperately exciting, even 
though that’s absolutely its 
core. Simply figuring out the 
mysterious economy takes 

many false starts, and it 
always feels like the rest of the 
world is having a much better 
time in this beautiful world.

With more dramatic 
decisions, à la King of Dragon 
Pass, it could have worked. As 
it is, it’s fine if trading is your 
passion, but making a fortune 
feels more a job than a 
fantasy. Richard Cobbett 

MerchAnts of KAidAn

HHHHH
£4.49 Developer Forever Entertainment SA,  
games.forever-entertainment.com

Works with iPhone, iPod touch, iPad, iOS 6.0 or later

A get-rich-quick scheme?

An ambitious 
game that tries 
too much, ending 

up complex without ever 
really being satisfying.

The story unfolds through animated drawings as well as text.
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It seems like astronomy apps are about as common as 
stars in our galaxy. Yet Sky Guide is the one I keep 
coming back to over the likes of Star Walk and 
Luminos. For me, it’s got just the right blend of 
armchair astronomer and genuine techie field use. 
First off, the visuals are jaw-droppingly good and if 

you’re fussy about visualisations for the constellations (and I’m 
seriously picky), then Sky Guide is clearly the benchmark. 

The usual scroll-around-and-zoom-around approach is once again 
employed here, as you’d expect, and it’s not delivered that much better 
than other top astronomy apps until you use two fingers to swipe up 
and change the sky brightness. This stunning HDR feature brings to 
life the depth and colour of the night sky and the tiny twinkling of the 
stars in view (and accurate colouring) is exquisite. 

The features don’t end there either. You can even listen to the stars, 
and I’m not talking about the dreamy background music. Hotter stars 
have higher pitches and larger stars have louder volumes. It’s a subtle 
addition to the sky map, but adds to your astronimcal knowledge – 
check out the multi-twinkled tune of the Pleiades!

Then there’s the brilliant time controls which speed you through 
time to see the heavens move years into the future in just a few 
seconds. Tap near the bottom of the screen to bring up the playback 
controls. Finally, there’s the Filter, a kind of magnifying glass device 
that appears if you tap and hold an object (star, planet, nebula etc). It 
doesn’t zoom though, rather it allows you to rotate through various 
wavelengths of light to get an entirely different view of the galaxy.

Sky Guide
Christian’s no Galileo, but casting his eyes 

to the heavens is much better with iOS
Alfred Remote  
is beautifully 
made but feels 
like a solution 

searching for a problem. It 
resembles a remote for OS X 
productivity tool Alfred, but 
it’s more of a companion. 

Essentially, you use the  
Mac app to create pages  
of actions, grouped into 
collections, and these can 
then be triggered by tapping 
the relevant icon on your iOS 
device, which is effortlessly 
paired via Wi-Fi.

With the free version of 
Alfred, you’re restricted to 
apps, system commands, files, 
folders and bookmarks. With 

the Powerpack installed, you 
can trigger iTunes commands, 
clipboard snippets, scripts  
and workflows. 

It’s here the app has 
potential, not least if you 
often forget action keywords. 
Even so, we’d like Alfred 
Remote more if it also rolled 
in keyboard/mouse/prompts 
support as well as fully 
remote (off-network) access. 
Craig Grannell

This learning 
app for kids 
starts out with 
the letter A. Tap 

it and it goes all 3D while a 
voice says ‘A’. Tap it again and 
it sprouts antlers, which can 
be bounced with a drag. 
Another tap and ‘A’ becomes 
an arch that begins to amble.

This sort of thing happens 
all the way to Z, the app 
revelling in bizarre forms and 
animations that frequently 
look like a modern take on 
things that have erupted from 
Terry Gilliam’s brain.

Occasionally it wobbles. 
The app’s a touch stiff, very 

definitely American (here, 
‘vase’ rhymes with ‘maze’ and 
not ‘cars’, and the alphabet 
ends on ‘zee’), and fumbles 
depicting the odd concept, 
such as ‘yesterday’. 

However, you can’t  
help but grin when the 
aforementioned vase turns 
into a vacuum you can use  
to suck up a tiny village! 
Craig Grannell

Alfred remote

metAmorphAbet

HHHHH
£3.99 Developer Running With Crayons, alfredapp.com

Works with iPhone, iPod touch, iPad Version 1.0

HHHHH
£2.99 Developer Vectorpark,  
metamorphabet.com 

Works with iPhone, iPod touch, iPad 
Version 1.01

Full of strange characters

Control Alfred from afar

An imaginative, 
interactive, 
playful alphabet 

app for all ages that’s well 
suited to iPad.

Feels a bit 
superfluous,  
but there’s 

potential here, especially 
for Alfred power users.
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Is Wacom looking over 
its shoulder asking who 
the new kid right on its 
heels is? Or is the race 

over before it has begun? Astropad 
offers the ability to use your iPad as a 
graphics tablet, so we wanted to 
know if it’s as good as it sounds.

Before starting, you must ensure 
you have up-to-date operating 
systems on both devices. The next 
important thing to do is ensure your 
stylus is calibrated with the software. 

You do this via a rather nifty box that 
prompts you to touch your stylus 
against the iPad. As you do so, you 
are told the sync is successful. 

There is a fair bit of tweaking 
required by specifying which area of 
your Mac screen your iPad would 
use, and we also had to move 
around a few toolbars to ensure they 
fitted into the workspace.

After playing with Astropad for a 
while, we were struck by one 
recurring issue: a worrying lack of 

accuracy. On a number of occasions 
we tried to locate the brush 
selection palette and were met with 
a red cross telling us Astropad 
couldn’t do what we were asking of 
it. Another issue was the latency on 
the iPad – often newly-selected 
areas appeared pixelated and 
difficult to see clearly – a rather 
important factor when you consider 
what the software’s purpose is.

That said, it does have many 
endearing features, most importantly 
the portability factor. It’s very easy to 
forget you are using your iPad as a 
graphics tablet and, being gadget 
lovers, we were really taken with 
that. James Robinson

New Wacom rival or bargain basement gimmick?

HHHHH
£18.99 Developer Astropad, astropad.com

Works with iPad Version 1.1

Astropad has a simple pairing setup for 
many of the leading stylus manufacturers.

You know, I’ve 
long fancied 
having a bit of a 

digital doodle – but not 
enough to splash out on 
a Wacom tablet. It’s not 
the polished product 
yet, but for less than 
£20, Astropad sounds 
like a really appealing 
option to me.

Team Talk

A useful piece of 
software with some 
slightly glitchy 

aspects – but it’s an 
affordable option.

  Comparatively cheap price

  Straightforward to set up

  Most up-to-date OS needed

  Some irritating glitches
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The brand-new 
MacBook comes 
in the same three 
colours as the 
iPhone and iPad

The Days Since Refresh box shows you when an Apple product was last updated at the time we 
went to press, and whether it’s safe to buy now or wait. Please remember this advice is just our 
best guess – Apple can update any product line at any time.

MacBook
The newest member of the Mac 
family sports a 12-inch Retina 
display with a pixel density of 

226ppi – almost identical to the 
MacBook Pro. It’s available in the same 
silver colour as other MacBooks, as well 
as Gold and Space Grey variants. 

Only this and the 13-inch MacBook 
Pro feature a Force Touch trackpad, 
which detects and responds differently 
to levels of pressure. The backlit keys are 
larger than on other Macs, and run 
almost from edge to edge.

The MacBook is powered by Intel’s 
new Core M processors (up to 1.3GHz), 
which are designed to stay cool without 

needing a fan, making this the quietest portable Mac. All models 
come with 8GB of RAM – double the amount that’s standard on 
the MacBook Air – and fast flash storage that starts at a comfortable 
capacity of 256GB, rising to 512GB in the more expensive version.

Days since  
refresh

UPDaTe LiKeLy?

New model

BUy or waiT?

Buy now

52

R

R

R  = Retina display

Your guide to buying a Mac, iPad, iPhone and Watch

Rather than give 
the MacBook Air 
a Retina display, 
Apple has opted 

to add a third strand to its 
line-up of portable Macs. 
The rather plainly-named 
MacBook is so small that 
you can lie one on top of an 
issue of MacFormat without 
covering up the magazine. 
Its Retina display is a big 
step up from the MacBook 
Air in colour saturation as 
well as sharpness. However, 
even the most affordable 
model has a four-figure 
price tag attached.

The Apple kit we’re most excited about

slim 
pickings 
Controversially, there’s just 
one USB-C port on the 
MacBook, and you’ll need 
an adaptor or hub to 
connect older devices to it.

Model Key specifications Price

1.1GHz  
dual-core 
Intel Core M

Solid State Drive: 256GB
RAM: 8GB 1600MHz LPDDR3
Graphics: Intel HD Graphics 5300

£1049

1.2GHz 
dual-core  
Intel Core M

Solid State Drive: 512GB
RAM: 8GB 1600MHz LPDDR3
Graphics: Intel HD Graphics 5300

£1299

choose a macBooK
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choose a macbook pro

Model Key Specifications Price

13” 2.5GHz 
dual-core i5

Graphics: Intel HD Graphics 4000 
Hard drive: 500GB RAM: 4GB

£899

13” 2.7GHz 
dual-core i5

Graphics: Intel Iris 6100 Graphics 
Solid State Drive: 128GB RAM: 8GB

£999

13” 2.7GHz 
dual-core i5

Graphics: Intel Iris 6100 Graphics 
Solid State Drive: 256GB RAM: 8GB

£1,199

13” 2.9GHz 
dual-core i5

Graphics: Intel Iris 6100 Graphics 
Solid State Drive: 512GB RAM: 8GB

£1,399

15” 2.2GHz 
quad-core i7

Graphics: Intel Iris Pro Graphics 
Solid State Drive: 256GB RAM: 16GB

£1,599

15” 2.5GHz 
quad-core i7

Graphics: GeForce GT 750M
Solid State Drive: 512GB RAM: 16GB

£1,999

R

R

R

R

R

MacBook Pro
Apple recently updated the 13-inch 
Retina MacBook Pro with small 

improvements to its processors and a 
brand-new Force Touch trackpad. 
However, the 15-inch MacBook Pro 
hasn’t seen an update since summer 
2014. summer, so anticipate that  
happening in the next few months.

 Since October 2013, all but one 
model of MacBook Pro has offered 
a Retina display, Thunderbolt 2, SSDs 
and a lightweight chassis, though the 
£899 non-Retina model persists. Power 
savings afforded by the latest Intel 
Core i5 and Core i7 processors give 

the Retina MacBook Pros a long battery life. The 13-inch model 
now lasts for 10 hours, and the 15-inch notebooks for eight hours.

Days since  
refresh

UPDaTe LiKeLy?

Recently updated

BUy or waiT?

Buy now

275

R  = Retina display

MacBook Air

UPDaTe LiKeLy?

BUy or waiT?

Days since  
refresh

Recently updated

Buy now

The 2015 MacBook Air refresh is a 
mere speed bump, yet even with 

the announcement of a new, lighter 
MacBook, the Air remains Apple’s most 
affordable portable Mac.

The MacBook Air uses Broadwell 
processors, which are designed to 
use very little power. The 2015 range’s 
updated graphics chipset is a small 
amount faster than its predecessor, and 
its flash storage can reach speeds in 
excess of 1,000 megabytes per second, 
which is in the same league as the 
Mac Pro. The MacBook Air is equipped 
with 802.11ac Wi-Fi, which is up to 

three times quicker than 802.11n, although you’ll need a 
compatible router to get that speed. Battery life is awesome, with 
the 13-inch models lasting up to 12 hours, and the 11-inch Airs 
running for up to nine hours on a single charge. 

52

Model Key specifications Price

11” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 128GB

£749

11” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 256GB

£899

13” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 128GB

£849

13” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 256GB

£999

choose a macbook aIR
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choose an iMac

Model Key specifications Price

21.5” 1.4GHz 
dual-core  
Intel Core i5

Hard drive: 500GB (5400rpm)
Graphics: Intel HD Graphics 5000
Graphics memory: Shared

£899

21.5” 2.7GHz 
quad-core  
Intel Core i5

Hard drive: 1TB (5400rpm)
Graphics: Intel Iris Pro
Graphics memory: Shared

£1,049

21.5” 2.9GHz 
quad-core  
Intel Core i5

Hard drive: 1TB (5400rpm) 
Graphics: NVIDIA GeForce GT 750M
Graphics memory: 1GB of GDDR5

£1,199

27”  3.2GHz 
quad-core  
Intel Core i5

Hard drive: 1TB (7200rpm)
Graphics: NVIDIA GeForce GT 755M
Graphics memory: 1GB of GDDR5

£1,449

27” 3.4GHz 
quad-core  
Intel Core i5

Hard drive: 1TB (7200rpm) 
Graphics: NVIDIA GeForce GTX 775M
Graphics memory: 2GB of GDDR5

£1,599

Retina 5K 27” 
3.5GHz quad-
core i5

Hard drive: 1TB Fusion Drive
Graphics: AMD Radeon R9 M290X
Graphics memory: 2GB of GDDR5

£1,999R

UPDaTe LiKeLy?

BUy or waiT?

Days since  
refresh

Recently updated

Buy now

Apple’s skipped 4K and headed 
straight for 5K to make this not only 

the Mac to have, but the desktop 
computer to own. It only comes in the 
27-inch variety for now and sports a 
3.5GHz quad-core Intel Core i5 (boosted 
to a 4.0GHz Core i7 as an option) and a 
1TB Fusion Drive. There’s also 8GB of 
RAM, AMD Radeon R9 M290X with 2GB 
video memory. The range elsewhere 
hasn’t changed, with two non-5K 
27-inch models available and three 21.5-
inch models. The entry-level model has a 
dual-core processor, but all others have a 
quad-core processor as standard.
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iMac

UPDaTe LiKeLy?

BUy or waiT?

Days since  
refresh

Possible soon

Wait if you can

Eschewing the traditional tower 
design, the new Mac Pro is 

cylindrical, coming in at one eighth 
of the previous model’s size – 
standing just 9.9 inches tall – but 
it packs a lot of power. And we 
mean a lot!

Designed around a thermal core 
that cools its components, the tiny 
Mac Pro boasts next-generation 
Xeon processor options, dual 
workstation-class GPUs, Thunderbolt 
2, PCIe-based flash storage and fast 
ECC memory. Six Thunderbolt 2 
ports sit at the back, flexible enough 

to provide a huge 20Gbps of bandwidth in one direction 
and able to daisy chain up to six peripherals. It’s fully 
backwards compatible with the original Thunderbolt port 
too, so if you already have Thunderbolt devices, you can still 
use them. There are also four USB 3.0 ports – the first time 
this high-speed USB connection has been featured on the 
Mac Pro – and two gigabit Ethernet ports. Numerous custom 
options are also available.

The Mac Pro is an incredibly powerful desktop computer, and 
probably a Mac too far for most users, but for those who need an 
incredible degree of computing power, it’s capable of offering 
astonishing performance for years.

497

Mac Pro

Model Key specifications Price

3.7GHz 
quad-core 
Xeon E5 

Solid State Drive: 256GB
RAM: 12GB 1866MHz DDR3 ECC
Graphics: Dual AMD FirePro D300

£2,499

3.5GHz 
six-core  
Xeon E5

Solid State Drive: 256GB
RAM: 16GB 1866MHz DDR3 ECC
Graphics: Dual AMD FirePro D500

£3,299

choose a mac Pro



The annual iPad refresh brought 
us the thinnest, lightest and most 

powerful iPad yet in the iPad Air 2. Its 
A8X processor has a 40% speed boost 
over 2013’s iPad Air. 

Touch ID finally makes an 
appearance too, bringing the iPad into 
line with the iPhones on that score. A 
new gold colour option also makes an 
appearance, but 32GB options have 
been ditched across the range apart 
from the iPad Air and iPad mini 2 (iPad 
mini with Retina display), which have 
both 32GB and 16GB options.

Days since  
refresh

UPDaTe LiKeLy?

Recently updated

BUy or waiT?

190

R  = Retina display

choose an ipad

R

R

R

R

Buy now

UPgrade!
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Mac mini
The smallest Mac in Apple’s range 
finally got a long awaited update 

in October. It’s a welcome update, but 
there’s been a few odd choices in the 
components as well. Starting a new 
lower price of £399 (£100 cheaper than 
the previous model), it’s still the same 
shape as before, but with some more 
modern internals. 

It starts with a 1.4GHz Intel Core i5 
dual-core processor with Intel HD 5000 
graphics, 4GB of RAM and a 500GB 
hard drive – pretty much the lowest-
end iMac without a screen. It’s the 
same kind of power as you get in a 

MacBook Air, but without the zippiness of flash memory.
 Higher end models bring Intel Iris graphics and the option for 
a Fusion Drive hybrid storage system, though every option limits 
you to dual-core processors – a quad-core option is sadly absent. 
When stepping up to the high-end model (£230 more than the 
previous model), you get a 2.8GHz Core i5, 8GB of RAM, Intel Iris 
and a 1TB Fusion Drive, offering more headroom for tasks such as 
video-editing, but it still needs to be accepted that they aren’t the 
powerhouses of some other Macs.

Days since  
refresh

UPDaTe LiKeLy?

Recently updated

BUy or waiT?

Buy now

196

Model Key specifications Price

1.4GHz 
dual-core 
Intel Core i5

Hard drive: 500GB
RAM: 4GB 1600MHz LPDDR3 
Graphics: Intel HD Graphics 5000

£399

2.6GHz  
dual-core 
Intel Core i5

Hard drive: 1TB
RAM: 8GB 1600MHz LPDDR3 
Graphics: Intel Iris Graphics

£569

2.8GHz  
dual-core 
Intel Core i5

Hard drive: 1TB
RAM: 8GB 1600MHz LPDDR3
Graphics: Intel Iris Graphics

£799

choose a mac mini

Model Key specifications Price

iPad mini 
16GB  
Wi-Fi (add 
£100 for 3G)

Resolution: 1024x768 pixels
Processor: Dual-core A5
Video recording: 1080p HD

Wi-Fi: £199
Wi-Fi+3G: 

£299

iPad mini 2 
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A7+M7
Video recording: 1080p HD

16GB: £239
32GB: £279

iPad mini 3 
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A7+M7
Video recording: 1080p HD

16GB: £319
64GB: £399
128GB: £479

iPad Air
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A7+M7
Video recording: 1080p HD

16GB: £319
32GB: £359

iPad Air 2
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A8X+M8
Video recording: 1080p HD

16GB: £399
64GB: £479
128GB: £599

iPad
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Model Key specifications Price

iPhone 5c Processor: A6
Camera: 8-megapixel
Video: 1080p, 30fps

8GB: £319

iPhone 5s Processor: A7+M7
Camera: 8-megapixel  
Video: 1080p, 30fps/720p, 120fps

16GB: £459
32GB: £499

iPhone 6 Processor: A8+M8
Camera: 8-megapixel
Video: 1080p, 60fps/720p, 240fps

16GB: £539
64GB: £619

128GB: £699

iPhone 6 Plus Processor: A8+M8
Camera: 8-megapixel
Video: 1080p, 60fps/720p, 240fps

16GB: £619
64GB: £699
128GB: £789

choose an iphone

R

R

R

R

R  = Retina display

UPDaTe LiKeLy?

BUy or waiT?

Days since  
refresh

Not until 2016

Buy now

Apple Watch
Apple Watch has the biggest price 
range of any Apple product, and 

goes from one of the cheapest to by far 
its most expensive. That’s because it’s 
more than just another Apple gadget. 
It’s also an accessory, and a fashion one 
at that. Most won’t give the gold ones a 
second look. But if serious jewellery is 
your thing then Apple offers that too. 

Of all Apple products though, never 
has a buyer’s guide been more needed! 
A staggering 38 different combinations 
are available. Apple realises that picking 
one isn’t an easy decision, so stores 
offer fitting sessions and there are even 

dedicated Watch boutiques, just like a real jewellers. The info on 
Apple’s website is a very good starting point, however.

6

choose a watch

Model Key Specifications Price

Apple Watch Sport 
(38mm)

Cases Silver Aluminium,  
Space Grey Aluminium

£299

Apple Watch Sport 
(42mm)

Cases Silver Aluminium,  
Space Grey Aluminium

£339

Apple Watch 
(38mm)

Cases Stainless Steel,  
Space Black

£479

Apple Watch 
(42mm)

Cases Stainless Steel,  
Space Black

£519

Apple Watch 
Edition (38mm)

Cases 18-Carat Rose Gold, 
18-Carat Yellow Gold

£8,000

Apple Watch 
Edition (42mm)

Cases 18-Carat Rose Gold, 
18-Carat Yellow Gold

£9,500

When you’re deciding which 
iPhone to buy from the new line-

up, your decision will be driven 
primarily by what size screen you want. 
The iPhone 5c (sadly relegated to one 
capacity, 8GB) and 5s have a 4-inch 
screens, while the 6 and 6 Plus have 4.7 
and 5.5-inch respectively; think about 
how they fit into your life – literally. 
There are other differences; the 6 Plus’s 
camera has an image-stabilising lens, 
and both 6 models are faster.

The iPhone 4s has sadly been retired 
by Apple but there are still some 
available from carriers (and second-

hand, of course), so if you want that 3.5-inch, thumb-friendly 
design, you can still get it. The iPhone 4s will run iOS 8, but don’t 
be surprised if it won’t be upgradable to iOS 9 (out in October).

Days since  
refresh

UPDaTe LiKeLy?

October 2015?

BUy or waiT?

Wait if you can

223

iPhone
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Solid state batteries 
don’t leak, don’t catch 
fire and can last three 
to four times longer.

The new MacBook’s impressively tiny 
motherboard and genuinely clever battery 
design are trying to compensate for a 
fundamental problem: you can only squeeze  
so much juice out of a lithium battery. 

Apple has made its batteries bigger, has found ingenious 
ways of fitting them inside devices and has optimised those 
devices incredibly well. But it keeps running up against some 
fundamental laws of physics and chemistry.

So Apple’s working on something else.
In 2013, the US Patent and Trademark Office published an 

Apple patent application that described charging techniques 
for a kind of battery called a solid state battery. Where normal 
batteries use liquid electrolytes, solid state ones – as the name 
suggests – use solid ones. That means they can be packaged 
much more densely than traditional batteries, and at present 
they last three to four times longer than current batteries.

There are other advantages. Solid state batteries don’t 
leak, don’t go on fire and need less cooling. You can also 
make them into interesting and/or flexible shapes, which 
makes them particularly useful for portable and 
wearable devices. 

An Apple Watch whose entire strap is a battery, or an 
iPhone so thin you can use it to chop vegetables, are 
enticing prospects. You can see why firms such as 
Toyota and Dyson are also investing in the technology: 
the potential for the former’s electric vehicles and the 
latter’s high-tech vacuum cleaners are enormous.

The downsides? Solid state batteries aren’t as 
conductive as liquid ones and that can limit power 
output. And like any nascent technology, currently, 
prices are high and manufacturing yields are low. But 
those issues can be fixed by smart people waving big 
piles of money. And Apple isn’t short of either.

Gary Marshall goes panning in the  
river of rumour for nuggets of knowledge

SPY

Solid State  
Batteries
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